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 LOVELY PROFESSIONAL UNIVERSITY  

Notes 

Unit 01: Computer Fundamentals, Data Representation 
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Objectives 

• Understanding and Introduction of computers 

• Discussion of computer evolution 

• Explanation of all generation of computers 

• Understanding of block diagram of computers  

• Understanding of memory and its types 

Introduction 

The word “computer” comes from the word “compute”, which means, “to calculate”. Hence, 
people usually use a computer to be a calculating device that can perform arithmetic operations at 
high speed. The original objective for inventing the computer was to create a fast calculating 
machine. However, more than 80% of work done by computers today is of non-mathematical or 
non-numerical nature. Hence, to define a computer merely as a calculating device is to ignore over 
80% of its functions.  

More accurately, we can define a computer as a device that operates upon data. Data can be 
anything like biodata, hence computer is used for shortlisting candidates for recruiting; marks 
obtained by students in when used for preparing results; details (name, age, sex, etc.) of passengers 
when used for or railway reservations: or the number of different parameters when used for 
solving scientific problems, etc.  

Hence, data comes in various shapes and sizes depending upon the type of computer application. 
A computer can and retrieves data as and when desired. The fact that computers process data is so 
fundamental that have started calling it a data processor.  

The name data processor is more inclusive because modern computers not only compute in the 
usual sense but also perform other functions with data that flows to and from them. For example, 
data processors may gather data from various incoming sources, merge (a process of mixing or 
putting together) them all, sort (a process of arranging in some of the sequences— ascending or 
descending) them in the desired order, and finally print them in the desired format. Notice that 
none of these operations involves arithmetic computations in the usual sense but a computer is the 
most suitable device for performing them. 
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Notes 

 

People usually consider a computer to be a calculating device that can perform arithmetic 
operations at high speed. It is also known as a data processor because it not only computes 
in the usual sense but also performs other functions with the data. 

The activity of processing data using a computer is called data processing. Data processing consists 
of three sub-activities: capturing input data, manipulating the data, and managing output results. 
As used in data processing, information is data arranged in an order and form that is useful to 
people receiving it. Hence, data is a raw material used as input to data processing and information 
is processed data obtained as an output of data processing. 

 

1.1  Characteristics of Computers 

The increasing popularity of computers has proved that it is a very powerful and useful tool. The 
power and use of this popular tool are mainly due to its following characteristics: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Automatic. An automatic machine works by itself without human intervention. 

Computers automatic machines because once started on employment , 

they perform the work (normally without a person's assistance) until it's finished. 

However, computers being machines cannot start themselves and can't leave and 

find their own problems and solutions. We need to instruct a computer using coded 

instructions that specify exactly how it'll do a specific job. a number of the other 

characteristics of computers (such as speed and accuracy) are 

because they're automatic and work on a problem with none human intervention. 

2. Speed. A computer may be a in no time device. It can perform during a few 

seconds, the quantity of labor that a person's being can neutralize a whole year if 

he/she worked day and night and did nothing else. In other words, a computer 

can neutralize a couple of minutes what would take a person his entire life time 

while talking about the speed of a computer we don't talk in terms of seconds or 

maybe milliseconds (10–3) but in terms of microseconds (106), nanoseconds (10–9), 

Figure 1  Characteristics of Computer 
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Notes and even picoseconds (10–12). a strong computer is capable of performing several 

billion (l09) simple arithmetic operations per second. 

3. Accuracy. In addition to being in no time , computers are very accurate. Accuracy of 

a computer is consistently high and therefore the degree of its accuracy depends 

upon its design. A computer performs even calculation with an equivalent accuracy. 

However, errors can occur during a computer. These errors are mainly thanks 

to human instead of technological weaknesses. for instance , errors may occur thanks 

to imprecise thinking by a programmer (a one that writes instructions for a 

computer to unravel a specific problem) or incorrect input file . we 

frequently ask computer errors caused thanks to incorrect input file or unreliable 

programs as garbage-in-garbage-out (GIGO). 

4. Diligence. Unlike citizenry , a computer is free from monotony, tiredness, and lack of 

concentration. It can continuously work for hours without creating any error and 

without grumbling. Hence, computers score over citizenry in doing routine sort 

of jobs that need great accuracy. If ten million calculations need to be performed, a 

computer will perform the last one with precisely the same accuracy and 

speed because the first one. 

5. Versatility. Versatility is one of the most wonderful things about a computer. One 

moment it is preparing results of an examination, next moment it is busy preparing 

electricity bills, and in between, it may be helping an office secretary to trace an important 

letter in seconds. All that is required to change its talent is to slip in a new program (a 

sequence of instructions for the computer) into it. In brief, a computer is capable of 

performing almost any task, if the task can be reduced to a finite series of logical steps. 

6. Power of Remembering. As a human being acquires new knowledge, his/her brain 

subconsciously selects what it feels to be important and worth retaining in memory. The 

brain relegates unimportant details to back of mind or just forgets them. This is not the 

case with computers. A computer can store and recall any amount of information because 

of its secondary storage (a type of detachable memory) capability. It can retain a piece of 

information as long as a user desires and the user can recall the information whenever 

required. Even after several years, a user can recall exactly the same information that 

he/she had stored in the computer several years ago. A computer forgets or looses 

creation information only when a user asks it to do so. Hence, it is entirely up to the user 

to make a computer retain or forget some information. 

 

1.2  Generation of Computers 

Generation in computer talk may be a step in technology. It provides a framework for the 
expansion of industry . Originally, the term “generation” was wont to distinguish between 
varying hardware technologies but it's now been extended to incorporate both hardware and 
software that together structure a computing system .The custom of pertaining to computer 
era in terms of generations came into wide use only after 1964. There are totally five 
computer generations known till today. Below we describe each generation along side its 
identifying characteristics. Although there's a particular amount of overlap between different 
generations, the approximate period shown against each are normally accepted. 
During description of varied computer generations, you'll encounter several new 
terminologies and computer jargons that you simply might not be ready to understand 
properly. However, the thought here is to supply you an summary of the main developments 
and technologies during the five generations of computers. Subsequent chapters will cover 
these developments and technologies intimately . the target of this section is especially to 
supply an summary of what all you're getting to learn during this entire book. 
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Fifth generation 

 

 

 

 

 

 

 

 

Figure 2 Generations of Computer 

 

First Generation (1942-1955) 

The first generation computers used vacuum tubes as the main electronic part. For memory 
devices, punch card and paper tapes were used. Magnetic drums are also used for storage. At that 
time memory was very expensive. Electronic time per calculation ranged from 0.1 milliseconds to 1 
millisecond. They used two types of computer programming languages 

• Machine Language 

• Assembly Language 

 

Figure 3 Vaccum Tubes 

A vacuum tube [see Figure 3] was a fragile glass device, which used filaments as a source of 
electronics and could control and amplify electronic signals. It was the only high-speed electronic 
switching device available in those days. These vacuum tubes computer could perform 
computations in milliseconds and were referred to as first-generation computers. 

The memory of these computers used electromagnetic relays, and all data and instructions were fed 
into the system from punched cards. The instructions were written in machine and assembly 
languages because high-level programming languages were introduced much later. Since machine 
and assembly languages are very difficult to work with, only a few specialists understood how to 
program these early computers. 

Characteristic features of first-generation computers are as follows: 

1. They were the fastest calculating devices of their time. 

2. They were too bulky in size, requiring large rooms for installation. 

3. They used thousands of vacuum tubes that emitted large amount of heat and burnt out 
frequently. Hence, the rooms/areas in which these computers were located had to be properly air-
conditioned. 

4. Each vacuum tube consumed about half a watt of power. Since a computer typically used more 
than ten thousand vacuum tubes, power consumption of these computers was very high. 

Second Generation 

 

Third Generation 

 

Generation 

Fourth Generation 

 

First Generation 
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Notes 5. As vacuum tubes used filaments, they had a limited life. Because a computer used thousand of 
vacuum tubes, these computers were prone to frequent hardware failures. 

6. Due to low mean time between failures, these computers required constant maintenance. 

7. In these computers, thousands of individual components were assembled manually by hand in to 
electronic circuits. Hence, commercial production of these computers was difficult and costly. 

8. Since these computers were difficult to program and use, they had limited commercial use. 

 
Give brief description about the first-generation computer 

Second Generation (1955-1964) 

 John Bardeen, Willian Shockley, and Walter Brattain invented a new electronic switching     device 
called transistor [see Figure 1.1(b)] at Bell Laboratories in 1947. Transistors soon proved to be a 
better electronic switching device than vacuum tubes due to their following properties: 

 1. They were more rugged and easier to handle than tubes since they were made of germanium 
semiconductor material rather than glass. 

2. They were highly reliable as compared to tubes since they had no parts like a filament that could 
burn out. 

3. They could switch much faster (almost ten times faster) than tubes. Hence, switching circuits 
made of transistors could operate much faster than their counterparts made of tubes. 

4. They consumed almost one-tenth the power consumed by tube. 

5. They were much smaller than a tube. 

6. They were less expensive to produce. 

7. They dissipated much less heat as compared to vacuum tubes. 

The second-generation computers were manufactured using transistors instead of vacuum tubes. 
Due to the properties of transistors listed above, these computers were more powerful, more 
reliable, less expensive, smaller, and cooler to operate than the first-generation computers. They 
used magnetic cores for main memory, and magnetic disk and tape as secondary storage media. 
Punched cards were still popular and widely used for preparing and feeding programs and data to 
these computers. 

On software front, high-level programming languages (like FORTRAN, COBOL, ALGOL, and 
SNOBOL) and batch operating system emerged during second-generation. High-level 
programming languages were easier for people to understand and work with than assembly or 
machine languages making second-generation computers easier to program and use than first-
generation computers. Introduction of batch operating system enabled multiple jobs to be batched 
together and submitted at a time. A batch operating system causes automatic transition from one 
job to another as soon as the former job completes. This concept helped in reducing human 
intervention while processing multiple jobs resulting in faster processing, enhanced throughput, 
and easier operation of second-generation computers. 

The first-generation computers were mainly used for scientific computations. However, the second-
generation computers were increasingly used in business and industry for commercial data 
processing applications like payroll, inventory control, marketing, and production planning. 

Characteristic features of second-generation computers are as follows:  

1. They were more than ten times faster than the first-generation computers. 

 2. They were smaller than first-generation computers and required smaller space.  

3. They consumed less power and dissipated less heat than the first-generation computers. The 
rooms/areas in which the second-generation computers were located still required to be properly 
air conditioned. 

 4. They were more reliable and less prone to hardware failures than the first-generation computers. 
5. They had faster and larger primary and secondary storage as compared to first-generation 
computers. 
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Notes  6. They were easier to program and use than the first-generation computers. Hence, they had wider 
commercial use.  

7. In these computers, thousands of individual transistors had to be assembled manually by hand 
into electronic circuits making commercial production of these computers difficult and costly. 

 

                                               Figure 4 Different devices for different generations 

Third Generation (1964-1975) 

In 1958, Jack Clair Kilby and Robert Noyce invented the first integrated circuit. Integrated circuits 
(called ICs) are circuits consisting of several electronic components like transistors, resistors, and 
capacitors grown on a single chip of silicon eliminating wired interconnection between 
components. The IC technology was also known, 0 technologies because it made it possible to 
integrate larger number of circuit components into very small (less than 5 mm square) surface of 
silicon, known as “chip” [see Figure l.l(c)]. Initially the integrated circuits contained only about ten 
to twenty components. This technology was named small scale integration (SSI). Later with the 
advancement in technology for manufacturing ICs, it became possible to integrate up to about 
components on a single chip. This technology came to be known as medium scale integration (MSI). 

Computers built using integrated circuits characterized the third generation. Earlier ones used SSI 
technology and later used MSI technology. ICs were smaller, less expensive to produce, more 
rugged and reliable, faster in operations, dissipated less heat, and consumed less power than 
circuits built by wiring electronic components manually. Hence third generation computers were 
more powerful, more reliable, less expensive, smaller, and cooler to operate than second-generation 
computers. 

Parallel advancements in storage technologies allowed construction of larger magnetic core based 
random access memory as well as larger capacity magnetic disks and tapes. Hence, third-
generation computers typically had few megabytes (less than 5 Megabytes) of main memory and 
magnetic disks capable of storing few tens of megabytes of data per disk drive. 

On software front, standardization of high-level programming languages, timesharing operating 
systems, unbundling of software from hardware, and creation of an independent software industry 
happened during third generation. FORTRAN and COBOL were the most popular high-level 
programming languages in those days. American National Standards Institute (ANSI) standardized 
them in 1966 and 1968 respectively, and the standardized versions were called ANSI FORTRAN 
and ANSI COBOL. The idea was that as long as programmers follows these standards in program 
writing, a program could be run on any computer with an ANSI FORTRAN or ANSI COBOL 
compiler. Some more high-level programming languages were introduced during the third-
generation period. Notable among these were PL/1, PASCAL, and BASIC. 

We saw that second-generation computers used batch operating system. In these systems, users 
had to prepare their data and programs and then submit them to a computer centre for processing. 
The operator at the computer centre collected these user jobs and fed them to a computer in batches 
at scheduled intervals. The respective users then collected their job’s output from the computer 
centre. The inevitable delay resulting from this batch processing approach was very frustrating to 
some users, especially programmers, because often they had to wait for days to locate and correct a 
few program errors. To rectify this situation, John Kemeny and Thomas Kurtz of Dartmouth 
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Notes College introduced the concept of timesharing operating system. Timesharing operating system 
enables multiple users to directly access and share computing resources simultaneously in a 
manner that each user feels that no one else is using the computer. This is accomplished by using a 
large number of independent relatively low-speed, on-line terminals connected to the main 
computer simultaneously. Introduction of timesharing concept helped in drastically improving the 
productivity of programmers and made on-line systems feasible, resulting in new on-line 
applications like airline reservation systems, interactive query systems, etc. 

Until 1965, computer manufacturers sold their hardware along with all associated software without 
any separate charges for software. For example, buyers received language translators for all 
languages supported on a computer they purchased. From user’s standpoint, software was free. 
However, the situation changed in 1969 when IBM and other computer manufacturers began to 
price their hardware and software products separately. This unbundling of software from 
hardware gave users an opportunity to invest only in software of their need and value. For 
example, now buyers could purchase only the language translators they needed and not all 
language translators supported on the purchased computer. This led to the creation of many new 
software houses and the beginning of an independent software industry. 

Development and introduction of minicomputers also took place during the third-generation 
period. Computers built until the early 1960s were mainframe systems that only very large 
companies could afford to purchase and use. Clearly, a need existed for low-cost smaller computers 
to fill the gaps left by the bigger, faster, and costlier mainframe systems. Several innovators 
recognized this need and formed new firms in the 1960s to produce smaller computers. Digital 
Equipment Corporation (DEC) introduced the first commercially available minicomputer, the PDP-
8 (Programmed Data Processor), in 1965. It could easily fit in the corner of a room and did not 
require attention of a full-time computer operator. It used timesharing operating system and a 
number of users could access it simultaneously from different locations in the same building. Its 
cost was about one-fourth the cost of a traditional mainframe system making it possible for smaller 
companies to afford computers. It confirmed the tremendous demand for small computers for 
business and scientific applications, and by 1971, there were more than 25 computer manufacturers 
in minicomputer market. 

Characteristic features of third-generation computers are as follows: 

1. They were more powerful than second-generation computers. They were capable of performing 
about one million instructions per second. 

2. They were smaller than second-generation computers requiring smaller space. 

3. They consumed less power and dissipated less heat than second-generation computers. The 
rooms/areas in which third-generation computers were located still required to be properly air-
conditioned. 

4. They were more reliable and less prone to hardware failures than second-generation computers 
requiring lower maintenance cost. 

5. They had faster and larger primary and secondary storage as compared to secondgeneration 
computers. 

6. They were general-purpose machines suitable for both scientific and commercial applications. 

7. There manufacturing did not require manual assembly of individual components into electronic 
circuits resulting in reduced human labor and cost involved at assembly stage. Hence, commercial 
production of these systems was easier and cheaper. However, highly sophisticated technology and 
expensive setup was required for the manufacture of IC chips. 

8. Standardization of high-level programming languages allowed programs written for one 
computer to be easily ported to and executed on another computer. 

9. Timesharing operating system allowed interactive usage and simultaneous use of these systems 
by multiple users. 

10. Timesharing operating system helped in drastically improving the productivity of programmers 
down the time and cost of program development by several fold. 

11. Timesharing operating system also made on-line systems feasible resulting in usage of these 
systems oil-line applications. 
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Notes 12. Unbundling of software from hardware gave users of these systems an opportunity to invest 
only in software of their need and value. 

13. Minicomputers of third-generation made computers affordable even by smaller companies. 

 

Fourth Generation (1975-1989) 

Average of electronic components packed on a chip doubled annually after 1965. This 
progress soon led to the age of huge scale integration (ISI) when it had been possible to 
integrate over 30,000 electronic components on one chip, followed by very large scale 
integration (VLSI) when it had been possible to integrate about a million electronic 
components on one chip. This progress led to a dramatic development — creation of a 
microprocessor. A microprocessor contains all circuits needed to perform arithmetic logic and 
control: functions, the core activities of all computers, on one chip. Hence, it became 
possible to create an entire computer with a Microprocessor, a couple of additional primary 
storage chips, and other support circuitry. It started a replacement social revolution—
personal computer (PC) revolution. Overnight computers became incredibly compact. They 
become inexpensive to form , and suddenly it became possible for anyone to have a 
computer. 
During forth generation, semiconductor memories replaced core memories leading to large 
random access memories with in no time time interval . On the opposite hand, hard disks 
became cheaper, smaller, and bigger in capacity. additionally to magnetic tapes, floppy disks 
became very fashionable as a transportable medium for porting programs and data from 
one computing system to a different .  

Another significant development during fourth-generation period was spread of high-speed 
computer networking enabling interconnection of multiple computers to enable them to 
speak and share data. Local area networks (LANs) became popular for connecting computers 
within a corporation or within a campus. Similarly, wide area networks (WANs) became 
popular for connecting computers located at larger distances. This gave rise to networks 
computers and distributed systems. 

On software front several new developments emerged to match the new technologies of 
fourth generation. For examples, several new operating systems were developed for PCs. 
Notable among these were MS-DOS, MS-windows, and apple’s propriety OS. Since PCs 
were for people who weren't computer professionals, companies developed graphical user 
interfaces for creating computers more user friendly (easier to use).  

A graphical interface ((U1) provides icons (pictures) and menus (list of choices) that users can 
select with a mouse. this permits new computer users to find out to use a PC quickly. Several 
new PC-based applications were also developed to form PCs a strong tool. Notable among 
these were powerful data processing packages that allowed easy development of documents, 
spreadsheet package that allowed easy manipulation and analysis of knowledge organized in 
columns and rows, and graphics packages that allowed easy drawing of images and 
diagrams. Another very useful concept that became popular during fourth-generation period 
was that of multiple windows on one terminal screen. This feature allowed users to 
ascertain the present state of’ several applications simultaneously in separate windows on 
same terminal screen. During fourth-generation period, UNIX OS and C programing 
language also became very fashionable . 

Characteristic features of fourth-generation computers are as follows: 

1. PCs were smaller and cheaper than mainframes or minicomputers of third generation. 

2. Although the fourth-generation mainframes required proper air-conditioning of the rooms/areas 
in which they were located, no air-conditioning was required for PCs. 

3. They consumed less power than third-generation computers. 

4. They were more reliable and less prone to hardware failures than third-generation computers 
requiring negligible maintenance cost. 

5. They had faster and larger primary and secondary storage as compared to thirdgeneration 
computers. 

6. They were general-purpose machines. 
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Notes 7. Their manufacturing did not require manual assembly of individual components into electronic 
circuits resulting in reduced human labour and cost involved at assembly stage. Hence, commercial 
production of these systems was easier and cheaper. However, highly sophisticated technology and 
expensive setup was required for manufacturing LSI and VLSI chips. 

8. Use of standard high-level programming languages allowed programs written for one computer 
to be easily ported to and executed on another computer. 

9. Graphical user interface (GUI) enabled new users to quickly learn how to use computers. 

10. PC-based applications made PCs a powerful tool for both office and home usage. 

11. Network of computers enabled sharing of resources like disks, printers, etc. among multiple 
computers and their users. They also enabled several new types of applications involving 
interaction among computer users at geographically distant locations. Computer Supported  
Cooperative Working (CSCW), or groupware is one such application in which multiple members 
working on a single project and located at distant locations cooperate with each other by using a 
network of computers. 

12. In addition to unbundled software, these systems also used add-on hardware feature that 
allowed users to invest only in the hardware configuration and software of their need and value. 

13. PCs of fourth generation made computers affordable even by individuals for their personal use 
at home. 

 

Fifth Generation (1989-Present) 

The trend of further miniaturization of electronic components, dramatic increase in power of 
microprocessor-chips, and increase in capacity of main memory and hard disc continued 
during fifth generation. VLSI technology came ULSI ((Ultra Large Scale Integration) 
technology in fifth generation leading to production of Microprocessor chips having ten 
million electronic components. In fact, the speed of microprocessors  and therefore the size of 
main memory and hard disc doubled almost every eighteen months. As a result, many 
features found within the CPUs of huge mainframe systems of third- and fourth-generation 
systems became a part of microprocessor architecture in fifth generation. This ultimately 
resulted in availability of very powerful and compact computers becoming available at 
cheaper rates and death of traditional large mainframe systems.  thanks to this fast space of 
advancement in technology , we see more compact and more powerful computers being 
introduced almost per annum at more or less an equivalent price or maybe cheaper. Notable 
among these are portable notebook computers that give the facility of a PC to their users even 
while travelling, powerful desktop PCs and workstations, powerful servers,  and 
really powerful supercomputers. 

Storage technology also advanced in no time making larger and bigger main memory and 
disk storage available in newly introduced systems. During fifth generation, optical disks also 
emerged as a well-liked portable mass storage D-ROM (Compact Disk - Read Only Memory). 
During fifth generation, there was tremendous outgrowth of computer networks. 
Communication technologies become faster day-by-day and more and more computers were 
networked together. This trend resulted in emergence and recognition of the web and 
associated technologies and applications. the web made it possible for computer users sitting 
across the world to speak with one another within minutes by use of electronic 
message (known as e-mail) facility. a huge ocean of data became readily available to 
computer users through the planet Wide Web (known as WWW). Moreover, several new sorts 
of exciting applications like e-commerce, virtual libraries, virtual classrooms, distance 
education, etc., emerged during the amount . 

Tremendous processing power and large storage capacity of fifth-generation computers also 
made them a really popular tool for a good range of multimedia applications 
that affect information containing text, graphics animation, audio, and video 
data. generally , the info size of multimedia information is far larger than textual information 
because representation of graphics, animation, audio, or video media in digital form requires 
larger number of bits than that required for representation of textual information.  

Characteristic features of fifth-generation computers are as follows: 
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Notes 1. Portable PCs (called notebook computers) are much smaller and handy than PCs of fourth 
generation allowing users to use computing facility even while travelling. 

2. Fifth-generation desktop PCs and workstations are several times more powerful than PCs of 
fourth generation. 

3. Although fifth-generation mainframes require proper air-conditioning of the rooms/ areas in 
which they are located, no air-conditioning is normally required for notebook computers, desktop 
PCs, and workstations.  

4. They consume less power than their predecessors do. 

 5. They are more reliable and less prone to hardware failures than their predecessors were, 
requiring negligible maintenance cost. 

 6. Many of the large-scale fifth-generation systems have hot-plug feature that enables a failed 
component to be replaced with a new one without the need to shutdown the system. Hence, the 
uptime of these systems is very high.  

7. They have faster and larger primary and secondary storage as compared to their predecessors. 

 8. They are general-purpose machines.  

9. Their manufacturing does not require manual assembly of individual components into electronic 
circuits resulting in reduced human labour and cost involved at assembly stage. Hence, commercial 
production of these systems is easier and cheaper. However, highly sophisticated technology and 
expensive setup (affordable only by a few organizations in the world) is required for 
manufacturing IJLSI chips.  

10. Use of standard high-level programming languages allows programs written for one computer 
to be easily ported to and executed on another computer. 

 11. More user-friendly interfaces with multimedia features make the systems easier to learn and 
use by anyone, including children.  

                              

Figure 4 Touch Screen technology 

1.3 Block Diagram of Computer 

The basic components of a computer are:  

• Input Unit  

• Output Unit  

• Memory/Storage Unit 

 • Arithmetic Logic Unit  

• Control Unit  

• Central Processing Unit 

 

 

10



Unit 1: Computer Fundamentals, Data Representation   

 LOVELY PROFESSIONAL UNIVERSITY  

Notes These are shown in Figure 5 

 

     

 

 

Figure 5 Block Diagram of Computer 

Input Unit 

Computers need to receive data and instruction in order to solve any problem. Therefore, we need 
to input the data and instructions into the computers. The input unit consists of one or more input 
devices. Keyboard is the one of the most commonly used input devices. Other commonly used 
input devices are the mouse, floppy disk drive, magnetic tape, etc. All the input devices perform 
the following functions:  

• Accept the data and instructions from the outside world.  

• Convert it to a form that the computer can understand.  

• Supply the converted data to the computer system for further processing. 

Storage Unit 

The storage unit of the computer holds data and instructions that are entered through the input 
unit, before they are processed. It preserves the intermediate and final results before these are sent 
to the output devices. It also saves the data for the later use. The various storage devices of a 
computer system are divided into two categories: 

1. Primary Storage: Stores and provides very fast. This memory is generally used to hold the 
program being currently executed in the computer, the data being received from the input unit, the 
intermediate and final results of the program. The primary memory is temporary in nature. The 
data is lost, when the computer is switched off. In order to store the data permanently, the data has 
to be transferred to the secondary memory. The cost of the primary storage is more compared to the 
secondary storage. Therefore, most computers have limited primary storage capacity.  

2. Secondary Storage: Secondary storage is used like an archive. It stores several programs, 

documents, data bases etc. The programs that you run on the computer are first transferred to the 
primary memory before it is actually run. Whenever the results are saved, again they get stored in 
the secondary memory. The secondary memory is slower and cheaper than the primary memory. 
Some of the commonly used secondary memory devices are Hard disk, CD, etc. 

Memory Size 

All digital computers use the binary system, i.e. 0’s and 1’s. Each character or a number is 
represented by an 8 bit code. The set of 8 bits is called a byte. A character occupies 1 byte space. A 
numeric occupies 2 byte space. Byte is the space occupied in the memory. The size of the primary 
storage is specified in KB (Kilobytes) or MB (Megabyte). One KB is equal to 1024 bytes and one MB 
is equal to 1000 KB. The size of the primary storage in a typical PC usually starts at 16 MB. PCs 
having 32 MB, 48 MB, 128 MB, 256 MB memory are quite common. 

Output Unit 

The output unit of a computer provides the information and results of a computation to outside 
world. Printers, Visual Display Unit (VDU) are the commonly used output devices. Other 
commonly used output devices are floppy disk drive, hard disk drive and magnetic tape drive. 

Input Processin
g 

Output 
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Arithmetic Logical Unit 

All calculations are performed in the Arithmetic Logic Unit (ALU) of the computer. It also does 
comparison and takes decision. The ALU can perform basic operations such as addition, 
subtraction, multiplication, division, etc and does logic operations viz, >, <, =, ‘etc. Whenever 
calculations are required, the control unit transfers the data from storage unit to ALU once the 
computations are done, the results are transferred to the storage unit by the control unit and then it 
is send to the output unit for displaying results. 

Control Unit 

It controls all other units in the computer. The control unit instructs the input unit, where to store 
the data after receiving it from the user. It controls the flow of data and instructions from the 
storage unit to ALU. It also controls the flow of results from the ALU to the storage unit. The 
control unit is generally referred as the central nervous system of the computer that control and 
synchronizes its working. 

Central Processing Unit 

The control unit and ALU of the computer are together known as the Central Processing Unit 
(CPU). The CPU is like brain performs the following functions:  

• It performs all calculations. 

 • It takes all decisions.  

• It controls all units of the computer 

 

The activity of processing data using a computer is called data processing. Data is raw 
material used as input to data processing and information is processed data obtained as 
output of data processing. 

1.4 Data Representation 

While the essential memory unit during a computer is that the bit, holding a worth of 1 or 0, or 
equivalently ON or OFF, most information of interest to the user requires quite an easy bi-valued 
representation. Thus, it's practical to make groups of bits, each consisting of some carefully chosen 
number of bits, and style the pc hardware to affect these groups as complete units. In modern 
computers the foremost basic group consists of 8 bits, called the byte. 

Most computers implement groupings of two bytes, 4 bytes, and eight bytes. 
In order to debate how data is processed by a computer, we should always first understand the 

shape during which data is stored in its memory. There are two basic sorts of data which are 
stored and processed by computers, namely character and numbers. Characters include letters and 
special symbols. for instance , computer could also be programmed to read an inventory of 
names, sort them in alphabetical order and print the sorted list. an inventory of 
names, like VINEET, PRADIP, GANESH read by an input unit would be stored in memory, sorted 
by the program in alphabetical order and printed the strings being VINEET, PRADIP and 
GANESH. the opposite sort of data is decimal numbers like 1234, 456 etc. Numbers are processed 
using arithmetic operations such add, subtract, multiply and divide. during this case, we assign 
values to numbers and therefore the processing leads to new values. The characters and numbers 
fed to a computer, and therefore the output from the pc , must be during a form which is usable 
by people. For this purpose tongue symbols and digit are appropriate. These constitute the 
external data representation. On the opposite hand, the representation of knowledge inside a 
computer must match the technology employed by the pc to store and process data. Thus we 

should always first determine the 

foremost appropriate representation to representation and the other way around . 

Number System 

A set of values used to represent different quantities is known as Number System. A numerical 
system is a writing system for expressing numbers. Mathematical notation for representing 
numbers of a given set using digits or other symbols in consistent manner. 
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Notes Example 

A number system can be used to represent  the number of students in a class or number  of 
viewers watching a certain TV program  etc. The digital computer represents all kinds of data 
and information in binary numbers. Number systems have numerous forms. The data can be in 
the form of audio, text, graphics and numbers. Total number of digits which composes a 
number is called as a Base or Radix. 

 

Types of number system 

Number system are of so many times but lets discuss the most commonly used ones. Following are 
the 4 main number systems types: 

• Binary Number System 

• Decimal Number System 

• Hexadecimal Number System 

• Octal Number System 

 

 

 

Figure 6 Types of Number System 

Each number system comes with a Base value. The base value of a number system is the number of 
different values the set has before repeating itself. The below mentioned table shows the number 
system along with its base value. 

SYSTEM BASE SYMBOLS 

Binary 2 0,1 

Decimal 10 0,1,2,3……9 

Octal 8 0,1,2,3……7 

Hexa-
decimal 

16 0,1,2…. 9, 

A,B,….F 

Table 2 Number system with its Base Value 

                             

Binary Number System 

Binary Number System: According to digital electronics and mathematics, a binary number is 
defined as a number that is expressed in the binary system or base 2 numeral system. It describes 

System
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Notes numeric values by two separate symbols; 1 (one) and 0 (zero). The base-2 system is the positional 
notation with 2 as a radix. 

The binary system is applied internally by almost all latest computers and computer-based devices 
because of its direct implementation in electronic circuits using logic gates. Every digit is referred to 
as a bit.  

n 

What is Bit in Binary Number? 

A single binary digit is called a “Bit”. A binary number consists of several bits. Examples are: 

• 10101 is a five-bit binary number 

• 101 is a three-bit binary number 

• 100001 is a six-bit binary number 

Facts to Remember: 

• Binary numbers are made up of only 0’s and 1’s. 

• A binary number is represented with a base-2 

• A bit is a single binary digit. 

 

How to Calculate Binary Numbers 

For example, the number to be operated is 1235. 

Thousands Hundreds Tens Ones 

1 2 3 5 

Table 1 Binary calculation 

This indicates, 

1235 = 1 × 1000 + 2 × 100 + 3 × 10 + 5 × 1 

Given, 

1000 = 103 = 10 × 10 × 10 

100 = 102 = 10 × 10 

10 = 101 = 10 

1 = 100 (any value to the exponent zero is one) 

Table 2 

The above table 3  can be described as, 

Thousands Hundreds Tens Ones 

103 102 101 100 

1 2 3 5 

Hence, 

1235 = 1 × 1000 + 2 × 100 + 3 × 10 + 5 × 1 

= 1 × 103 + 2 × 102 + 3 × 101 + 5 × 100 

The decimal number system operates in base 10, wherein the digits 0-9 represent numbers. In 
binary system operates in base 2 and the digits 0-1 represent numbers, and the base is known 
as radix. 

Example to calculate decimal equivalent 
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Notes Binary Number - 101012 

Step 1 Convert Binary number into decimal 

            101012= ((1 x 24) + (0 x 23) + (1x 22) + (0 x 21) + (1 x 20))10 

As you can see in the above example after conversion the deciamal number system is displayes 

Step 2  Simplify the calculation of Decimal number system by multiplication and addition function 

              101012= (16 + 0 + 4 + 0 + 1)10 

Step 3  Sum it up and display the results  

              101012=2110 

Decimal Number System 

In the decimal number system, the numbers are represented with base 10. The way of denoting the 
decimal numbers with base 10 is also termed as decimal notation. This number system is widely 
used in computer applications. It is also called the base-10 number system which consists of 10 
digits, such as, 0,1,2,3,4,5,6,7,8,9. Each digit in the decimal system has a position and every digit is 
ten times more significant than the previous digit. 

For example, the decimal number 1234 consists of  

• 4 in the unit's position 

• 3 in the tens position 

• 2 in the hundreds position 

• 1 in the thousands position 

The value of 1234 can be written as 

(1x1000)+ (2x100)+ (3x10)+ (4x1)   

(1x103)+ (2x102)+ (3x101)+ (4x100)   

1000 + 200 + 30 + 4 = 1234 

 

 Suppose, 25 is a decimal number, then 2 is ten times more than 5. Some examples of decimal 
numbers are:- 

(12)10, (345)10, (119)10, (200)10, (313.9)10 

A number system which uses digits from 0 to 9 to represent a number with base 10 is the decimal 
system number. The number is expressed in base-10 where each value is denoted by 0 or first nine 
positive integers. Each value in this number system has the place value of power 10. It means the 
digit at the tens place is ten times greater than the digit at the unit place. Let us see some more 
examples: 

(92)10 = 9×101+2×100 

(200)10 = 2×102+0x101+0x100 

The decimal numbers which have digits present on the right side of the decimal (.) denote each 
digit with decreasing power of 10. Some examples are: 

(30.2)10= 30×101+0x100+2×10-1 

(212.367)10 = 2×102+1×101+2×100+3×10-1+6×10-2+7×10-3 

 

Octal Number System 

Octal Number System has a base of eight and uses the number from 0 to 7. The octal numbers, in 
the number system, are usually represented by binary numbers when they are grouped in pair of 
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Notes three. For example, 128 is expressed as 0010102, where 1 is equivalent to 001 and 2 is equivalent to 
010. 

Octal Number System 

Base – 8 

Octal Symbol – 0, 1, 2, 3, 4, 5, 6 and 7 

 

Characteristics of Octal Number System 

• Uses eight digits, 0,1,2,3,4,5,6,7. 

• Also called base 8 number system 

• Each position in an octal number represents a 0  power of the base (8). Example 80 

• Last position in an octal number represents a x  power of the base (8). Example 8x where x  
represents the last position - 1. 

Like Octal number is represented with base 8, in the same way, a binary number is represented 
with base 2, decimal number with base 10 and the hexadecimal number is represented with base 
16.  

Examples for these number systems are: 

• 222 is a binary number 

• 10010 is a decimal number 

• 4016 is a hexadecimal number 

If we solve an octal number, each place is a power of eight. 

• 1248= 1 × 82 + 2 × 81 + 4 × 80 

Example of converting Octal into Decimal  

Octal Number : 125708 

Step 1 Convert the octal number to decimal with the base value 10 

            125708=((1 x 84) + (2 x 83) + (5 x 82) + (7 x 81) + (0 x 80))10 

Step 2  Simplify the calcukation after the decimal convertion by multiplication and addition 

              125708=(4096 + 1024 + 320 + 56 + 0)10 

Step 3  Perform addition to get the conversion results 

                125708= 549610 

Hexadecimal Number System 

In the hexadecimal number system, the numbers are represented with base 16. It is also 
pronounced sometimes as ‘hex’. Just like the binary number, octal number and decimal 

number whose base representation are 2, 8 and 10, respectively, the hexadecimal conversion is also 
possible which can be represented in a table. The list of 16 hexadecimal digits with their decimal, 
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Notes octal and binary representation is provided here in the form of a table, which will help in number 

system conversion. 

Characteristics of Hexadecimal Number System 

• Uses 10 digits and 6 letters, 0,1,2,3,4,5,6,7,8,9,A,B,C,D,E and F 

• Letters represents numbers starting from 10. A=10, B=11, C=12, D=13, E=14, F=15 

• Also called base 16 number system 

• Each position in a hexadecimal number  represents a 0 power of the base (16). Example, 
160 

• Last position in a hexadecimal number  represents a x power of the base (16).  Example 16x 

where x represents the last  position - 1. 

 

Hexadecimal to Decimal Number System Conversion 

Here, you will see the representation of a hexadecimal number into decimal form. 

Hexadecimal 
0 1 2 3 4 5 6 7 8 9 A B C D E F 

Decimal 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 
15 

Decimal to Hexadecimal Number System Conversion 

You have learned how to convert hexadecimal number to decimal number. Now let us find out 
how we can convert a decimal number in hexadecimal. Follow the below steps: 

• Firstly divide the number by 16 

• Take the quotient and divide again by 16 

• The remainder left will produce the hex value 

• Repeats the steps until the quotient has become 0 

Example: Convert (242)10 into hexadecimal. 

Solution: Divide 242 by 16 and repeat the steps, till the quotient is left as 0. 

 

Therefore, (242)10 = (F2)16 

 

Hexadecimal Number System Conversion Examples 

Example 1: What is 5C6 (Hexadecimal)? 

Solution: Step 1: The “5 “ is the “16 x 16” position, so that means 5 x16 x16 

Step 2: The ‘C’ (12) is in the “16” position, so that means 12 x 16. 

Step 3: The “6” in the “1” position so that means 6. 

Answer is : 5C6 = 5 x 16 x 16 + 12 x 16 +6 = (1478 ) in Decimal. 

  

Example 2: What is 3C5 (Hexadecimal)? 

Solution: Step 1: The “3 “ is the “16 x 16” position, so that means 3 x16 x16 
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Notes Step 2: The ‘C’ (12) is in the “16” position, so that means 12 x 16. 

Step 3: The “5” in the “1” position so that means 5. 

Answer is : 5C6 = 3 x 16 x 16 + 12 x 16 +5 = ( 965) in Decimal. 

  

Example 3: What is 7B5 (Hexadecimal)? 

Solution: Step 1: The “7 “ is the “16 x 16” position, so that means 7 x16 x16 

Step 2: The ‘B’ (11) is in the “11” position, so that means 11 x 16. 

Step 3: The 5” in the “1” position so that means 5. 

Answer is : 7B5 = 7 x 16 x 16 + 11 x 16 +5 = (1973) in Decimal. 

 
What is 5D6 (Hexadecimal)? 

 

 

           Table 3 Relationship among Decimal,Hexadecimal,Binary and Octal Number System 
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Notes Summary 

• The word computer comes from the word “compute”, which means, “to calculate”.  

•  Then characteristics of computer discuss which include Automatic Machine, Speed, 

Accuracy, Diligence, Versatility, Power of Remembering.  

•  Computer generation like First Generation (1942-1955), Second Generation (1955-1964), 

Third Generation (1964-1975), Fourth Generation (1975-1989) and Fifth Generation (1989-

Present).  

•  Block Diagram of Computer means sub part of computer like input, output and memory 

devices.  

•  The control processing unit is combination of ALO and Au. 

• In octal number system their are only eight symbols or digits i.e. 0, 1, 2, 3, 4, 5, 6, 7, 8. • In 

hexadecimal number system each position represent a power of the base 16. 

Keywords 

Data processing: The activity of processing data using a computer is called data processing.  

Generation: Originally, the term “generation” was used to distinguish between varying hardware 
technologies but it has now been extended to include both hardware and software that together 
make up a computer system.  

Integrated circuits: They are usually called ICs or chips. They are complex circuits which have been 
etched onto tiny chips of semiconductor (silicon). The chip is packaged in a plastic holder with pins 
spaced on a 0.1" (2.54 mm) grid which will fit the holes on stripboard and breadboards. Very fine 
wires inside the package link the chip to the pins.  

Medium scale integration (MSI): Medium-Scale Integration is a term used in electronic chip 
manufacturing industry. An integrated circuit which contained hundreds of transistors on each 
chip, called Medium-Scale Integration (MSI).  

Small-scale integration” (SSI): The first integrated circuits contained only a few transistors. Called 
“Small-Scale Integration” (SSI), they used circuits containing transistors numbering in the tens.  

Storage unit: The storage unit of the computer holds data and instructions that are entered through 
the input unit, before they are processed. It preserves the intermediate and final results before these 
are sent to the output devices.  

Very-large-scale integration (VLSI): It is the process of creating integrated circuits by combining 
thousands of transistors into a single chip. 

Binary number system: It is like a decimal number system, except that the base is 2, instead of 10 
which use only two symbols (0 and 1).  

n-bit number: An n-bit number is a binary number consisting of ‘n’ bits.  

Decimal number system: In this system, base is equal to 10 because there are altogether ten 
symbols or digits (0, 1, 2, 3, 4, 5, 6, 7, 8, and 9). 

 

Self-Assessment Questions 

1. Computer’s third generation is from…………. to …………  

(a) 1955-1964    (b) 1964-1975 

 (c) 1942-1955 (d) 1975-1989 

 2. Developed an electronic machine to solve certain mathematical equations.  

(a) Dr John Atanasoff   (b) Herman Hollerith 

 (c) Professors J. Presper Eckert   (d) All of these  
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Notes 3. The activity of processing data using a computer is called Data handling. 

 (a) True    (b) False 

4. A powerful computer is capable of performing several billion (109) arithmetic operation per 
second.  

(a) True     (b) False 

5. The second generation computers were manufactured by using ………… 

 (a) Vacuum tubes   (b) Transistors  

(c) IC Chip  (d) None of above  

6. ANSI stands for…………  

(a) American National Standards Institute  (b) Asia National Standards Institute 

7.Which of the following is not a positional number system? 

a)Roman Number System 

b)Octa l Number  System 

c)BinaryNumberSystem 

d) Hexadecimal Number System 

8.The value of radix in binary number system is _____________ 

a)2  

b)8 

c)10  
d) 1 

9.The input hexadecimal representation of 1110 is _______________ 

a)0111 

b)E 

c) 15 

d) 14 

10.A bit in a computer terminology means either 0 or 1. 

a) True 

b) False 

11.Convert the binary equivalent 10101 to its decimal equivalent. 

a)21 

b)12 

c) 22 

d) 31 

12.Which of the following is the correct representation of a binary number? 
a)(124)2 

b)1110 

c) (110)2 

d) (000)2 

13.Which of the following is not a binary number? 

a)1111 

b)101 
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Notes c) 11E 

d) 000 

14. A term in computer terminology is a change in technology a computer is/was being used. 
a)development 

b)generation 

c) advancement 

d) growth 

15. The fourth generation was based on integrated circuits. 

a) True 

b) False 

 

Review Questions 

1.What is “generation” in computer terminology? How many computer generations are there till 
date?  

 2.List the various computer generations along with the key characteristics of computers of each 
generation.  

3.List key hardware technologies used in building computers of each of the five generations. 

4.List key software technologies used in building computers of each of the five generations.  

5.What is an IC? How does it help in reducing the size computers?  

6.Why were first- and second-generation computers more difficult and costlier to produce 
commercially that computer of subsequent generations?  

7.Name the technologies used for constructing main memory in first-, second-, third-, and fourth-
generation computers.  

8.Name the secondary storage media popularly used, i.e. first-, second-, third-, fourth-, and firth-
generation computers. 

9.Find decimal equivalent of following binary numbers:  

(a) 1101011  

(b) 1000  

(c) 10110011  

(d) 11011101  

(e) 1110101 

(f) 1000 

(g) 10110001100 

(h) 110001 

(i) 1010101100  

(j) 111 

10.Convert the following numbers to decimal numbers:  

(a) 1101102 

(b) 25736 

(c) 2A3B16 

(d) 12349 
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Answers to Self-Assessment Questions 

1. B 2. A 3. B 4. A 5. B 

6. A 7. A 8. A 9. B 10. A 

11. A 12. D 13. C 14. B 15. B 

Further Readings 

 

Fundamental Computer Concepts, William S. Davis.  

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister 

 

https://www.javatpoint.com/computer-fundamentals-tutorial 
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Objectives 

After studying this unit, you will be able to:  

Understand the unit memory 

• Discussed the various types of memory  

• Explain the random access memory  

• Discussed the read only memory 

• Explain the auxiliary storage device 

 • Understanding of input and output devices in computer 

 • Knowledge and understanding of latest input and output devices in market  

Introduction 

CPU contains necessary circuitry for processing controlling other components of the pc . However, 

one thing it doesn't have built into it's the place to store programs and data needed 
during processing . CPU contains several registers for storing data and directions but they 

will store only a couple of bytes at a time. they're just sufficient to carry just one or two instructions 
with corresponding data. If the instructions and data of a program being executed by a CPU were 

to reside in auxiliary storage sort of a disk, and fetched and loaded one by one into CPU 

registers because the program execution proceeded, this is able to cause the CPU being idle most of 
the time. This isbecause there's an outsized speed mismatch between the speed at which CPU can 

process data and therefore the rate at which data can be transferred from disk to CPU registers. for 

instance , a CPU can process data at a rate of about 5 nanosecond/byte and a disk reader can read 
data at a speed of about 5 microseconds/byte. Hence, within the time during which a disk can 

supply one byte of knowledge a CPU can process 1000 bytes. this is able to cause a really slow 

overall performance albeit a computer used a really fast CPU. to beat this problem, there's a 
requirement to possess a fairly large space for storing which will hold the instructions and data of 

the program(s) on which CPU is currently working time to fetch and cargo data from this space for 
storing into CPU registers must even be very small as compared thereto space from disk storage to 

scale back the speed mismatch problem with CPU speed. Every computer has such a space for 

storing referred to as primary storage, main memory, or just memory. it's a short lived cargo 
area built into the pc hardware. Instructions and data of a program reside mainly during this area 

when CPU is executing the program. Physically, this memory consists of some microcircuit (IC) 

chips either on the motherboard or on a little circuit card attached to the motherboard of 

Bhanu, Lovely Professional University
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a computing system . This built-in memory allows CPU to store and retrieve data very 
quickly. the speed of fetching data from this memory is of the order of 

fifty nanoseconds/byte. Hence, the speed of knowledge fetching from main memory is about 

100 times. 

2.1 Units of Memory 

Starting with the Unit of memory, you can see the difference between things like a “Kilobyte” and a 

“Megabyte” and other computer memory terms. Memory devices are to store the data for later 

reference. The smallest unit of memory is defined as a Bit(0,1 
).The bit is a term shortly used instead of the word ‘Binary digit’, which is nothing but the 0’s and 

1’s. When the number of bits increases into four it is stated as a Nibble.Nibble can be defined as the 

collection of four bits, which is characterized as a hexadecimal number to store the data in the 
memory. Another terminology which is most used is Byte. A byte can be defined as the group of 

eight binary digits, which generally corresponds to the other compounds of 8 bits. This is the 
commonly used unit terminology, as it comes with the prefixes for the multiples of bytes, such as 

the prefixes as kilo-, mega-, giga-, tera-, peta-, etc. 

The charts below will give you a clear understanding of: 

 

Table 1 Units of Memory 

 
How many bytes in 2 GB describe with example? 

2.2 Types of Memory 

Computer memory is the storage space in the computer, where data is to be processed and 

instructions required for processing are stored. 
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Figure 2 Diagram of memory types 

Random Access Memory (RAM) 

When people mention memory, they typically mean the volatile RAM memory. Physically, this 

memory consists of some microcircuit (IC) chips (see Figure 3) either on the motherboard or on a 
little circuit card attached to the motherboard. A computer’s motherboard is meant during 

a manner that its memory capacity are often enhanced easily by adding more memory chips. 

Hence, if you opt to possess more memory than your computer currently has, you'll buy more 
memory chips and plug them within the empty memory slots on the motherboard. Service 

engineers normally do that job. the extra RAM chips which plug into special sockets on the 

motherboard, are referred to as single in-line memory modules (SIMMs). 

 

Figure 3 Random Access Memory 

Read-Only Memory (ROM) 

A special sort of RAM, called ROM (ROM), may be a non-volatile chip during which data is 

stored permanently and can't be altered by usual programs. In fact, storing data permanently 
into this type of memory is named “burning within the data” because data in such memory is 

stored by using fuse-links. Once a fuse link is burnt, it's permanent. Data stored during a ROM 

chip can only be read and used—they can't be changed. this is often the 
rationale why it's called ROM (ROM). Since ROM chips are non-volatile, data stored during 

a ROM aren't lost when power is transitioned or interrupted unlike within the case of a volatile 

RAM chip. ROM is additionally referred to as field stores, permanent stores, or dead stores. 
ROMs are mainly wont to store programs and data that don't change and are frequently 

used. most elementary computer operations are administered by wired electronic circuits. 

However, several higher-level and regularly used operations require very complicated electronic 
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circuits for his or her implementation. Hence, rather than building electronic circuits for these 
operations, special programs are written to perform them. These programs are called micro 

programs because they affect low-level machine functions and are essentially substitutes for 

extra hardware. ROMs are employed by computer manufacturers to store these micro-
programs in order that they can't be modified by theusers. an honest example of a micro-

program is that the set of instructions needed to form a computing system able to use 
when it's powered on. This micro-program, called ‘’system boot program”, contains a group of 

start-up instructions to see if the system hardware like memory, I/O devices, etc. are functioning 

properly. it's for an OS and loads its core part within the volatile RAM of the system to supply the 
initial display-screen prompt. Note that this micro-program is employed whenever the pc is 

switched on and wishes to be retained when the pc is transitioned. Hence, ROM is a 

perfect storage for storing it. 

Some of the characteristics 

• These are semiconductor memories. 

• It is known as the main memory. 

• Usually volatile memory. 

• Data is lost in case power is switched off. 

• It is the working memory of the computer. 

• Faster than secondary memories. 

• A computer cannot run without the primary memory. 

 

Figure 4 Read Only memory 

Programmable Read-Only Memory (PROM) 

There are two sorts of ROM (ROM) - manufacturer-programmed and userprogrammed. A 

manufacturer –programmed ROM is one during which data is burnt in by the manufacturer of the 
equipment during which it's used. for instance , a private computer manufacturer may store the 

system boot program permanently during a ROM chip located on the motherboard of every PC 

manufactured by it. Similarly, a printer manufacturer may store the printer controller software 
during a ROM chip located on the circuit card of every manufactured by it. Manufacturer-

programmed ROMs are used mainly in those cases where the demand for such programmed ROMs 

is large. Note that manufacturer-programmed ROM chips are supplied by the manufacturers of 
equipment and it's impossible for a user to switch the programs or data stored during a ROM chip. 

On the opposite hand, a userprogrammed ROM is one during which a user can load and store 

“read-only” programs and data. That is, it's possible for a user to “customize” a system by 
converting his/her programs to micro-programs and storing them during a user-programmed 

ROM chip. Such a ROM is usually referred to as Programmable ROM (EPROM) because a user can 
program it. Once the user programs are stored during a PROM chip they will be executed usually 

during a fraction of the time previously required. PROMs are programmed to record information 

employing a special device referred to as PROM-programmer. However, once the chip has been 
programmed, the PROM become a ROM. That is, the knowledge recorded in it can only be read (it 

can't be changed). PROM is additionally nonvolatile storage , i.e., the stored information remains 

intact albeit power is transitioned or interrupted. 

2.3 Secondary Storage Devices 

Secondary storage devices, as indicated by the name, save data after it's been saved by the 

first memory device , usually mentioned as RAM (Random Access Memory). From the 

instant you begin typing a letter in Microsoft Word, for instance , and until you click on “Save”, 
your entire work is stored in RAM. However, once you power off your machine,  that 
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storage device where you saved it, like internal or external hard disc drive, optical drives for CDs 

or DVDs, or USB flash drive.  

Primary storage of a computing system has following limitations:  

1. Limited Capacity. it's often necessary to store many millions, sometimes billions, and even 

trillions, of bytes of knowledge during a computer. Unfortunately, the storage capacity of primary 
storage of today’s computers isn't sufficient to store the massive volume of knowledge handled 

by most processing centers.  

2. Volatile. Primary storage is volatile and therefore the data stored in it's lost when power is 
turned off or interrupted. However, computer systems got to store data on permanent basis for 

several days, several months, or maybe several years.  

As a result, additional memory, called auxiliary memory or auxiliary storage , is employed with 
most computing system . auxiliary storage is non-volatile and has lower cost per bit stored but it 

generally has an operating speed far slower than that of primary storage. it's used primarily to 

store large volume of knowledge on permanent basis which will be partially transferred to 
primary storage, whenever required for processing. Over the years, several devices and 

media are used as auxiliary storage in computer systems. Many of them like punched paper and 

punched cards became obsolete now. they're mag tape , magnetic disc , optical disc , and 
memory storage devices. during this chapter, you'll study the terminologies, principles of 

operation, uses, and tradeoffs of various sorts of auxiliary storage devices. 

Hard Disks 

Hard disks are the first on-line auxiliary storage device for many computer systems 
today. they're made from rigid metal (frequently aluminum) platters and are available in many 

sizes starting from 1 to 14-inch diameter. 

 

Figure 5 Hard Disks 

Types of Hard Disks 

Depending on how they're packaged, hard disks are normally categorized into three types:  

1. Zip/Bernoulli Disk: It consists of one hard disc platter encased during a plastic cartridge. The 

disk commonly of 3‰-inch size having storage capacity of about 100 MB. The storage capacity 

slightly varies counting on the formatting style employed by a computing system with which it's 
used. Its disc drive , called zip drive, could also be of portable or fixed type. The fixed type is a 

component of a computing system permanently connected thereto. The portable type are often 

brought and connected to a computer for the duration of use and may then be disconnected and 
brought away. a zipper per disk are often easily loaded/unloaded into a zip drive even as we 

insert/remove a diskette during a diskette drive or a video cassette during a VCR. 
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                                                         Figure 6 A Disk Pack 

2. Disk Pack:It is made up of several hard disc platters (two or more) placed on a single central 

shaft. At the same time, both discs revolve. Its disc drive has a read/write head for each a vailable 

disc surface (keep in mind that when several discs are used in a disc system, the upper surface of 
the topmost disc and the lower surface of the bottommost disc are not always usable). Its disc drive 

is interchangeable, allowing for the loading and unloading of different disc packs as required. A 

disc pack is kept off-line in a plastic case when not in use (see Figure 6). Disk packs now have 

nearly infinite storage capacity. 

3. Winchester Disk: A Winchester disc is made up of several hard disc platters (two or more) 

placed on a single central shaft. A Winchester disc drive, on the other hand, is a fixed-type drive, 
unlike a disc pack drive. That is, the hard disc platters and disc drive are packed together in a 

contamination-free container and are unable to be removed.As a result, the ability of Winchester 
discs is reduced. However, for the same number of identically sized disc platters. Because of the 

following factors, Winchester discs can have a greater storage capacity than disc packs:  

(a) As both disk platters and disc drive are permanently sealed together, all surfaces of all disk 
platters (including the side of the topmost platter and therefore the lower surface of the bottommost 

platter) are used for data recording during a Winchester disk. That is. For a Winchester disk with 

four platters there are eight usable surfaces as against six surfaces just in case of a disc pack with 

four platters.  

(b) The contamination-free environment allows Winchester disks to use greater precision of 

knowledge recording and accessing, leading to greater data storage density than interchangeable 

disk packs.  

Winchester disks were so named after the 30-30 Winchester rifle because the first Winchester disk 
systems had two 30-MB disks. Storage capacity of today’s Winchester disks ranges from a couple of 

tens of megabytes to a couple of gigabytes (l09 bytes). 

Flash Drive (Pen Drive) 

Flash drive may be a compact device of the dimensions of a pen, comes in various shapes and 
classy designs (such as pen shape, wallet shape, etc.), and should have different added features 

(such like a camera, with a built-in N1P3lWMA/FM Radio replay for music on the go, etc.). It 

enables easy transport of knowledge from one computer to a different .it's a plug-and-play device 
that simply plugs into a USB (Universal Serial Bus) port of a computer. the pc detects it 

automatically as removable drive. Now one can read, write, copy, delete, and move data from the 

computer’s hard disc drive to the flash drive or from the flash drive to the hard disc drive. One can 
even run applications, view videos, or play MP3 files from it directly. Once done, it are often simply 

plugged out of the USB port of the pc and kept into the pocket for being carried anywhere. A flash 

drive doesn't require any battery cable, or software, and is compatible with most PCs, desktop, and 
laptop computers with USB 2.0 port. of these features make it ideal external data storage for mobile 

people to hold or transfer data from one computer to a different . because the name implies,  it's 

supported flush memory storage technology Recall that flash is non-volatile, Electrically Erasable 
Programmable Read Only Memory (EEPROM) chip. it's a highly Aid-state storage having data 

retention capability of quite 10 years. 
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Figure 7 Flash Drive (Pen Drive) 

Figure 7 shows a flash drive is seen It consists of a main body and, in most cases, a port connector 
cover. If the drive is to be inserted into a computer's USB port, the cover is removed or the port 

connector is pushed out. A write protect tab, a read/write LED (Light Emitting Diode) indicator, 

and a strap hole are normally found on the main body. Some manufacturers also have applications 

that can be used in conjunction with the drive. 

Optical Disk Drive 

An optical disc is mounted on an optical disc drive for reading/writing of data thereon. An optical 

disc drive contains all the mechanical, electrical, and electronic components for holding an optical 
disc and for reading/writing of data thereon. That is, it contains the tray on which the disk is kept, 

read/write laser beams assembly and motor to rotate the disk. Figure 8. shows an optical disc 

drive. 

 

Figure 8 Optical Disk Drive 

Types of Optical Disks 

All optical disks are round platters. they are available in several sizes and capacities. Commonly 

used sorts of optical disc are CD-ROM, WORM (CD-R), CD-RW, and DVD disks. they're described 

below.  

CD-ROM 

CD-ROM stands for Compact Disk-Read-Only-Memory. it's a spin-off of audio CD technology and 

works very similar to audio CDs utilized in music systems. In fact, if your computer has sound card 

and speakers, you'll play audio CDs together with your computer. CD-ROM disk may be a shiny, 
silver color metal disk usually of 5/4-inch (12 cm) diameter. it's made from polycarbonate plastic 

and thin layer of pure aluminum is applied to form the surface reflective. for a few excellent quality 
disks, gold layer is employed . a skinny layer of lacquer protects it. it's storage capacity of about 650 

Megabytes or 700 Megabytes in newer ones. it's so called due to its large storage capacity on a 

compact-size disk and since it's a read-only memory medium. “That is, these disks come pre-
recorded and knowledge stored on them can't be altered. Since an optical disc is read from the 

middle to fringes , several sizes are possible. aside from the foremost common 120mm 74/8 minute 

disk having storage capacity of 650 MB to 700 MB, 80mm 21 minute disk (called Mini-CD) having 
184 MB storage is additionally available. they will be used with the disc drive of a 120 mm disk. 

Mini CDs are designed in various fancy shapes like round, oval, triangle, etc., while ensuring that 

the cargo area is affected. 

29



Office Automation Tools 

 LOVELY PROFESSIONAL UNIVERSITY  

Notes 
CD Read/Write (CD-RW) Disk  

A CD Read/Write (CD-RW) disk is extremely almost like a WORM disk with the exception that 
you simply can erase the previous content and write of it multiple times. Such disks use metallic 

alloy layer. beam changes the property during writing (or burn process) changing reflectivity at 

desired places. The land-pit difference on CD-RW isn't significant and hence CD drives need to be 
compatible to read such disks. A CD-RW disk usually features a lifetime of 100 or more erase-write 

cycle. A disk written once are often erased by changing by the property again then it are often 
written on to afresh. CD-RW drives have such erase capability. CD-RW disks are little expensive 

than CD-R disks but are an excellent cost saver because they will be reused repeatedly thanks to 

their erase capability.  

Digital Video (or Versatile) Disk (DVD)  

DVD was designed primarily to store and distribute movies. However, it's fast becoming 

mainstream optical disc as prices are reducing and wish for giant capacity storage is increasing. it's 

almost like CD-ROM in theory but is denser in recording data. It follows Eight-toFourteen 
Modulation Plus %1Plus) encoding as compared to Eight-to-Fourteen Modulation (EFM) encoding 

employed by CD-ROM. There are variants of DVD—single-layer disk and doublelayer disk. Single-

layer disk has storage capacity of 4.7GB, whereas, double-layer disk has storage capacity of 8.5 GB. 

 • Like CD-ROM, DVD also has many types—DVD-R/RW, DVD+R/RW, DVD-Video, and DVD-

Audio. DVD-Video is now the foremost dominant movie storage format used. It allows storage of 

video in 4:3 or 16:9 aspect ratios in MPEG-2 video format using NTSC or PAL resolution. it's going 
to be of interest to notice that NTSC has resolution of 720 x 576 and PAL has resolution of 720 x 576. 

The audio is typically Dolby Digital (AC-3) or Digital Theater system (DTS) and may be either 

monaural or 5.1 Surround Sound. 

DVD has enough space to store movie and support multi-lingual subtitles, multi-lingual audio, 

multiple camera, angles etc. It also supports region marking to guard against piracy and use of 
DVD from one region to a different . It also supports Content Protection for Prerecorded Media 

(CPPM) security technique to safe guard against n; etc. 

2.4 Advantages and Limitations of Optical Disks 

Advantages  

1. The Cost-per-bit of storage for optical disks is extremely low due to their low cost and high 
storage density. Additional cost benefit comes from the very fact that some optical disks are often 

erased and reused repeatedly. 

2. Use of one spiral track makes optical disks a perfect data-storage medium for reading large 

blocks of sequential data like audio or video. 

 3. Optical disc drives don't have any mechanical read/write heads to rub against or crash into the 

disk surface. This makes optical disks a more reliable data-storage medium than magnetic tapes or 

magnetic disks. 

 4. Optical disks have a knowledge storage lifetime of over 30 years. This makes them a far better 

data-storage medium for data archiving as compared to magnetic tapes or magnetic disks. 

 5. Since data once stored on CD-ROM/WROM disks becomes permanent, the danger of stored 

data getting inadvertently erased/overwritten isn't there.  

6. Thanks to their compact size and light-weight , optical disks are easy to handle, store, and port 

from one place to a different . 

 7. Audio CDs are often played on a computer having a CD-ROM drive along side a sound card and 

speakers. this enables computer systems to be also used as music systems, whenever desired. 

8. A computer having a DVD drive are often wont to play DVDs allowing it to be used for watching 

videos like movies. 

 Limitations 

1. CD-ROM and WORM disks are read-only (permanent) storage mediums. Data once recorded, 

can't be erased. Hence, they can't be reused.  

2. Data access speed for optical disks is slower than magnetic disks. 
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necessity to possess a laser generating source and detection lens that need precision engineering 

and careful handling.  

4. Since the optical disc may be a removable media, it's susceptible to scratches, dust, sticky prints 

(including fingerprints), etc. while handling. Hence, they have careful handling. 

 5. When used for off-line storage, they ought to be labeled properly for straightforward 

identification. 

Uses of Optical Disks are used for the subsequent purposes: 

 1. For distributing large amounts of knowledge at a coffee cost. for instance , an entire 

encyclopedia, dictionary, world atlas, dictionary of quotations, biographies of great people, 

information about all educational institutions of a specific type during a country, etc. are often 

distributed on CD-ROM disks.  

2. For distribution of the electronic version of conference proceedings, journals, magazines, books, 

product catalogs, etc. 

 3. For distribution of audio like songs. 

 4. For distribution of latest or upgraded versions of software products by software vendors.  

5. For storage and distribution of a good sort of multimedia applications like video games.  

 6. For archiving of knowledge not used frequently but which can be used occasionally.  

7. WORM disks are often employed by end-user companies to form permanent storage of their own 
proprietary information. for instance , many banks use them for creating a  permanent record of 

their daily transactions. 

8. DVDs became a well-liked medium for the distribution of flicks . 

Summary 

• Secondary storage is a hard disc that stores more data in a computer. 

• Secondary storage facilities are hard discs. 

Keywords 

Flush memory: Storage technology Recall that flash is non-volatile, Electrically Erasable 

Programmable Read Only Memory (EEPROM) chip. 

 

 

Define all secondary storage devices 

 

Self-Assessment Questions 

1. RAM chips plugged into special sockets on the motherboard are known as ……… 

(a) SIMMs  

(b) SINNs 

(c) SIMNs  

(d) None of these 

 

2. The act of retrieving data from a storage location is called ……… 

(a) Memory write operation  

(b) Memory read operation 

(c) Memory read and write operation 

(d) None of these 
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3. ……………. storage system consists of a rotating disk coated with a thin metal.  

(a) Memory disc  

(b) Optical disk 

(c) Hard disk  

(d) None of these 

 

4.A plug and play storage device that simply plugs in the port of a computer is __________ 

(a) Flash drive 

(b) Compact disk 

(c) Hard disk 

(d) CD 

 

5.What does USB stand for? 

(a) Universal Signal Board 

(b) Universal Signal Bus 

(c) Universal Serial Bus 

(d) Universal Serial Board 

 

6.  A device similar to a flash drive ______________ 

(a) Memory card 

(b) Compact drive 

(c) Compact disk 

(d) Memory disk 

 

7. Which of the following is not a magnetic disk? 

(a) Floppy 

(b) Winchester 

(c) Zip 

(d) FLASH 

 

8. Brain of computer is ____________ 

(a) Control unit 

(b) Arithmetic and Logic unit 

(c) Central Processing Unit 

(d) Memory 

 

9. General register organization is also known as _______ CPU register organization. 

(a) Five  

(b) Seven 

(c) Six 
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10. The storage device that uses rigid, permanently installed magnetic disks to store data is 

(a). Floppy 

(b). Permanent disk 

(c). Optical disk 

d). Hard disk 

 

11.____________has smallest storage capacity 

(a). Floppy disk 

(b). Zip disk 

(c). Hard disk 

(d). CD 

 

12. How much is one terabyte equal to? 

(a). 1024 megabytes 

(b). 1024 bytes 

(c). 1024 kilobytes 

(d). 1024 gigabytes 

 

13. What is the term used for the disk content that is recorded at the time of manufacturer and that 

cannot be changed or erased by the user? 

(a). Read only 

(b). Write only 

(c). Once only 

(d). Run only 

 

14. Which of the following is the most common type of storage device? 

(a). Steel 

(b). Magnetic 

(c). Optical 

(d). Flash 

 

15. HDD stands for 

(a). High disk drive 

(b). Hard Digital disk 

(c). High digital drive 

(d). Hard disk drive 
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Answers 

1. A 2. B 3. B 4. A 5. C 

6. A 7. D 8. C 9. B 10. D 

11. A 12. D 13. A 14. B 15. D 

 

Review Questions 

1. What is a secondary storage? How does it differ from a primary storage? 

2. What are the main limitations of primary storage of a computer system? 

3. Why is the secondary storage used in most computer\stems? 

4. Name some popular secondary storage devices used in today’s computer systems. 

 

Further Readings 

 

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister. A Study of Computer 

Fundamental, Shu-Jung Yi 

 

https://www.tutorialspoint.com/computer_fundamentals/computer_memory 

 

 

34



Unit 3: Input/Output Devices 

 LOVELY PROFESSIONAL UNIVERSITY  

Notes 

Unit 03 – Input/ Output Devices 
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Outcomes 

In this unit we will learn 

• about various input/output devices 

• about different types of mouses 

• about different types of keyboards 

• differences among various printers 

Introduction 

In computing, input/output (I/O, or informally io or IO) is that the communication between an 
information science system, like a computer, and therefore the outside world, possibly a person's or 

another information science system. Inputs are the signals or data received by the system and outputs 

are the signals or data sent from it. The term also can be used as a part of an action; to "perform I/O" 

is to perform an input or output operation. 

I/O devices are the pieces of hardware employed by a person's (or other system) to speak with a 

computer. as an example, a keyboard or mouse is an data input device for a computer, while monitors 
and printers are output devices. Devices for communication between computers, like modems and 

network cards, typically perform both input and output operations. 

The designation of a tool as either input or output depends on perspective. Mice and keyboards take 
physical movements that the human user outputs and convert them into input signals that a 

computer can understand; the output from these devices is that the computer's input. Similarly, 
printers and monitors take signals that computers output as input, and that they convert these signals 

into a representation that human users can understand. From the human user's perspective, the 

method of reading or seeing these representations is receiving output; this sort of interaction between 
computers and humans is studied within the field of human–computer interaction. an extra 

complication is that a tool traditionally considered an data input device , e.g., card reader, keyboard, 

may accept control commands to, e.g., select stacker, display keyboard lights, while a tool 
traditionally considered as an output device may provide status data, e.g., low toner, out of paper, 

paper jam. 

In computer architecture, the mixture of the CPU and main memory, to which the CPU can read or 
write directly using individual instructions, is considered the brain of a computer. Any transfer of 

data to or from the CPU/memory combo, for instance by reading data from a disc drive, is considered 
I/O. The CPU and its supporting circuitry may provide memory mapped I/O that's utilized in low-

level programming, like within the implementation of device drivers, or may provide access to I/O 

Bhanu, Lovely Professional University
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channels. An I/O algorithm is one designed to take advantage of locality and perform efficiently 

when exchanging data with a auxiliary storage device, like a disc drive. 

 

Figure 1 Illustrating role of Input/Output devices in a Computer System 

3.1 Input Devices 

The data input device is a mechanical device that accepts data from outside world and translates 

them into a computer can interpret. Several input devices are available today. they will be broadly 

classified into following categories: 

• Keyboard devices  

• Point-and-draw devices  

• Data scanning devices 

• Digitizer  

• Electronic cards based devices.  

• Speech recognition devices  

• Vision based devices 

Different types of input devices are explained below along with-it applications. 

Keyboard devices 

Keyboard is a portable wired or wireless electronic device that contains all the alphabets, numeric, 

symbols and special characters. Keyboard devices are the foremost commonly used input devices 
today. they permit data entry into a computing system by pressing a group of keys (labeled buttons) 

neatly mounted on a keyboard connected to a computing system. the favored keyboard used today 

is that the 101-keys QWERTY keyboard. This device is used to enter information or input data into 

desktop/laptop. 

 

Figure 2 Qwerty keyboard 
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Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 keys or 108 keys 

are also available for Windows and Internet. 

The keys on the keyboard are as follows – 

 

 

Keys and Description 

Typing Keys 

These keys include the letter keys (A-Z) and digit keys (09) which generally give 

the same layout as that of typewriters. 

Numeric Keypad 

It is used to enter the numeric data or cursor movement. Generally, it consists of a 
set of 17 keys that are laid out in the same configuration used by most adding 

machines and calculators. 

Function Keys 

The twelve function keys are present on the keyboard which are arranged in a row 
at the top of the keyboard. Each function key has a unique meaning and is used for 

some specific purpose. 

Control keys 

These keys provide cursor and screen control. It includes four directional arrow 
keys. Control keys also include Home, End, Insert, Delete, Page Up, Page Down, 

Control (Ctrl), Alternate(Alt), Escape(Esc). 

Special Purpose Keys 

Keyboard also contains some special purpose keys such as Enter, Shift, Caps Lock, 

Num Lock, Space bar, Tab, and Print Screen. 

Table 1 Keys along with its description 

Alphabetic Keys 

• Alphabet keys are used to type letters, words or sentences. 

• There are 26 alphabet keys on a keyboard (from A to Z). 
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Figure 3 Alphabet keys on a keyboard 

Number Keys 

• Number keys are used to type numbers from 0-9. 

• There are 10 number keys on a keyboard. (0,1, 2,…9) 

• There are two set of number keys on a standard keyboard. 

 

Figure 4 Number keys on a keyboard 

Cursor Control Keys 

• It is also called as Arrow keys. 

• There are 4 cursor control keys. 

• These keys are used to move the cursor in four directions on the monitor- up, down,  left 

and right. 

 

Figure 5 Cursor control keys on a keyboard 

Home Key  

Moves the cursor to the starting of the current row in a document.    
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Figure 6 Home key 

End Key  

Moves the cursor to the end of the current row in a document.  

 

Figure 7 End key  

Esc Key     

A key on computer keyboards, usually labeled Escape key. This helps in aborting or cancelling of the 

current operations. 

 

 

Function keys 

• There are 12 function keys. 

• They are placed at the top row of the keyboard. 

• They are marked from F1 to F12. 

    Home 

    End 

Esc key 
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Figure 8 Function keys 

Functionality from F1 to F12 keys are described in below table  

 

 

Function 
Key 

Use 

F1 This key opens up the “Help Screen” for almost every program. 

F2 This key allows you to “Rename” a selected file/folder. 

F3 This key opens the “Search Feature” for the application that’s currently active.  

F4 Close an active window combining “Alt with F4”. 

F5 This key allows you to “Refresh/Reload” the current page or document window.  

F6 This key highlights the “Address bar” in most browsers. 

F7 This key “Spell/Grammar Checks” a document in microsoft applications.  

F8 With this key. “Turn on the Boot Menu” on the startup of your windows computer.  

F9 
“Refresh” a Microsoft Word document & “Send and Receive” emails on Microsoft 

Outlook. 
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F10 “Shift + F10” works same as right click that activates the menu bar.  

F11 
“Enter and Exit FullScreen Mode” on your internet browser with this function key.  

 

F12 
This key “Opens the Save As Dialogue Box” on Microsoft Word 

 

Table 2 Function keys and its usage 

Types of Keyboards 

The computer keyboard is a device that allows a person to input text using keys representing the 

alphabet, numbers, and special symbols. These devices come in different shapes and sizes. There are 

different styles to choose from, some specifically designed to suit your needs. 

 

Mechanical Keyboard 

 

Flexible keyboards 

 

Ergonomic Keyboards 

 

Gaming Keyboard 

 

 

Wireless Keyboard 

 

    

Handheld Keyboard 
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Projection Keyboard 

Point and Draw Device 

Interaction with computers was initially restricted mainly to text mode. However, it had been soon 
realized that interacting with computers in text mode is cumbersome and time-consuming. Hence, a 

replacement sort of interface called graphical interface (GUI), was devised for interacting with 
computers. A GUI provides a screen with icons (small images on the screen) or menus and allows a 

user to form rapid selections from them to offer instructions to a computer. For efficient utilization, 

OUI requires a data input device which will be used rapidly point to, and choose a graphic icon or 
menu item from the multiple options displayed on the screen. The keyboard though usable was 

found to be inconvenient and unsuitable for this requirement. Hence, research efforts to seek out an 

appropriate data input device to satisfy this requirement gave birth to many input devices sort of a 
mouse, trackball, joystick, light pen, and touch screen. Later it had been realized that a lot of of those 

devices, like mouse and lightweight pen, could even be used very effectively to make graphic 

elements on the screen like lines, curves, and freehand shapes. With this new ability, these devices 
came to be referred to as point-and-draw devices. These input devices have made computers a way 

more easily usable tool establishing them as a flexible tool for a good range of users including 

children, illiterate citizens, and graphic designers. Some commonly used point-and-draw devices are 

described below. 

 

Figure 9 Point and Draw Device 

Mouse 

Mouse is that the hottest point-and-draw device. it's a must have data input device on modern 
personal computers and workstations because they support GUI as their primary interface. A mouse 

may be a small hand-held device that matches during a user’s palm comfortably. It rolls on a little 

bearing and has one or more buttons on the highest. When a mouse that's connected to a user terminal 
is rolled on a flat surface, a graphics cursor moves on the terminal screen within the direction of the 

mouses movement. Since all movements of the mouse are reproduced by the graphics cursor on the 

screen, you'll move the graphics cursor at a menu item or an icon by moving the mouse.  It is a 
handheld hardware data input device that controls a cursor during a GUI (graphical user interface). 

It can move and choose text, icons, files, and folders on your computer. For desktop computers, the 
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mouse is placed on a flat surface (e.g., mouse pad or desk) ahead of your computer. Example of a 

personal computer mouse with two buttons and a wheel. Below is the image of a mouse with a pad. 

 

Figure 10 Wired Mouse with a pad 

The graphical cursor is displayed as a spread of symbols like an arrow, a wrist a pointing finger etc. 

counting on the appliance, the text and graphics cursor could also be displayed on the screen at an 
equivalent time. The graphics cursor, regardless of its size and shape, features a pixel-size point that's 

considered the purpose of regard to decide where the cursor is positioned on the screen. now is 

named hot-spot of the graphics cursor when the hot-spot is positioned at a menu item or an icon, the 

graphics cursor is claimed to point 

 thereto menu item or icon. With a click of the mouse’s button, the system can then be notified of this 

choice. Note that notifying the system of a specific choice, out of the varied options provided by the 
software, is far easier a mouse than pressing various key combinations. With proper software, a 

mouse also can be wont to draw picture on the screen and edit text. 

The rollerball based mouse is now being replaced with optical sensor based mouse. The optical sensor 
mouse features a light with a sensor arranged in such a fashion that the sunshine coming from the 

source is detected by the sensor after reflection from the surface. The on-board electronics on the 
mouse uses the reflection differences to calculate the direction and speed of movement and notifies 

the pc system. The optical sensor mouse is more sensitive, easier, and smoother to use. Another 

innovation in mouse is to possess user-programmable buttons on the edges and therefore the middle 
button on top is replaced with a wheel which will be rotated as scroll to scroll the screen display and 

may even be pressed as a button. 

 

Activities of a Mouse 

There are numerous functionalities of a mouse. Some of these activities are mentioned below which 

makes the life of a computer user very easy and efficient. 
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• Move the mouse cursor 

• Open or execute a program 

• Select 

• Drag-and-drop 

• Hover 

• Scroll 

• Perform other functions 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Types of Mouse 

When PCs first hit the marketplace for consumers, the pc mouse was simple and had limited 
functions. Today, there are numerous sorts of mouse and trackball designs to suit every computing 

style. 

Wired Mouse 

A wired mouse connects on to your desktop or laptop, usually through a USB port, and transmits 
information via the cord. The cord connection provides several key advantages. For starters, wired 

mice provide fast reaction time, because the data is transmitted directly through the cable. They also 

tend to be more accurate than other designs. this will make wired models great for gamers, digital 

artists, and other users who believe high accuracy. 

 

Figure 11 Wired Mouse 
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Wireless Mouse 

Wireless mice transmit radio signals to a receiver connected to your computer. the pc accepts the 
signal and decodes how the cursor was moved or what buttons were clicked. While the freedom or 

range with wireless models is convenient, there are some drawbacks. The decoding process, as an 

example, means a wireless mouse is typically not as conscious of gestures as a wired mouse. Gamers 
especially might find the lag frustrating. That said, there are specific wireless mice designed for 

gaming that address the latency issue in their design and have quicker response times. for several 

users, however, the lag or lost accuracy with a wireless model are getting to be negligible.  

 

Figure 12 Wireless Mouse 

Bluetooth Mouse 

Wireless mouse designs and Bluetooth mouse designs tend to seem very similar, as neither need a 

wired connection to work. Most wireless mice models use a dongle that connects to your PC, and 
therefore the mouse communicates back and forth therein manner. A Bluetooth mouse, however, 

utilizes an indoor Bluetooth connection on your PC, allowing you to attach the mouse to multiple 

devices at a time. 

 

Keep in mind, however, that not all devices have Bluetooth connections. If your computer doesn't 

have an indoor Bluetooth receiver, you'll get USB receiver which will be plugged into your computer 

to use together with your Bluetooth mouse and other Bluetooth devices. 

 

Figure 13 Bluetooth Mouse with USB to connect 

Wired vs. Wireless vs. Bluetooth Mice 

The debate of whether a wired or wireless mouse is the best choice is one of the oldest arguments. 

The fact is, they are both excellent choices depending on how you most often use your mouse. Here’s 

a quick comparison to help you decide: 

 

 

45



Office Automation Tools 

 LOVELY PROFESSIONAL UNIVERSITY  

Notes 

Table 3 shows the advantage and disadvantage among Wired, Wireless and Bluetooth Mouse 

Trackball Mouse 

A trackball mouse looks tons like an upside-down mouse. These mice feature a ball with sensors that 

move the cursor on the screen when the ball is moved together with your thumb. A trackball 

generally requires less effort to maneuver around than a wired or wireless mouse while also allowing 
easier scrolling. That said, a mouse generally gives you more freedom of movement and faster 

reaction time, which makes non-trackball styles better for gaming and computing activities that need 

heavy mouse use. 

 

 

Optical Mouse 

Technically, all mice are optical and take images thousands of times per second because the mouse 

is moved. Traditional mice track the X and Y coordinates of the peripheral. truth optical mouse uses 
a red or infrared LED light projected onto a surface to trace movement by bouncing the sunshine off 

the surface into a CMOS sensor, which converts the sunshine particles into an electrical current. The 

resulting analog data passes over 10,000 digital images each second. The result's smooth movement 
and accurate pointing on your display that does not require a mouse pad and even allows the mouse 

to figure over a glass surface. 
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Laser Mouse 

Whether wired or wireless, an optical mouse and laser mouse are considerably alike in design but 
have one key difference. While optical mice use infrared LED light to bounce off surfaces to trace 

movement, laser mice utilize an LED outside the color spectrum and appears to possess no light in 

the least. Both types perform well, but laser mice models tend to possess a touch more accuracy. 

Either way, both mouse types are excellent choices for normal PC duties. 

 

 

 

Trackball vs. Optical vs. Laser Mice 

Although very similar in how they function, there are some distinct differences between trackballs, 
optical mice and laser mice. What you choose should depend on your ergonomic and accuracy needs. 

Here’s a quick comparison to help you decide: 

 

Table 4 Shows the advantage and disadvantage of Trackball, Optical and Laser Mice  
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USB Mouse 

A USB mouse is one of the most common types of computer mice and has been a part of computer 
peripherals since the USB Standard was set in 1996. USB computer mice may be wired or wireless. 

The wired mouse plugs into a USB slot on your PC, while a wireless mouse usually has a transmitter 

that plugs into the USB slot and communicates with the mouse. These are good standard mice for all 

PC activities. 

Gaming Mouse 

Gaming mice are available in both wired and wireless designs and should include additional features 

beyond standard models to enhance your gaming experience. generally, these mice models are 
designed to try to everything a traditional mouse can do while offering higher accuracy, less latency, 

and more ergonomic designs. 

Other key features which will be found with gaming mice are the inclusion of more buttons (which 
could also be programmable for unique in-game use), flashy designs, DPI control, and customizable 

drivers which will be tailored to your specific gaming needs. Some gaming mouse models even have 

adjustable weights, which may make a difference when making repeated movements together with 
your mouse over long gaming sessions. And, of course, you'll still use your gaming mouse for non-

gaming day-to-day activities also. 

 

Working of a Mechanical Mouse 

Mouse allows quick and straightforward access to several icons and operations on the pc, like 
selecting from an inventory of possible actions (menu), work with Windows and moving files. once 

you move the mouse, the rubber ball turns and runs two rollers, both related to wheel with slots. 
LED (LED) sends light through the slits and transducers convert light into an electrical signal. 

Pressing the button will send additional information to the pc. 

The main goal of any mouse is to translate the motion of your hand into signals that the pc can use. 

Let's take a glance inside a track-ball mouse: 

 

Figure 14 Shows the different parts of a Mechanical Mouse 
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1. Roller - Roller turns by turning the rubber ball back and forth 

2. Rubber Ball - The ball is turning when you run the mouse over the surface 

3. Moving Roller 

4. Slotted wheel - This wheel with the slots associated with vertical rollers. 

5. Light emitting diode 

6. Converter 

7. Cable coupling 

8. Plastic housing 

9. Cable - cable connects the mouse to the computer through input on your computer 

10. Chip - The chip processes data from the transducer movement and buttons before it transmits 

them to computer 

11. Right button - The button pressing their work to encourage the chip and the chip sends signals 

to the computer 

12. Roller - This is moved by rotation of Roller balls 

 

Figure 15 Working of  a  mechanical mouse 

Figure 15 shows the internal working of a mechanical mouse where these below mentioned 

components plays an important role. 

1. Wheel with slots - when the wheel rotates, the movement of the slot next to the diode produces 

light flashes 

2. Light-emitting diode (LED) - LED sends light through the slits on the outer edge of the wheel 

3. Converter - Converter code flashes of light into electrical signals. 

4. Roller Lever - Lever roller transfers spins on the wheel with slits. 

How do optical mouse works? 

It appears that the venerable wheeled mouse is in peril of extinction. The now-preferred device for 

pointing and clicking is that the optical mouse. ­ 

Developed by Agilent Technologies and introduced to the planet in late 1999, the optical mouse uses 

a small camera to require 1,500 pictures every second. ready to work on almost any surface, the 

mouse features a small, red LED (LED) that bounces light off that surface onto a complementary 

metal-oxide semiconductor (CMOS) sensor. 
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The CMOS sensor sends each image to a digital signal processor (DSP) for analysis. The DSP, 
operating at 18 MIPS (million instructions per second), is able to detect patterns within the images 

and see how those patterns have moved since the previous image. supported the change in patterns 

over a sequence of images, the DSP determines how far the mouse has moved and sends the 
corresponding coordinates to the pc. the pc moves the cursor on the screen supported the coordinates 

received from the mouse. This happens many times each second, making the cursor appear to 

maneuver very smoothly. 

Optical mice have several benefits over wheeled mice: 

• No moving parts means less wear and a lower chance of failure. 

• There's no way for dirt to urge inside the mouse and interfere with the tracking sensors. 

• Increased tracking resolution means smoother response. 

• They don't require a special surface, like a mouse pad. 

Although LED-based optical mice are recent, another sort of optical mouse has been around for over 

a decade. the first optical-mouse technology bounced a focused beam of sunshine off a highly 
reflective mouse pad onto a sensor. The mouse pad had a grid of dark lines. whenever the mouse 

was moved, the beam of sunshine was interrupted by the grid. Whenever the sunshine was 

interrupted, the sensor sent a sign to the pc and therefore the cursor moved a corresponding amount. 
this type of optical mouse was difficult to use, requiring that you simply hold it at precisely the proper 

angle to make sure that the sunshine beam and sensor aligned. Also, damage to or loss of the mouse 

pad rendered the mouse useless until a replacement pad was purchased. Today's LED-based optical 

mice are much more user-friendly and reliable. 

  

 

Figure 16 Internal Structure of an Optical Mouse 

3.2 Data Scanning Devices 

Data scanning devices are input devices used for direct data entry into a computing system from 
source documents. several them also are capable of recognizing marks or characters. These devices 

have following characteristics: 

1. They eliminate the necessity for manual entry of knowledge by citizenry. Automatic entry of 
knowledge with their use improves data accuracy and increases timeliness of the knowledge 

processed. 

2. They demand top quality of input documents due to direct data entry from source documents. 

Documents that are typed poorly, have strikeovers, or have erasures are normally rejected.  

3. Form design, and ink specification usually becomes more critical with the utilization of those 
devices than when keyboard devices are wont to key in data from forms. Data scanning devices are 

of the many types. Commonly used ones are described below 

Image Scanner 

An image scanner is a data input device that translates paper documents into an electronic format 
which will be stored in computer. The input documents could also be typed text, pictures, graphics, 

or maybe handwritten material. This data input device has been found to be very useful in preserving 

paper documents in electronic form. a replica of a document stored during a computer during this 
manner will never deteriorate in quality or become yellow with age, and may be displayed or printed, 
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whenever desired. The stored images can even be altered and manipulated in interesting ways, if the 

pc has image-processing-software. 

Image scanners come in various shapes and sizes. Two commonly used types are: 

• Flatbed scanner. A flatbed scanner is sort of a copier machine consisting of a box having a 

glass plate on its top and a lid that covers the glass plate. A document to be scanned is placed 

the wrong way up on the glass plate. a light-weight source, situated below the glass plate, 

moves horizontally from one end to a different when activated. After scanning one line, the 

sunshine beam moves up a touch and scans subsequent line. the method is repeated for all 

the lines. It takes about 20 seconds to scan a document of size 21 cm x 28 cm. 

• Hand-held scanner. A hand-held scanner features a set of sunshine emitting diodes encased 

during a small case which will be held in hand conveniently (See Figure 4.10). To scan a 

document, the scanner is dragged slowly over it from its one end to the opposite end with 

its light on. The scanner has got to be dragged very steadily and punctiliously, otherwise 

the conversion of the document into its equivalent bit map will not be correct. thanks to this 

reason, handheld scanners are used only in cases where high accuracy is not needed. they 

are also used when the quantity of documents to be scanned is low. they are less expensive 

than flatbed scanners. 

Optical Character Recognition (OCR) Device 

When image scanners are used for inputting text documents (typed or handwritten), they need 

following two limitations:  

1. Since a scanned input document is stored as a picture, rather than text, it's impossible to try to any 

data processing of the document (the computer cannot interpret the stored document as letters, 

numbers and special characters).  

2. Space for storing required for storing the document as a picture is far quite that required for storing 

an equivalent document as a text. for instance, a page of printed text having 2000 characters are often 
stored as 2000 bytes by using the ASCII representation. A bitmap-image representation of an 

equivalent document would require 10 to fifteen times more storage counting on the resolution 
(granularity) of grid points. OCR technology is employed to beat these limitations. during this case, 

the scanner is provided with character recognition software (called OCR software) that converts the 

bitmap images of characters to equivalent ASCII codes. That is, the scanner first creates the bitmap 
image of the document then the OCR software translate the array of grid points into ASCII text that 

the pc can interpret as letters, numbers, and special characters. OCR software is extremely complex 

because it's difficult to form a computer recognize a vast number of typefaces and fonts. Hence, this 
software are designed to acknowledge texts written using standard type fonts (called OCR fonts). 

Two such standard fonts are OCR-A (American standard) and OCR-B (European standard). Note 

that if the document contains italics or bold face letters, or fonts aside from that that the OCR software 

has been designed, the OCR software won't work effectively. 

Digitizer 

A digitizer is an data input device used for converting (digitizing) pictures, maps, and drawings into 

digital form for storage in computers. for instance, the x and y coordinates of points during a drawing 
could also be stored in digital form. this permits re-creation of the drawing from the stored 

information and straightforward incorporation of changes within the drawing, whenever required. 

A digitizer consists of a digitizing tablet (also referred to as graphics tablet) related to a stylus.  

The digitizing tablet may be a flat surface that contains many fine copper wires forming a grid. Each 

copper wire receives electric pulses. The digitizing tablet are often cover a working table and is 
connected to a computer. The stylus a sort of a pen or a lens-like cursor with a cross wire and button. 

it's connected to the tablet and may be pressed down at some extent on the tablet to input the (x, y) 

coordinates of the purpose. On moving the stylus on the tablet, a cursor on computers screen moves 
simultaneously to a corresponding position on the screen to supply visual feedback to the operator. 

this permits the operator to draw sketches directly or to input sketched drawings very easily. 

Inputting drawings or developing sketches by employing a digitizer is further simplified by the very 
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fact that poorly sketched lines, arcs, and other graphical objects are automatically input as 

mathematically precise objects like straight lines and smooth curves.  

Digitizers are used commonly within the area of Computer Aided Design (CAD) by architects and 

engineers to style cars, buildings, medical devices, robots, mechanical parts, etc. they're also utilized 

in the world of Geographical data system (GIS) for digitizing of maps available in paper form 

3.3 Output Devices 

An output device is an electromechanical device that accepts data from a computer and translates 

them into a form suitable for use by outside world (users). Several output devices are available today. 

They can be broadly classified into following categories:  

1. Monitors  

2. Printers  

3. Voice response system  

4. Plotter 

5. Screen image projector 

These types of output devices along with their applications are described in next page. Output 

devices generate computer output that can be broadly classified into following two types: l. Soft-copy 
output. A soft-copy output is not produced on a paper or some material that can be touched and 

carried for being shown to others. They are temporary in nature. For example, content displayed on 

a terminal screen, or words spoken out by a voice response system are S011-copy output. 2. Hard-
copy output. A hard-copy output is produced on a paper or some material that can be touched and 

carried for being shown to others. They are permanent in nature and can be kept in paper files or can 

be looked later when the person is not using a computer. For example. output produced on paper by 

printers or plotters are hardcopy output. 

Monitors 

Monitors are the foremost popular output devices used today for producing soft-copy output. They 

display the generated output on a television like screen. A monitor is associated usually with a 
keyboard and together they form a display screen terminal (VDT). A VDT (often mentioned as just 

terminal) is that the hottest input/output (I/O) device used with today’s computers. It is both an 
input and output device. The keyboard is employed for input to a computer and therefore the 

monitor is employed to display the output from the pc. The name “terminal” comes from the very 

fact that a terminal is at the terminus or end of a communication path. Two basic sorts of monitors 
used today are cathode-ray-tube (CRT) and LCD (Liquid Crystal Display) flat-panel. CRT monitors 

work very similar to a television screen and are used with nonportable computer systems. On the 

opposite hand, LCD flat-panel monitors are thinner, lighter. and are used commonly with personal 
computer systems like notebook computers. With gradual reduction in price of LCD flat panel 

monitors, they're used increasingly with nonportable personal computer systems also. they're also 

preferred because they occupy less table space. 

 

Figure 17 A Video Display Terminal Consists of a Monitor and a Keyboard 
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LCD Monitor 

LCD stands for liquid Display, pertaining to the technology behind these popular flat panel monitors. 
An LCD monitor is distinguishable from a standard CRT monitor because the latter features a bulky 

footprint with a depth of several inches and a weight 13-23 kilograms or more, while LCDs are 

commonly 1-3 inches (2.5-7.5 cm) thick and weigh but 4.5 k. 

LCD displays were used on laptop computers before the technology improved enough to form the 

jump to desktop monitors. An LCD monitor consists of 5 layers: a backlight, a sheet of polarized 

glass, a “mask” of colored pixels, a layer of liquid solution aware of a wired grid of x , y coordinates, 
and a second polarized sheet of glass. By manipulating the orientations of crystals through precise 

electrical charges of varying degrees and voltages, the crystals act like tiny shutters, opening or 

closing in response to the stimulus, thereby allowing degrees of sunshine that have skilled specific 

colored pixels to illuminate the screen, creating an image . 

 

 

 

 

 

 

 

 

Figure 18 LCD Monitor 

Printers 

Printers are the most popular output devices used today for producing hard-copy output. Different 

types of printers are described below 

Dot Matrix Printers 

Dot-matrix printers arc character printers that print one character at a time. They form characters and 

everyone sorts of images as patterns of dots. Figure 4.16 shows how various sorts of characters are 

often formed as patterns of dots. A matrix printer features a print head that moves horizontally (left 
to right and right to left) across the paper. Print contains an array of pins which will be activated 

independent of every other to increase and strike against an inked on to make patterns of dots on the 

paper. To print a personality, the printer activates the acceptable set of pins because the print head 
moves horizontally. For faster printing, many dot-matrix printers print both ways—while the printer 

head moves from left to right and while it moves from right to left, on return. Such method is named 

bidirectional printing. Figure 4.16 shows a dot-matrix printer. 

 

Figure 19 Dot Matrix Printer 
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Since matrix printers produce printed output as patterns of dots, they will print any shape of 

character that a gram can describe. They, therefore, can print many special characters, different sizes 

of print, and even have the power to print graphics like charts and graphs. Dot-matrix printers are 
impact printers because they print by hammering the pins on the inked ribbon to go away ink 

impressions on a paper. Hence, they will be wont to produce multiple copies by using carbon or its 

equivalent. thanks to impact printing, dot-matrix printers are noisy as compared to non-impact 

printers. 

Dot-matrix printers are normally slow with printing speeds starting from 30 to 600 characters per 

second. However, they're cheap in terms of both initial cost and price of operation. Hence, they're 
preferred by individuals and organizations for generating printed outputs if the speed and quality 

of printing aren't important factors. they're also used for applications requiring multi-copy output 

like shipping forms and invoice that on impact printing for generating multiple copies. 

Inkjet Printers 

Inkjet printers are character printers that form characters, and everyone sorts of images by spraying 

small drops of ink on paper. The print head of an inkjet printer contains up to 64 tiny nozzles which 

will be heated selectively during a few microseconds by a microcircuit resistor. When the resistor 
heats up, the ink near it vaporizes and is ejected Through the nozzle making a dot on the paper placed 

ahead of the print head. To print a personality, the printer selectively heats the acceptable set of 
nozzles because the print head moves horizontally. Figure 4.18 shows an inkjet printer. Inkjet printers 

produce higher quality output than dot-matrix printers do because they form characters by very tiny 

ink dots. A high-resolution inkjet printer has as many as 64 nozzles within a height of 7mm’providing 

print resolution of around 360 dots per inch. 

 

Since inkjet printers produce printed output as patterns of small dots, they will print any shape of 

characters that a program can describe. this enables the printer to print many special characters, 
different sizes of print, and therefore the ability to print graphics like charts and graphs. Inkjet 

printers are non-impact printers because they print by spraying ink on the paper. Hence, they're 

quieter operational. Being of non-impact type, they can't be wont to produce multiple copies of a 
document during a single printing. A color inkjet printer usually comes with two ink cartridges—

black and tricolor. The tri-color cartridge contains red, blue, and yellow colors during a package 

which will mix appropriate amount of those colors with black from the opposite cartridge to urge 
any desired color with saturation. This makes it possible to urge multi-colored and photo quality 

output from inkjet printers. Inkjet printers are slower than dot-matrix printers are with printing 
speeds starting from 40 to 300 characters per second. Typically, an inkjet printer is costlier than a dot-

matrix printer. they're preferred if speed of printing isn't a crucial factor. 

Figure 20 A typical Dot-matrix output 
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Drum Printers 

Drum printers are line printers that print a whole line at a time. Recall that matrix and inkjet printers 
print one character at a time. Figure 4.19 shows the print mechanism of a line printer. It consists of a 

solid cylindrical drum with characters embossed (raised characters) on its surface within the sort of 

circular bands. Each band consists of all the printing characters supported by the printer in its list. 
Total number of bands is adequate to the utmost number of characters (print positions) which will 

be printed on a line. Hence, a line printer with 132 characters per line and supporting a personality 

set of 96 characters will have altogether 12,672 (132 x 96) characters embossed on its surface. 
additionally, to the drum, the printer features a set of hammers (one opposite each band) mounted 

ahead of the drum during a manner that an inked ribbon and paper are often placed between the 

hammers and therefore the drum. the entire number of hammers is adequate to the entire number of 

bands on the drum, which is additionally adequate to the entire print positions per line.  

 

Figure 21 Drum Printer 

The drum rotates at a high speed. a personality is printed at a desired print position by activating the 
acceptable hammer when the character embossed on the band at the print position passes below it. 

Hence, the drum would need to complete one full revolution to print each line of output. this suggests 

that not all characters on a line are printed at precisely the same time, but the time required to print 

a whole line is so fast that it appears as if one line is printed at a time. 

The drum of a line printer is dear and can't be changed often. Hence, drum printers can print a pre-

defined set of characters only during a pre-defined style embossed on the drum. Drum printers, 
therefore, don't have ability to print any shape of characters, different sizes of print, and graphics like 

charts and graphs. 

Drum printers are impact printers because they print by hammering on a paper and inked ribbon 
against the -3cters embossed on the drum. Hence, they will be wont to produce multiple copies by 

using carbon or its equivalent. thanks to impact printing, drum printers are noisy operational and 
sometimes use a canopy to scale back the background level. Printing speeds of drum printers are 

within the range of 300 to 2000 lines per minute. 

Laser Printer 

Laser printers are page printers that print one page at a time. Main components of a  electrostatic 
printer are a beam source, a multi-sided mirror, a photoconductive drum, and toner (tiny particles of 

oppositely charged ink). To print a page of output, the beam is concentrated on the electro statically 

charged drum by the spinning multi-sided mirror. The mirror focuses the beam on the surface of the 
drum during a manner to make the patterns of characters/images to be printed on the page. Since 

the drum is photoconductive, a difference in charge is made on those parts of the drum surface that 

are exposed to the beam. As a result, the toner, composed of oppositely charged ink particles, sticks 
to the drum within the places where the beam has charged the drum’s surface. The toner is then fused 

permanently on. The paper with heat and pressure to get the printed output. The drum is then rotated 

and cleaned with a rubber blade to get rid of the toner sticking to its surface to organize the drum for 

next page printing. 
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Figure 22 Laser Printer 

Laser printers produce very top-quality output because they form characters by very tiny ink 

particles. the foremost -common laser printers have resolution of 600 dpi (dots per inch), whereas 
some high-end laser printers have resolution. of 1200 dpi. thanks to their high resolution, these 

printers give excellent graphics art quality. 

Since laser printers produce printed output as patterns generated by the beam, they will print any 

shape of characters that a program can describe. They, therefore, can print many special characters, 

different sizes of print, even have the power to print graphics like charts and graphs. 

Laser printers are non-impact printers. Hence, they're very quiet operational. Being of non-impact 

type, they will not be wont to produce multiple copies of a document during a single printing. 

Although most laser printers can print in black color only because they need one toner drum 
arrangement, now even color laser printers are available at affordable price. A color electrostatic 

printer like color inkjet printer four color toners, each with a drum of its own. The usage of drums 

and toners are same as earlier, but drum is charged in such how that together they produce the 

specified color output. 

Laser printers are faster in printing speed than other printers discussed earlier. Low speed laser 
printers can print 4 = pages per minute. High-speed laser printers also are available. due to their 

better print quality and printing speed, laser printers are costlier than other sorts of printers.  

Plotters 

We learnt earlier that matrix, inkjet, and laser printers are capable of manufacturing graphics output. 

However, engineering design applications like plan of a building, design of mechanical components 
of an aircraft or a car etc., often require high quality, perfectly proportioned graphic output on large 

sheets. The various: sorts of printers discussed above aren't suitable for meeting this output 
requirement of such applications. A special sort of output device, called plotters, is employed for this 

purpose. Plotters are a perfect output device for architects, engineers, city planners, et al. who got to 

routinely generate high-precision, hard-copy, graphic output of widely varying sizes. ‘Two 

commonly used sorts of plotters are drum plotter and flatbed plotter. they're described below: 

Drum Plotters 

In a drum plotter, the paper on which the planning is to be made is placed over a drum which will 

rotate in both clockwise and anti-clockwise directions to supply vertical motion. The mechanism also 
consists of 1 or more penholder mounted perpendicular to the drum’s surface. The pen(s) clamped 

within the holder(s) can move left to or right to left to supply horizontal motion. A graph-plotting 

program controls the movements of the drum and pen(s) that’s, under computer control, the drum 
and pen(s) move simultaneously to draw designs and graphs; sheet placed on the drum. The plotter 

also can annotate the designs and graphs so drawn by using the pen to draw characters of varied 

sizes. Since each pen is program selectable, pens having ink of various colors are often mounted in 

several holders to supply multi-colored design 
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Figure 23 Drum Plotter 

 

 

 

 

 

 

 

 

 

 

Figure 24 A Flat-bed Plotter 

 

3.4 Latest Input Devices in Market 

1. Keyboard 

2. Pointing Devices 

(a) Mouse 

(i) Mechanical mouse 

(ii) Optical mouse 

(b) Track Ball 

(c) Joystick 

(d) Touch Screen 

(e) Light Pen 

(f) Touch Pad 

4. Digital Camera 

5. Scanner 

6. Microphone 

7. Graphic Digitizer 

8. Optical Scanners 
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9. Optical Character Recognition (OCR) 

10. Optical Mark Recognition (OMR) 

11. Magnetic-Ink Character Recognition (MICR)  

12 Bar Code Reader (BCR) 

3.5 Latest Output Devices in Market 

1. Monitor 

 2. Compact Disk 

 3. Printers  

4. Speaker 

 5. Disk Drives 

 6. Floppy Disk  

7. Headphone 

 8. Projector 

 Summary 

• Secondary storage is a hard disk that save more data in computer.  

• Hard disk is secondary storage services.  

• Input device means that provide the input from user side in the computer.  

• Output devices is used display the result of computer.  

• Digitizer consists of a digitizing tablet (also known as graphics tablet) associated with a stylus.  

• A potter is special type of output device that use in computer.  

• Lager printer are non-impact printer; they are very quiet in operation. Being of nonimpact type, 

they cannot be used to produce multiple copies of a document in a single printing. 

Keywords 

Terminal: A monitor is associated usually with a keyboard and together they form a Video Display 
Terminal (VDT). A VDT (often referred to as just terminal) is the most popular input/output (I/O) 

device used with today’s computers. 

Plotter: A special type of output device, called plotters, is used for this purpose. Plotters are an ideal 
output device for architects, engineers, city planners, and others who need to routinely generate high-

precision, hard-copy, graphic output of widely varying sizes. 

LCD: LCD stands for Liquid Crystal Display, referring to the technology behind these popular flat 

panel monitors. 

Digitizer: A digitizer is an input device used for converting (digitizing) pictures, maps, and drawings 

into digital form for storage in computers. For example, the x and y coordinates of points in a drawing 

may be stored in digital form. 

 

1. Define output device.  

2. Define all secondary storage devices. 

Self-Assessment 

1. RAM chips plugged into special sockets on the motherboard are known as ……… 

(a) SIMMs (b) SINNs 

(c) SIMNs (d) None of these 

2. The act of retrieving data from a storage location is called ……… 

(a) Memory write operation (b) Memory read operation 
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3. ……………. storage system consists of a rotating disk coated with a thin metal.  

(a) Memory disc (b) Optical disk 

(c) Hard disk (d) None of these 

4. LED indicator stands for ……………… 

(a) Light-emitting diode (b) Level-emitting diode 

(c) Low-emitting diode (d) None of these 

5. A …………….. is a pointing device similar to a roller-ball mouse? 

(a) Electronic pen (b) Trackball 

(c) All of above (d) None of these 

6. A color inkjet printer comes with two ink cartridges-black and …….. 

(a) Tricolor (b) Blue, green, white (c) None of these 

7. A4 size is equal to 8" × 12" page. 

(a) True (b) False 

8. CRT stands for ………….. 

(a) Crystal ray tube (b) Cathode ray tube 

9. The UPC bar code patterns are decoded as ………. digit. 

(a) 5 (b) 10 

(c) 12 (d) 2 

10.Input Devices that use a special ink that contains magnetizable particles of iron oxide are ____ 

a) Optical disks 

b) Magnetic disks 

c) MICR 

d) Magnetic drives 

11.Which of the following is a name of plotter as well as a printer? 

a) Flatbed 

b) Laser 

c) Drum 

d) Impact 

12.Which of the following is not a part of a digitizer? 

a) Digitizing tablet 

b) Cursor 

c) Stick 

d) Stylus 

13. Which of the following Printers have a speed in the range of 40-300 characters per second? 

a) Inkjet 

b) Laser 

c) Dot matrix 

d) Drum 

14.Which of the following is a temporary output? 

a) Hard copy 

b) Soft copy 
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c) Duplicate copy 

d) On paper 

15. MICR character set consists of only 2 digits 0 and 1. 

a) True 

b) False 

Review Questions 

1. What is a secondary storage? How does it differ from a primary storage? 

2. What are the main limitations of primary storage of a computer system? 

3. Why I/O devices are necessary for a computer system? 

4. What are peripheral devices? Why are they called so? 

5. Why I/O devices are very slow as compared to the speed of primary storage and CPU? 

6. What is an input device? Name some commonly used input devices. 

7. What are keyboard devices? 

8. What are point-and-draw devices? Name some commonly used point-and-draw devices. 

9. Explain how information is recorded on a magnetic tape. 

10. Why is the secondary storage used in most computer\stems? 

11. Name some popular secondary storage devices used in today’s computer systems.  

12. What is a sequential-access storage device? Write examples of a few applications for which such 

a storage device is suitable. 

13. What is a random-access storage device ‘? Write examples of a few applications for which such a 

storage device is suitable. 

14. Distinguish between a sequential access, a direct access, and a random-access storage device. 

Write one example of each. 

15. What factors determine storage capacity of disks? 

Answers for Self-Assessment Questions  

1. (a)  2. (b)  3. (b)  4. (a)  5. (b)  6. (a)  7. (b)  8. (b)  9. (b) 

10.(c) 11.(c) 12.(c) 13.(a) 14.(b) 15.(b) 

Further Reading 

   

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister. A Study of Computer 

Fundamental, Shu-Jung Yi. 

 

https://www.tutorialspoint.com/computer_fundamentals/computer_input_devices.ht

m 
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Objectives 

• After studying this unit, you will be able to:  

• Understand the windows various features.  

• An overview of different properties of windows  

• Discussed about the desktop and its display.  

• Explain the execution pattern of My Computer.  

• Discussed the using of My Computer, also adjuster of system sittings with computer. 

Introduction 

Microsoft Windows, commonly mentioned as Windows, may be a group of several proprietary 
graphical OS families, all of which are developed and marketed by Microsoft. Each family caters to a 

particular sector of the computing industry. Active Microsoft Windows families include Windows 

NT and Windows IoT; these may encompass subfamilies, (e.g., Windows Server or Windows 
Embedded Compact) (Windows CE). Defunct Microsoft Windows families include Windows 9x, 

Windows Mobile, and Windows Phone. 

Microsoft introduced an operating environment named Windows on November 20, 1985, as a 
graphical OS shell for MS-DOS in response to the growing interest in graphical user interfaces 

(GUIs).[5] Microsoft Windows came to dominate the world's pc (PC) market with over 90% market 

share, overtaking Mac OS, which had been introduced in 1984, while Microsoft has in 2020 lost its 
dominance of the buyer OS market, with Windows right down to 30%, less than Apple's 31% mobile-

only share (65% for desktop operating systems only, i.e. "PCs" vs. Apple's 28% desktop share) in its 

home market, the US, and 32% globally (77% for desktops), where Google's Android leads. 

As of October 2020, the foremost recent version of Windows for PCs, tablets and embedded devices 

is Windows 10, version 20H2. the foremost recent version for server computers is Windows Server, 

version 20H2. A specialized version of Windows also runs on the Xbox One computer game console. 

In a nutshell, below is how Microsoft windows evolved over time: 

• Windows 1.0 – Nov 1985 

• Windows 2.0 – Dec 1987 

• Windows 3.0 – May 1990 

Bhanu, Lovely Professional University
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• Windows 95 – Aug 1995 

• Windows 98 – June 1998 

• Windows ME – Sep 2000 

• Windows XP – Oct 2001 

• Windows Vista – Nov 2006 

• Windows 7 – July 2009 

• Windows 8.0 – Oct 2012 

• Windows 8.1 – Oct 2013 

• Windows 10 – July 2015 

Microsoft has released most versions of Windows with multiple editions, tailored for different users. 
For example, Windows 10 is available in "Home" and "Pro" editions. The Home edition is sufficient 

for most users, while the Pro edition includes additional networking and administrative features 

useful in corporate workspaces. 

Windows runs on standard x86 hardware, such as Intel and AMD processors. Unlike Apple, 

Microsoft licenses the OS to multiple manufacturers. Therefore, numerous companies, such as Dell, 
HP, Acer, Asus, Lenovo, sell Windows PCs. Microsoft develops its own line of Windows Surface 

laptops as well. 

Software programs written for Windows may be called apps, applications, or executable files. 
Regardless of their label, Windows software programs have an .EXE file extension. 64-bit versions of 

Windows run both 32 and 64-bit apps, while 32-bit versions only run 32-bit applications. 

4.1 What is Windows 10? 

Windows 10 brings an extended list of important changes that any IT pro should anticipate to, 
including major improvements within the user experience, significant security enhancements, and a 

replacement browser. 

But the foremost significant change is meant to get rid of the anxiety that accompanies enterprise 
upgrades. The goal of Windows 10 is to deliver new features when they’re ready, instead of saving 

them for subsequent major release. In fact, the very concept of a serious release goes away—or a 

minimum of recedes into the distant background—with Windows 10. Terry Myerson, the Microsoft 
executive responsible of the operating systems division, calls it “Windows as a Service.” actually , he 

argues, “One could reasonably consider Windows within the next few years together of the largest 

Internet services on the earth . And a bit like any Internet service, the thought of asking ‘What version 
are you on?’ will cease to form sense” That process has already begun, with the launch in late 2014 

of a Windows 10 Technical Preview aimed at IT pros and consumers. those that have opted into the 

Windows 10 preview program are receiving major new features, bug fixes, and security update.  

4.2 Installation 

There are two methodologies you can take for introducing Windows 10 in your PC: Upgrade or a 

Clean Install.  

Normally, when you overhaul your working framework, every one of your records and applications 
stay unaltered, while with a clean introduce you would be beginning again without any preparation. 

Be that as it may, something significant to check initially is if your PC has the fundamental equipment 

to help Windows 10. 

System Requirements 

Although most computers nowadays probably have the necessary requirements for Windows 10. It 

will certainly be useful to know them in case you want to upgrade from an older system. 

The main requirements are − 

• A processor (CPU) with a clock rate of at least 1GHz. 

• At least 1 to 2GB of memory (RAM), but Microsoft recommends 4GB. 

• At least 16GB space in your hard disk. 
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One important thing to note is that the installation process itself will verify your computer hardware 
and let you know if it qualifies for a Windows 10 upgrade or not. If not, then you will need to 

upgrade your hardware. 

Upgrade 

If your computer qualifies for a Windows 10 upgrade, then you can follow these steps to perform 

the upgrade − 

Step 1 − Look for the Windows 10 notification in the lower-right corner of the screen. This is a one-

year-only offer that Microsoft is extending to valid users of Windows 7 and Windows 8.1.  

Step 2 − By clicking on the notification, it will start the download and installation process of 

Windows 10 in your system. The download required for the upgrade is quite large, so make sure you 

have a stable Internet connection and continuous power for your computer to avoid interruptions 

during the process. 

Step 3 − After the download is complete, it will prompt you to accept Microsoft’s license terms.  

Step 4 − After agreeing to the terms, it will ask if you want to install the upgrade at that moment or 

schedule it for later. 

Since the upgrade process can take approximately 2 hours, it will be helpful to schedule it for a time, 

that will be more suitable to you. 

Step 5 − Once the upgrade starts, the system will perform a series of tasks, during which you will 

see the following screen. 

During this time, your computer will reboot a couple of times, so don’t worry. The process itself will 

take you through the steps to complete the upgrade. 

Step 6 − As the upgrade approaches its end, it will ask you to configure some basic Windows 
settings. You can choose to use Express settings, which will apply the most common or 

recommended settings, or you can choose to customize the settings as you please. 

Step 7 − After the upgrade finishes, you will see the Windows welcome screen. 

4.3 Getting Started with Windows 10 

After you have installed or upgraded your Windows, you will get a Welcome Screen with the time 

and date. Just click anywhere to go to the User Accounts Screen. 

This screen lets you choose which user you want to log in to from the lower-left corner. After choosing 

the right user, and entering a password if necessary, you will see the Windows Desktop. 

The Windows Desktop is simply your operating system main screen. Here you have access to an 
array of tools like the Start Menu, Taskbar, and other icons. Windows 10 also introduces a search box 

in the Taskbar, which facilitates browsing both your computer and the Web. 

4.4 Windows 10 Graphical User Interface (GUI)Basics 

Once you get to the Windows Desktop screen, here are some basic features you will see. 

 

Figure: GUI of Windows 10 
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One of the most important parts of your Desktop is the Taskbar. By default, it sits at the bottom of 

your screen giving you access to the Start Menu, several application icons, and the Notification Area. 

Windows 

In Windows 10, if an application is active or opened, you will see a Green Line below its icon. Clicking 

the icon will bring the appliance window up. 

Features Three Buttons 

Every open window features three buttons within the upper-right corner. These are wont to 

minimize, maximize, or close the window − 

• Minimizing means the window will hide within the Taskbar. 

• Maximizing will bring the window to a full-screen size. 

Windows are often moved around or resized as you please − 

• To move a window, just click on its Title Bar on the top of the window and drag it.  

• To resize a window, move your mouse to any corner until you see a double-sided arrow. 

Then click and drag until you reach the specified size. 

Icons 

Most Windows versions will feature different icons on the background. An icon is just a graphic 

representation of an application or a file. To open or access an icon, just double click thereon. 

 

Figure: Shows the icons on a desktop 

Although the quantity and sort of icons will vary, counting on the pc, you can add more icons by 

following these steps − 

Step 1 − Right-click on the Desktop Background. 

Step 2 − Choose “New” and “Shortcut”. 

Step 3 − Browse for the appliance or file you would like to make a shortcut to.  

Step 4 − Assign a reputation to the shortcut and click on “Finish”. 

Icons also can be moved around by clicking on them and dragging them to a different place within 

the screen. 

Desktop Background 

Another component of your Desktop is that 

the Background. this is often simply a picture 

that appears at the rear of your screen. Most 
computers accompany a pre-selected 

background, but you'll change it to any image 

you would like .  

To change the background, follow these steps 

− 

Step1 − Right-click on the background and 

choose “Personalize”. 

Step 2 − From the Personalization window, 
choose from a series of pre-selected pictures or 

browse for your own. After choosing a picture, 

the Background will change automatically. 
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Navigation 

To navigate your Windows, you can 
simply type what you are looking for on 

the Taskbar search. It can be the name of a 

document or application, or just any 

information you are looking for. 

Start Menu 

If you are looking for a specific 
application, you can also open the Start 

Menu and click “All Applications”. This 

will open an alphabetical list of all the 

applications installed on your computer. 

The Start Menu is the main point of access 

to your applications. There are two main 

ways to open it  

Step 1 − Use your mouse to click 

Windows icon in the lower-left corner of 

the taskbar. 

Step 2 − Press the Windows key on your 

keyboard. 

The Windows 10 Start Menu features two panes. 

The left pane resembles the traditional Start Menu from Windows 7 and earlier, while the right pane 

features live tiles that were used in 

Windows 8. 

Left Pane 

Among the things you can do in the left 

pane are − 

• Click the username at the top of 

the menu to change account 

settings or log in with another 

user. 

• Access the applications you use 

more frequently. 

• A small arrow next to an 

application will open a sub-

menu with a list of recent 

documents opened with that 

application. 

• Open the “File Explorer” to 

navigate your folders and files. 

• Change the settings of your 

computer like your Internet 

connection or changing your 

background. 

• See different options to shut 

down your computer. 

• See a list of all the applications 

installed in your computer. 

65



Office Automation Tools  

 LOVELY PROFESSIONAL UNIVERSITY  

Notes 

Search Box 

The “Search box” on the Taskbar 
will allow you to search within your 

documents and files or on the Web 

for anything you write. The initial 
results will appear within the Start 

Menu itself. 

The results will be grouped 

according to the closest match (or 

matches) labeled “Best match” at 

the top of the list. 

The remaining results will be 

grouped according to what they are 

or their location − 

• Web results 

• Documents or folders 

• Apps 

• System settings 

 

Right Pane  

The right pane features a varied array of tiles, 

similar to the ones that were seen on the Start 

Screen of Windows 8. 

These tiles can be moved and dragged to 

different places by holding the mouse button. 

You can also configure them by right-clicking on 

them to see options to resize them or “unpin” 

them (remove them) from the Menu. 

The whole Start Menu can also be resized by 

dragging the borders with the mouse to the 

desired size. 

Taskbar 

The Windows 10 taskbar sits at the bottom of the screen giving the user access to the Start Menu, as 

well as the icons of frequently used applications. On the right-side, the Taskbar features the 

Notification Area which informs the user of different things like the state of the Internet connection 

or the charge of the laptop battery. 

 

The icons in the middle of the Taskbar are “pinned” applications, which is a way to have a quick 

access to applications you use frequently. “Pinned” applications will stay in the taskbar until you 

“unpin” them by using unpin option that you get by right clicking on the icon. 

Similarly, if an icon is not there on the taskbar that you would like over there can be brought by 

using following steps: - 

“Click on Start  Right Click on the icon  Pin to Taskbar” 
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This will attach or “pin” the application icon to your Windows Taskbar. 

Notification Area 

The Notification Area is located at the right 

side of the Taskbar. It shows different types 

of notifications from your computer like your 

Internet connection, or the volume level. 

At first, the Notification Area shows a limited 
number of icons. But you can click the 

upward arrow on its left side to see other 

icons as well.  

 

Task View 

Task View allows you to quickly move within your open windows and applications. You can access 

it by clicking the “Task View” button from the Taskbar. 

 

 

You can also press and hold the Windows key, and then press Tab to achieve the same result.  

By pressing the Alt+Tab keyboard shortcut also serves a similar purpose. 

File Explorer 

File Explorer is the file management 

application used by Windows 
operating systems to browse folders 

and files. It provides a graphical 

interface for the user to navigate and 

access the files stored in the computer. 

The main way to access the File 

Explorer is by clicking the folder icon 
in the Taskbar. After clicking the icon, 

the File Explorer window will open. 

The initial File Explorer window is comprised of the following sections − 

1. The File Explorer ribbon, which resembles the ribbon featured in Microsoft Office. The 

ribbon contains buttons for common tasks to perform with your files and folders. 

2. The Navigation Pane gives you access to your libraries of documents and pictures, as well 

as your storage devices. It also features frequently used folders and network devices. 
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3. The Frequent folders section on the right features the folders you’ve worked with recently 

to allow for quick access to them. 

4. The Recent files section in the lower part of the window features files and documents that 

you’ve opened recently. 

Cortana 

Cortana is Microsoft’s intelligent personal assistant. It is included in Windows 10, as well as with 

other Microsoft systems and devices like Windows Phones and Xbox, among others. 

Cortana will help you find things in your computer, set appointments, answer questions, and many 

other things. 

To use Cortana simply type a question in the search box in the Taskbar or click the microphone icon 

and talk to Cortana. 

The icons on the left-side are for − 

• Home 

• Notebook 

• Reminders 

• Feedback 

Home is the initial Cortana window where you 

can type or ask questions. 

Activating Cortana 

If Cortana isn’t active, you can turn it on by typing 
“Cortana” in the Taskbar search to access the 

Cortana settings, or just clicking the “Gear” icon 

on the left-side of the menu. 

 

1 

3 

2 
4 
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After activating Cortana, it will start gathering information about you to personalize the experience. 

You can also customize how Cortana responds to you. 

Personalizing Cortana 

To further customize Cortana and personalize your interactions with it, you can also access the 

Cortana Notebook. 

This notebook stores what Cortana knows about you.You can also add reminders by either typing 

them or talking to Cortana. 
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Lab Exercise 

Using the personalize property try to change the background of your desktop 

and set your image as a background image. 

4.5 Control Panel 

The instrument panel may be a component of Microsoft Windows that gives the power to look at and 

alter system settings. It consists of a group of applets that include adding or removing hardware and 

software, controlling user accounts, changing accessibility options, and accessing networking 
settings. Additional applets are provided by third parties, like audio and video drivers, VPN tools, 

input devices, and networking tools. 

The instrument panel has been a part of Microsoft Windows since Windows 1.0, with each successive 

version introducing new applets. Beginning with Windows 95, the instrument panel is implemented 

as a special folder, i.e., the folder doesn't physically exist, but only contains shortcuts to varied applets 
like Add or Remove Programs and Internet Options. Physically, these applets are stored as .cpl files. 

for instance, the Add or Remove Programs applet is stored under the name appwiz.cpl within the 

SYSTEM32 folder. 

In Windows XP, the instrument panel home screen was changed to present a categorized navigation 

structure like navigating an internet page. Users can switch between this Category View and 

therefore the grid-based Classic View through an option that appears on either the left side or top of 
the window. In Windows Vista and Windows 7, additional layers of navigation were introduced, 

and therefore the instrument panel window itself became the most interface for editing settings, as 

against launching separate dialogs. 

Many of the individual instrument panel applets are often accessed in other ways. as an example , 

Display Properties are often accessed by right-clicking on an empty area of the desktop and selecting 
Properties. The instrument panel are often accessed from a prompt by typing control; optional 

parameters are available to open specific control panels. 

On Windows 10, instrument panel is deprecated in favor of Settings app, which was originally 
introduced on Windows 8 as "PC settings" to supply a touchscreen-optimized settings area using its 

Metro-style app platform. Some functions, particularly the power to feature and take away user 

accounts, were moved exclusively to the present app on Windows 8 and can't be performed from 

instrument panel. 

As of the October 2020 update to Windows 10 trying to open the System page of instrument panel 

will redirect users to the Windows 10 Settings application. 

 

Figure 1 Control Panel applet 
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How to open Control Panel? 

In Windows 10, the Control Panel has largely been superseded by the Settings App. To open the 

Settings app, open the Start Menu and click the gear icon (       ), or press Win+I (hold down 

the Windows Key and press "i").However, the traditional Control Panel is still available: 

There are several ways to open the Control Panel in Windows 10. 

From the Start Menu 

• Open the Start Menu. 

• Scroll down to W, click Windows System, then click Control Panel. 

 

From the Cortana search bar 

• The Cortana search bar is on the left side of the taskbar, next to Start Menu button. Click the 

search bar to place your cursor in this box. 

• Type the word control. Cortana lists best matches above as you type. In this list, 

select Control Panel. 

 

From the Run box 

The control command may be used to open the Control Panel. For instance: 

• Open the Run box by pressing Win+R (hold down the Windows key on your keyboard, 

then press the “R“ key). 

• Type control and press Enter.  
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As mentioned below, you can also run the control command from the Windows 10 Command  

Prompt. 

Description of each category and icon in the Control Panel 

Since its introduction in Windows 95, the Control Panel has undergone many changes including 

adding, renaming, and removing of icons and the introduction of categories. This page helps give 
you a better understand the Control Panel, help find where a setting may be adjusted, and give a 

complete overview of what's available in the Windows Control Panel. Below is a visual example of 

the Windows 10 Control Panel. 

Control Panel categories and icons 

Control panel consist of the following categories and icons. Below is the list of applets available along 

with their detailing: 

• Appearance and Personalization 

The Appearance and Personalization category allows you to change the look and feel of Windows, 
which includes adjusting the theme, screen saver, and taskbar. Below is a list of each of the 

subcategories of Appearance and Personalization in Windows 10. 

➢ Taskbar and Navigation - Opens the Taskbar settings that allow you to change how the 

taskbar is shown or hidden, its location, icons, and other settings. 

➢ Ease of Access Center- Opens the Ease of Access Center, which gives you access to all 

settings that makes Windows easier to use for all users. In this area, you'll find the following 

settings. 

o Use the computer without a display - Optimize for blindness. 

o Make the computer easier to see - Optimize visual display. 

o Use the computer without a mouse or keyboard - Set up an alternative input 

device. 

o Make the mouse easier to use - Adjust settings for the mouse or other pointing 

devices. 

o Make the keyboard easier to use - Adjust settings for the keyboard. 

o Use text or visual alternatives for sounds - Set up alternatives to sounds. 

o Make it easier to focus on tasks - Adjust settings for reading and typing. 

o Make touch and tablets easier to use - Adjust settings for touch and tablets. 

➢ Accommodate low vision - Adjust High Contrast, make text and icons larger, and other settings 

to help people with low vision use their computer easier. 

➢ Use screen reader - Enable and disable the Narrator that lets you have things on the screen read to 

you as you use the computer. 

➢ Turn on easy access keys - Enable and disable Mouse Keys, Sticky Keys, Toggle Keys, Filter Keys, 

and get to other keyboard settings. 

 

• In Windows 7, Windows 8, and Windows 10 you can use the search in the top-

right corner of the Control Panel window to find the area you are looking to 

adjust. For example, you could type "firewall" to search for the Firewall settings. 

You can also use the Windows search in the Taskbar to find Windows settings 

and tools available through the Control Panel. 

• In all new versions of Windows, you can adjust how the Control Panel is shown 

by changing the View by option. In the top-right corner of the Control Panel, 

change the View by from Category to Large icons or Small icons to see only icons. 

72

https://www.computerhope.com/issues/control-panel.htm#dos
https://www.computerhope.com/jargon/c/commprom.htm
https://www.computerhope.com/jargon/c/commprom.htm
https://www.computerhope.com/jargon/w/win95.htm
https://www.computerhope.com/jargon/c/contrast.htm
https://www.computerhope.com/jargon/m/microsoft-narrator.htm
https://www.computerhope.com/jargon/m/mousekey.htm
https://www.computerhope.com/jargon/s/stickyke.htm
https://www.computerhope.com/jargon/t/toggleke.htm
https://www.computerhope.com/jargon/f/filterke.htm
https://www.computerhope.com/jargon/k/keyboard.htm
https://www.computerhope.com/jargon/f/firewall.htm


Unit 4: MS Windows  

 LOVELY PROFESSIONAL UNIVERSITY  

Notes 

➢ Turn High Contrast on or off - Adjust all display settings including the background, colors, lock 

screen, Themes, Start, and the taskbar. 

➢ File Explorer Options - Open the File Explorer Options window with options on how to view and 

search files on your computer. 

➢ Specify single- or double-click to open - Adjust the File Explorer mouse settings to be either 

single-click or double-click. 

➢ Show hidden files and folders - Opens the View tab in the File Explorer Options window that 

allows you to specify if hidden files should be shown. 

➢ Fonts - Opens the Fonts window that shows all installed fonts on the computer. 

➢ Preview, delete, or show and hide fonts - Opens the Fonts window (same as above). 

➢ Change Font Settings - Opens the Fonts settings window to adjust how fonts are shown on the 

computer. 

➢ NVIDIA Control Panel - For computers with NVIDIA video cards gives you access to the 

NVIDIA Control Panel, which gives you more advanced display settings for your video card.  

• Clock, Language, and Region 

The Clock, Language, and Region category is seen when viewing the Control Panel as categories and 
allows you to change the date, time, language, and region settings in Windows. Below is a list of each 

of the subcategories of Clock, Language, and Region in Windows 10. 

➢ Date and Time - Opens the Date and Time window that shows you the current date and 

time and the ability to change your date and time settings. 

➢ Set the time and date - Opens the Date and Time window with the "  Change date and 

time..." button that allows you to change the time or date on the computer. 

➢ Change the time zone - Opens the Date and Time window with the "Change time zone..." 

button that allows you to change the time zone. 

➢ Add clocks for different time zones  - Opens the Date and Time window in 

the Additional Clocks tab that lets you add additional clocks when hovering over the 

taskbar clock. 

➢ Language - Open the Language window that allows you to adjust, add, and remove the 

display language and the input and handwriting language. 

➢ Add a language - Opens the Language window (same as above) and allows you to add a 

new language, remove languages, or set the language priorities if more than one language 

is selected. 

➢ Change input methods - Opens the Language window (same as above). Clicking the 

Options link to the right of the language allows you to change the input methods (i.e., 

the keyboard layout) for the language. 

➢ Region - Opens the Region window that allows you to change the date and time formats 

and the first day of the week. 

➢ Change location - Opens the Region window in the Location tab that lets you to specify 

the home location. 

➢ Change date, time, or number formats - Opens the Region window (see above). 

• Ease of Access 

The Ease of Access is a category shown when viewing the Control Panel as categories that adjust the 
vision, hearing, speech recognition, and mobility settings. Below is a list of each of the subcategories 

of System and Security in Windows 10. 

Ease of Access Center can also be accessed using Ease of Access. 

• Hardware and Sound 
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The Hardware and Sound category allows you to add and remove printers and other hardware, 
change system sounds, update drivers and more. Below is a list of each of the subcategories of 

Hardware and Sound in Windows 10. 

➢ Devices and Printers- Open the Devices and Printers window that shows you all the 

hardware devices, printers, and multimedia devices detected by your computer. In devices 

and printers, you have following options: - 

o Add a device - Open the Add a device wizard to detect any new hardware 

connected to your computer. You would run this wizard if Windows did not 

automatically detect and set up a new device. 

o Advanced printer setup - Open the Add printer wizard to set up a new printer or 

set up a network printer. 

o Mouse - Open the Mouse Properties window to configure all your computer 

mouse settings. 

o Device Manager - Open the Windows Device Manager. 

o Change Windows to go startup options - Setup and configure the Windows To 

Go options. 

➢ AutoPlay–  Open the AutoPlay settings to configure what happens when disc 

(e.g., CD, DVD, Blu-ray) is inserted into the computer. The AutoPlay settings also allow you 

to choose what to do with pictures, videos, music, and mixed content. Here, there are two 

options as listed: -  

o Change default settings for media or devices - Opens the AutoPlay settings (same 

as above). 

o Play CDs or other media automatically - Opens the AutoPlay settings (same as 

above). 

➢ Sound - Opens the Sound settings that allows you to adjust the playback, recording, and 

sounds settings on the computer. In this, you can: - 

o Adjust system volume - Opens the Volume Mixer to adjust 

the volume and mute settings of your speakers and other sound devices. 

o Change system sounds - Opens the Sound settings window in the Sounds tab to 

adjust the sound theme of your computer. These sounds are what you may hear 

when starts or while using Windows. 

o Manage audio devices - Opens the Sound settings window in the Playback tab to 

adjust the audio devices on the computer. 

➢ Power Options - Opens the Power Options window to adjust the computer's power plan 

settings, which are the settings that tell the computer when to go to sleep (Standby) 

or hibernate. Here, you can: - 

o Change power-saving settings - Opens the Power Options window (same as 

above). 

o Change what the power buttons do - Change the button settings for your power 

button and sleep button. For example, when pressing the power button, your 

computer can be set to Shut down the computer, sleep, hibernate, or do nothing. 

o Change when the computer sleeps - Change the sleep (Standby) settings of the 

computer and monitor. From this window, you can change how long to wait until 

the display and computer goes into sleep mode. 

o Choose a power plan - Change the Power Options power plan settings from 

Balanced, Power saver, or high performance. 
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o Edit power plan - Change the sleep (Standby) settings of the computer and 

monitor. From this window, you can change how long to wait until the display 

goes into sleep mode and when the computer goes to sleep. 

• Network and Internet 

The Network and Internet category is shown when viewing the Control Panel as categories and allows 
you to view your network status and configure other network settings and preferences. Below is a 

list of each of the subcategories of Network and Internet in Windows 10. 

➢ Network and Sharing Center - Opens the Network and Sharing Center window to view 

basic networking information, set up a new connection, and troubleshoot network 

problems. Here, you can: - 

o View network status and tasks - Open the Network and Sharing Center window 

(same as above). 

o Connect to a network - Open the available networks that which include 

available Wi-Fi networks and the ability to turn on Airplane mode and set up a 

mobile hotspot. 

o View network computers and devices - Opens the Network window that shows 

computers on your network, media devices, network infrastructure (e.g.,  router), 

and other devices (e.g., available IoT devices and Internet/Network connected 

devices). 

➢ Internet Options- Opens the Internet Properties window to adjust Internet Explorer 

browser settings (e.g., home page, browsing history, and other settings). Here, you can: - 

o Change your homepage - Opens the Internet Properties window (same as above).  

o Manage browser add-ons - Opens the Internet Properties window in 

the Programs tab. From the Programs tab, you can manage any add-ons that are 

installed into Internet Explorer and choose how the computer opens links. 

o Delete browsing history and cookies - Opens the Internet Properties window in 

the General tab that allows you to delete the browsing history and change the 

browsing history settings and delete cookies and adjust cookie settings. 

• Programs 

The Programs category is shown when viewing the Control Panel as categories and allows you to get 
new programs and uninstall programs on your computer. Below is a list of each of the subcategories 

of Programs in Windows 10. 

➢ Programs and Features - Opens the Programs and Features window that allows you to 

change, repair, and uninstalled any program that is installed on the computer. Here, there 

are following options: - 

o Uninstall a program - Opens the Program and Features window (same as above). 

o Turn Windows features on or off - Opens the Windows Features window to view 

enabled Windows features and turn features on and off. 

o View installed updates - Opens the Installed Updates window to see a full list of all 

updates that are installed on the computer. 

o Run programs made for previous versions of Windows  - Open the Windows 

Program Compatibility Troubleshooter to fix problems with running older programs 

in Windows. 

o How to install a program - Opens the Windows support web page for help with 

installing a program. 
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➢ Default Programs - Opens the Default Programs window with the options to Set your 

default programs, associate files, change AutoPlay settings, and set program access and 

computer defaults. Here you have following controls: - 

o Change default settings for media or devices - Opens the AutoPlay settings to 

configure what happens when disc (e.g., CD, DVD, Blu-ray) is inserted into the 

computer. The AutoPlay settings also allow you to choose what to do with 

pictures, videos, music, and mixed content. 

o Make a file type always open in a specific program - Open the Set 

Associations window to view and change how file types (files with a certain file 

extension) are opened. 

o Set your default programs - Open the Set Default Programs window to adjust what 

file types and protocols a program is capable of opening. From this window, you 

can set a program as the default program for its associated file types or view what 

file types (file extensions) are associated with the program. 

o Java (32-bit) - If Java is installed on the computer, this option opens the Java Control 

Panel to adjust Java related settings. 

• System and Security 

The System and Security category allows you to view computer system information and settings and 
view and change the computer security settings. Below is a list of each of the subcategories of System 

and Security in Windows 10. 

➢ Security and Maintenance - View the system security settings (e.g., the Network 

firewall, virus protection, Internet security settings, and User Account Control). In Security 

and Maintenance, you're also able to adjust your maintenance settings. 

o Review your computer's status and resolve issues - Open the Security and 

Maintenance and show any of the computer issues that are detected. 

o Change User Account Control settings - Opens the User Account Control Settings to 

adjust the level of UAC (User Account Control). 

o Troubleshoot common computer problems - Opens the Troubleshoot tool to fix 

common problems with Windows and hardware connected to Windows using the 

troubleshooter. 

➢ Windows Firewall- View the Windows Firewall status and adjust settings. 

o Check firewall status - Show the Windows Firewall status to determine if the 

firewall is turned on or off and how it is blocking incoming connections. 

o Allow an app through Windows Firewall - Display a list of programs (apps) 

permitted to communicate through the Windows Firewall and enable or disable 

private and public access. 

➢ System - Opens the System information section to display computer information. 

Information includes the version of Windows, processor speed, RAM, if it's 32-bit or 64-bit, 

if pen or touch is enabled, computer name, workgroup, and if Windows is activated. 

o View amount of RAM and processor speed - Opens the System 

information window (same as above). 

o Allow remote access - Opens the System Properties window Remote tab to allow 

and not allow remote access to the computer. 

o Launch remote assistance - Launch the Windows Remote Assistance that allows you 

to invite someone to help you with your computer or help someone who has 

invited you to help them with their computer. 
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o See the name of this computer - Opens the System window (mentioned above) 

that displays system information including the computer name and option to 

change the name. 

➢ Power Options - Opens the Power Options that allow you to change how Windows 

manages the power and sleep (Stand By) option to your computer and devices connected to 

your computer. 

o Change what the power buttons do - Opens the System Settings for the Power 

Options that allows you to change what happens when you press the power 

button and sleep button. For example, you could change the power button to put 

your computer to sleep instead of shutting down the computer when it is pressed. 

o Change when the computer sleeps - Opens Power Plan Settings to specify how 

long to wait until the display and the computer are put to sleep. 

➢ File History - Opens the File History window that shows you if File History is enabled 

and external drives available for File History. 

o Save backup copies of your files with File History - If File History is enabled save 

a backup of your files. 

o Restore your files with File History - Restore files from your File History if 

available. 

➢ Backup and Restore (Windows 7) - Open the Windows 7 Backup and Restore option and 

where you can find the location to create a system image and create a system repair disc.  

o Restore files from backup - Restore any files that were backed up using Windows. 

➢ BitLocker Drive Encryption - Enable and disable BitLocker Drive Encryption for your 

hard drive and removable drives. 

o Manage BitLocker - Open the BitLocker Drive Encryption window (same as above) 

to adjust the BitLocker settings. 

➢ Storage Spaces - Manage Storage Spaces that allow you to save files to two or more drives 

to help protect your computer in case of a drive failure and add more drives when you run 

low on disk capacity. 

o Manage Storage Spaces - Manage Storage Spaces (same as above). 

➢ Work Folders - Manage and set up Work Folders that allow other devices to access your 

files, even when offline. 

o Manage Work Folders - Manage Work Folders (same as above). 

➢ Administrative Tools - Open the Administrative Tools window that gives you access to all 

settings important to system administrators. These tools can include all the following tools.  

i. Component Services 

ii. Computer Management 

iii. Defragment and Optimize Drives 

iv. Disk Cleanup 

v. Event Viewer 

vi. Internet Information Services (IIS) Manager 

vii. iSCSI initiator 

viii. Local Security Policy 

ix. ODBC Data Sources (32-bit and 64-bit) 

x. Performance Monitor 

xi. Services 

xii. System Configuration 
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xiii.  System Information 

xiv. Task Scheduler 

xv. Windows Firewall with Advanced Security 

xvi. Windows Memory Diagnostic 

o Free up disk space - Opens the Disk Cleanup tool that allows you to free up disk space 

by cleaning any files no longer needed. 

o Defragment and optimize your drives - Opens the Optimize Drives tool that allows you 

to defrag your hard disk drive and optimize the drive. 

o Create and format hard disk partitions - Opens the Disk Management tool that allows 

you to partition a disk drive and change other drive settings needed when setting up 

a hard drive for the first time. 

o View event logs - Opens the Event Viewer to view the system event logs. 

o Schedule tasks - Opens the Task Scheduler that allows you to schedule when a task or 

program needs to run. 

➢ Flash Player (32-bit) - Opens the Adobe Flash Player Settings Manager that allows you to 

adjust the settings of Adobe Flash. 

• User Accounts 

The User Accounts category is shown when viewing the Control Panel as categories and allows you 
to view user accounts, adjust user settings (e.g., passwords), and adjust other user settings. Below is 

a list of each of the subcategories of the User Accounts in Windows 10. 

➢ User Accounts - Opens the User Accounts window to make changes to your user account, 

change your account type, manage another account, and change User Account 

Control settings. Here, users can: - 

o Change account type - Opens the Manage Accounts window to adjust the account 

type of one or more of the users on the computer. 

o Remove user accounts - Opens the Manage Accounts window (same as above). 

➢ Credential Manager - Opens the Credential Manager window to view the Web Credentials 

and Windows Credentials. From this area, you can also view, edit, and remove any of the 

credentials. Here, users can: - 

o Manage Web Credentials - Opens the Credential Manager window (same as 

above). 

o Manage Windows Credentials - Open the Credential Manager window (same as 

above). 

• Action Center 

Open the Windows Action Center that allows you to review recent messages and resolve problems that 

may have happened with your computer. 

• Broadcom Control Suite 

For computers with a Broadcom network adapter or motherboard Broadcom chipset, the Broadcom 

Advanced Control Suite has network adapter settings, diagnostics, and statistics. 

• Color Management 

Opens the Color Management window that allows you to adjust the color settings for your display 

device and calibrate your display. 

• Desktop Gadgets 

Show the available gadgets available for the Windows desktop of computers running Windows 7 

and Windows Vista. 
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• Device Manager 

Opens the Windows Device Manager to list detected computer hardware, change hardware settings, 

and add and remove hardware devices. 

• Display 

Configure the display settings of your computer and your computer screen. Includes the ability to 

adjust the resolution, calibrate the color, change display settings, adjust ClearType text, and set 

custom text size (DPI). 

• Fonts 

Opens the Fonts window that shows all installed fonts on the computer. 

• Getting Started 

Start the Getting Started guide that helps you learn more about Windows by linking you to guides on 

how to use Windows and important areas of the computer. 

• Indexing Options 

Opens the Indexing Options window that shows how many files are indexed and allows you adjust 

your indexing preferences. 

• Keyboard 

Opens the Keyboard Properties window to adjust the keyboard settings such as the character repeat 

delay and rate settings and the cursor blink rate. 

• Language 

Opens the Language window that allows you to adjust, add, and remove the display language and 

the input and handwriting language. 

• Location and Other Sensors 

Add and configure sensors and get direct access to the Location Activity in the Event Viewer. 

• Mouse 

Opens the Mouse Properties window to configure all your computer mouse settings. 

• Network and Sharing Center 

Opens the Network and Sharing Center or Network and Sharing window to view basic networking 

information, set up a new connection, and troubleshoot network problems. 

• Notification Area Icons 

Change the settings of the notification icons that appear on the Windows Notification Area. In this 

area, you can adjust what icons should be shown and what icons should be hidden. 

• NVIDIA Control Panel 

For computers with NVIDIA video cards gives you access to the NVIDIA Control Panel, which gives 

you more advanced display settings for your video card. 

• Parental Controls 

Setup and control Parental Controls for user accounts using the Windows Live Family Safety in 
Windows 7 and earlier versions of Windows. In Windows 10, this area has changed to "Family 

options" and is part of the Windows Defender Security Center. 

• Performance Information and Tools 

View the rating of your computer and tips you can do to help improve the computer's performance. 
With the introduction of Windows 8, this option is no longer available for Windows 8 and Windows 

10. 

• Personalization 
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Opens the Personalization window that gives you access to change the desktop background, change 
themes, adjust sounds, and adjust the screen saver. With Windows 10, this option has been moved 

into the "Themes and related settings" section. 

• Phone and Modem 

Opens the Phone and Modem settings that allow you to specify your modem dialing rules and add, 

remove, and change the properties of the installed modem in the computer. 

• Power Options 

Opens the Power Options window to adjust the computer's power plan settings, which are the settings 

that tell the computer when to go to sleep (Standby) or hibernate. 

• Programs and Features 

Opens the Programs and Features window that allows you to change, repair, and uninstalled any 

program that is installed on the computer. 

• Realtek HD Audio Manager 

If a Realtek sound card is installed with its software, this option opens the Realtek HD Audio 

Manager to adjust the sound card settings and other audio properties. 

• Recovery 

Opens the Recovery tools window that allows you to create a recovery drive, open System Restore, 

and configure System Restore. 

• Region 

Opens the Region window that allows you to change the date and time formats and the first day of 

the week. In Windows 7 and earlier, this area was called "Region and Language."  

• RemoteApp and Desktop Connections 

Connect to and add new RemoteApp connections. 

• Security and Maintenance 

View the system security settings (e.g., the Network firewall, virus protection, Internet security 

settings, and User Account Control). In Security and Maintenance, you're also able to adjust your 

maintenance settings. 

• Sound 

Opens the Sound settings that allows you to adjust the playback, recording, and sounds settings on 

the computer. 

• Speech Recognition 

Open the Speech Recognition window that allows you to open the following areas. 

➢ Start Speech Recognition - Start using your voice to control your computer. 

➢ Set up microphone - Set up your computer to work properly with Speech Recognition. 

➢ Take Speech Tutorial - Learn to use your computer with speech. Learn basic commands 

and dictation. 

➢ Train your computer to better understand you - Read text to your computer to improve 

your computer's ability to understand your voice. 

➢ Open the Speech Reference Card - View and print a list of common commands to keep 

with you, so you always know what to say. 

• Storage Spaces 

Manage Storage Spaces that allow you to save files to two or more drives to help protect your 

computer in case of a drive failure and add more drives when you run low on disk capacity.  

• Sync Center 

View recent sync activity, sync now, or change your sync settings. 
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• System 

Opens the System information section to display computer information. Information includes 
the version of Windows, processor speed, RAM, if it's 32-bit or 64-bit, if pen or touch is enabled, 

computer name, workgroup, and if Windows is activated. 

• Taskbar and Navigation 

Opens the Taskbar settings that allow you to change how the Taskbar is shown or hidden, its location, 

icons, and other settings. 

• Troubleshooting 

Opens the Troubleshooting window to troubleshoot software programs, hardware and sound, 

network and Internet, and system and security areas. 

• User Accounts 

Opens the User Accounts window to make changes to your user account, change your account type, 

manage another account, and change User Account Control settings. 

• Windows Anytime Upgrade 

Discontinued option that allowed you to upgrade your version of Windows. 

• Windows CardSpace 

In Windows 7, the Windows CardSpace Control Panel option allows you to add, view, and edit 

CardSpace card data. Microsoft has discontinued Windows CardSpace. 

• Windows Defender 

In Windows 7 and earlier, this Control Panel option allows you to view and edit Windows Defender 

options. In Windows 10, this option has been moved into the Windows Defender Security Center. 

• Windows Firewall 

View the Windows Firewall status and adjust settings. 

• Windows Live Language Setting 

Gives you the ability to download and adjust the languages for Windows Live programs. 

• Windows To Go 

Setup and configure the Windows To Go options. 

• Windows Update 

View the available Windows updates available for download and install, change your update 

settings, view your update history, and other update related settings. 

• Work Folders 

Manage and set up Work Folders that allow other devices to access your files, even when offline.  

Summary 

• The title bare offers the handling the feature of window like expanding window etc. 

•  Control panel handle all setting of computer system.  

• Windows accessories comes under which we explained multimedia and magnifier.  

•  Search folder is used for searching the files and folder in computer system memory. 

Keywords 

Title bar: The title bar is the bar that runs horizontally across an application window. The title bar 
will contain either the name of the file for example, a document we are viewing or the website we are 

viewing through Internet browser. Find out how to use, customize and install add-ins to title bars. 

Appearance and Personalization :The Appearance and Personalization category allows you to 

change the look and feel of Windows, which includes adjusting the theme, screen saver, and taskbar. 
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Microsoft Edge: Microsoft Edge is the new browser for Windows 10 and is the successor to Internet 
Explorer 11, although Internet Explorer will remain for compatibility and legacy purposes. Cortana 

has been integrated into Edge, accessible by the option "Ask Cortana" in the right click menu, as well 

as a Reading View and the ability to write notes directly on web pages and save to OneNote. 

Cortana: Cortana is a virtual assistant developed by Microsoft which uses the Bing search engine to 

perform tasks such as setting reminders and answering questions for the user. 

Windows: Windows is a desktop operating system developed by Microsoft. For the past three 

decades, Windows has been the most popular operating system for personal computers. 

Lab Exercises 
1. Explain all Windows Accessories. 

2. Search Files or Folders. 

Self Assessment 

1. Name the application that provides detailed information about file, folder and drives.  

a. Application Icon 

b. Gadgets 

c. Windows Explorer 

d. None of these 

2. What is the new built-in browser included in Windows 10? 

a. Edge 

b. Safari 

c. Opera 

d. Super Internet Explorer Pro 

3. Windows 10 was launched in which year? 

a. 2012 

b. 2013 

c. 2014 

d. 2015 

4. Features of windows include: 

a. Running several programs simultaneously 

b. Switching between open applications 

c. Multitasking 

d. All of these 

5. Small images that represent commands, files, applications, or other windows are: 

a. Jpegs 

b. Icons 

c. Snips 

d. Application 

6. From where you can change the mouse setting? 

a. Setting->mouse 

b. Hardware Setting 

c. Control panel->mouse 

d. None of these 

7. Which key is used to close the active window? 

a. Ctrl+F4 

b. Ctrl+F5 

c. Alt+F6 
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d. Alt+F7 

8. Software can be removed and installed through_____ 

a. Control Panel 

b. Installer 

c. Debugger 

d. Linker 

9. Which of the following is not the element of computer desktop? 

a. Icons 

b. Taskbar 

c. Start Button 

d. Title bar 

10. Which component consists of number of different applets which helps in changing the settings 

of a computer system? 

a. Control panel 

b.  Desktop 

c. Icons 

d. Taskbar 

11. Which file extension is used to compress the files to save disk space? 

a. .ppt 

b. .pdf 

c. .zip 

d. .doc 

12. File which contains the other file names is known as 

a. Path file 

b. Batched file 

c. Directory 

d. Path name 

13. Which of the following is not an image file extension? 

a. .jpeg 

b. .jpg 

c. .doc 

d. .png 

14. You organize files by storing it in _______ 

a. namespaces 

b. rings 

c. drawers 

d. folders 

15. A file _____ shows the location of a file or folder 

a. Matrix 

b. Run 

c. Path 

d. Circuit 
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Answers for Self-Assessment 

1. c 2. a 3. d 4. d 5. b 

6. c 7. a 8. a 9. d 10. a 

11. c 12. c 13. c 14. d 15. c 

 Review Question 

1. What Is the Purpose of Microsoft Windows? 

2. Define role of taskbar. 

3. Explain any 5 applets of Control Panel. 

4. Explain different features of Windows 10. 

5. What is the use of Cortana in windows 10? 

6. Write down the steps to search a special file or folder in your computer system. 

Further Readings 

 
Computer Basics Absolute Beginner’s Guide, Windows 10 Edition, 

 
https://edu.gcfglobal.org/en/windowsbasics/all-about-windows/1/ 
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Purpose and Objective 

• After studying this unit, you will be able to 

•  Understanding and explanation of Microsoft Word  

•  Explanation of word environment in micro soft word  

•  Process of using or creating a word document.  

•  Explanation of editing in a word document  

•  Process of saving a document in word.  

•  Explanation of opening a document.  

•  Process of finding files. 

•  Understanding of word document views 

 

Introduction 

When you use a computer program to create, edit, and format text documents, you are performing a 
task known as Word Processing. Part of the Microsoft Office 2013 suite of programs, Microsoft Word 
2013 is one of the most sophisticated word processing programs available. By using Word, it is easy 
to efficiently create a wide range of business and personal documents, from the simplest letter to the 
most complex report. Word includes many desktop publishing features that you can use to enhance 
the appearance of documents so that they are visually appealing and easy to read.  

You can use Word to:  

• Create professional-looking documents that incorporate impressive graphics.  

• Give documents a consistent look by applying styles and themes that control the font, size, 
color, and effects of text and the page background.  

Bhanu, Lovely Professional University
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• Store and reuse pre-formatted elements such as cover pages and sidebars.  

• Create personalized mailings to multiple recipients without repetitive typing.  

• Make information in long documents accessible by compiling tables of contents, indexes, 
and bibliographies.  

• Coauthor documents with team members.  

• Safeguard documents by controlling who can make changes and the types of changes that 
can be made, as well as by removing personal and confidential information. 

 

5.1 View of Microsoft Word Window 

The program window contains the following elements:  

 

 

 

 

 

 

 

• Title bar:-At the top of the program window, this bar displays the name of the active 

document and provides tools for managing the program and the program window. 

 

 

 

 

 

At the left end of the title bar is the program icon, which you click to display commands to restore, 
move, size, minimize, maximize, and close the program window.  

To the right of the program icon is the Quick Access Toolbar, which by default displays the Save, 
Undo, and Redo buttons. You can customize the Quick Access Toolbar to display any commands you 
want.  

At the right end of the title bar are five buttons: the Microsoft Word Help button that opens the Word 
Help window; the Ribbon Display Options button that allows you to entirely hide the ribbon, display 
only the ribbon tabs, or display the ribbon tabs and commands; and the familiar Minimize, 
Maximize/Restore Down, and Close buttons.  

• Ribbon Below the title bar:-all the commands for working with a Word document are 

gathered together in this central location so that you can work efficiently with the program 

 

 

 

 

Across the top of the ribbon is a set of tabs. Clicking a tab displays an Associated set of commands.  

Figure 1 Identifying program window elements 
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Commands related to managing Word and Word documents (rather than document content) are 
gathered together in the Back stage view, which you display by clicking the colored File tab located 
at the left end of the ribbon. Commands available in the Back stage view are organized on pages, 
which you display by clicking the page tabs in the colored left pane. You redisplay the document and 
the ribbon by clicking the Back arrow located above the page tabs.  

Commands related to working with document content are represented as buttons on the remaining 
tabs of the ribbon. The Home tab, which is active by default, contains the commands most Word 
users will use most often. When a graphic element such as a picture, table, or chart is selected in a 
document, one or more tool tabs might appear at the right end of the ribbon to make commands 
related to that specific object easily accessible. Tool tabs are available only when the relevant object 
is selected. 

 

 

 

 

 

 

 

 

 

 

When a gallery contains more thumbnails than can be shown in the available ribbon space, you can 
display more content by clicking the scroll arrow or more button located on the right edge of the 
gallery.  

Related but less common commands are not represented as buttons in a group. Instead, they’re 
available in a dialog box or pane, which you display by clicking the dialog box launcher located in 
the lower-right corner of the group.  

To the right of the groups on the ribbon is the Collapse the Ribbon button, which is shaped like a 
chevron. Clicking this button hides the groups of buttons but leaves the tab titles visible. When the 
groups are hidden, the Collapse the Ribbon button changes to the Pin. 

The Ribbon button, which is shaped like a pushpin. You can click any tab title to temporarily display 
the groups, then click a ribbon command or click away from the ribbon to hide the groups again,  or 
click the Pin The Ribbon button to permanently redisplay the groups.  

KEYBOARD SHORTCUT:- Press Ctrl+F1 to unpin or pin the ribbon.   

• Status bar: - Across the bottom of the program window, this bar displays information about 

the current document and provides access to certain program functions. 

 

 

 

By default, Word displays the Page Number, Word Count, Spelling And Grammar Check, and 
Macro Recording indicators at the left end of the status bar. Each of these indicators on the left 
displays at a glance the status of that feature; clicking any of these indicators displays the related 
pane or dialog box.  

At the right end of the status bar, Word displays by default the View Shortcuts, Zoom Slider, and 
Zoom Level controls. The View Shortcuts toolbar includes buttons for the three primary document 

Figure 3 Identifying program window elements 

Figure 2 The Backstage view, where you can manage files and 
customize the program. 

Figure 4 Status Bar 
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content views. The Zoom Slider and Zoom Level controls enable you to adjust the magnification of 
the active document.  

You can display the content of the active document in five views: Draft view, Outline view, Print 

Layout view, Read Mode view, and Web Layout view. All views are available from the View tab; 
Read Mode, Print Layout, and Web Layout views are available from the View Shortcuts toolbar on 
the status bar. You carry out most of the development work on a document in Print Layout view, 
which is the default.  

5.2  Creating a New Document 

By default, Word displays the Page Number, Word Count, Spelling and Grammar Check, and Macro 
Recording indicators at the left end of the status bar. Each of these indicators on the left displays at a 
glance the status of that feature; clicking any of these indicators displays the related pane or dialog 
box.  

At the right end of the status bar, Word displays by default the View Shortcuts, Zoom Slider, and 
Zoom Level controls. The View Shortcuts toolbar includes buttons for the three primary document 
content views. The Zoom Slider and Zoom Level controls enable you to adjust the magnification of 
the active document.  

You can display the content of the active document in five views: Draft view, Outline view, Print 
Layout view, Read Mode view, and Web Layout view. All views are available from the View tab; 
Read Mode, Print Layout, and Web Layout views are available from the View Shortcuts toolbar on 
the status bar. You carry out most of the development work on a document in Print Layout view, 
which is the default. 

Steps to create a New Blank document  

1. Select File->New 

2. Select Blank Document from listed Templates  

3. Click on Create. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Saving a Document 

Each document you create is temporary, indicated by a file name such as Document1, until you save 
it. To save a document for the first time, you click the Save button on the QuickAccess Toolbar or 
click Save in the Backstage view. Either action displays the Save As page of the Back stage view, 
where you can choose a storage location, assign a name, attach metadata tags, and specify a file type 
for the document. When you choose a location on the Save As page, the Save As dialog box opens 
displaying that location in the Address bar at the top of the dialog box. If you want to save the 

Figure 5 The New page of the Backstage view provides access to document Templates 
saved locally (on your computer) and online. 
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document in a folder other than the one shown in the Address bar, you can click the arrow s in the 
Address bar or click locations in the Navigation pane on the left to display the folder you want. If 
Figure 8- The Save As page of the Backstage view provides links to identify existing and new 
locations in which to save documents. 40 you want to create a folder in which to store the document, 
you can click the New Folder button on the toolbar. But when someone wants to create a duplicate 
of the current document in same or different location, Save as ….. is used from File menu. 

                                                                                                   

 

 

 

 

 

 

 

 

 

Opening a Document 

Click the Open page tab. This page displays locations from which you can open existing documents 
as well as a list of the documents you recently worked on. The content of the Places list varies based 
on your available resources.  

 

 

 

Did you Know? 

By default, the Recent Documents list displays a maximum of 20 
documents. You can change this number on the Advanced page of the 
Word Options dialog box. 

Closing a document 

As you know Microsoft word is an application in Windows, which allows to open 

multiple documents at a time side by side. Closing represents to close the active 

document which can be done by 
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1. Click the File tab, and then click Close. 

2. Or, press Ctrl+W. 

3. Or, Press Ctrl+F4(Function key) 

4. Or, Click on the Close Button from the Document Window 

Exiting a word document 

Exit Word means to close all documents from the Application Microsoft word and Close the 
Application. This can be done by: 

1. Click the File tab, and then click Exit. 

2. Or, Press Alt+F4(Function key) Or, Click on the Close Button from the Document. 

5.3  Navigation in a Document 

Navigation means the way of cursor movements in a document efficiently to work more effectively. 

 

Navigation with Keyboard 

These keyboard shortcuts help you to move in a document faster and easily so that you can work 
more efficiently 

Table 1 List of keyboard shortcuts for Navigation 

. 

Navigation with Go To 

On the Home tab, in the Editing group, click the Find arrow (not the button), and then click Go To to 
display the Go To page of the Find and Replace dialog box. 

KEYBOARD SHORTCUT: Press Ctrl+G to display the Go To page of the Find And Replace dialog 
box. 
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Figure 6 Go to in Find and Replace Box 

5.4 Editing text 

Editing documents in Word is just as simple as entering text in a blank document. By clicking within 
the body of the document, you can add text. By default, Overwriting is turned off, which means text 
to the right of the insertion point will be moved to the right. It is important to note, however, that if 
you highlight part of your document and then start typing, the highlighted portion will be deleted 
and the new text will appear in its place; it doesn’t matter whether you have hard returns, images, 
tables, or text highlighted, the results will be the same. In the event you accidentally delete part of 
your document, you can use the Undo feature (ctrl+z)- to undo up to 100 changes you have made to 
your document. If you want to delete portions of your document, you can simply highlight the 
portion you would like to delete and press the delete key; unless you’ve changed Word options, 
Word will automatically correct the spacing at the point of the deletion. To delete individual elements 
of your document, you have two options: The delete key will delete objects to the right of the insertion 
point, while the backspace key will delete objects to the left of the insertion point. 

5.5 Moving and copying text and object 

Perhaps the most important benefit of word processing over typewriter use is the ability to move and 
copy objects and blocks of text. There are many ways of accomplishing move and copy operations in 
Word, so you can select whatever method is most comfortable for you or makes the most sense in a 
particular situation. The following sections explain the various move and copy operations and the 
differences between them. 

Moving or Copying Text with Drag-and-Drop 

Drag-and-drop operations are popular because they most closely resemble the way you do things 
outside the computer. (Yes, there really is a life outside the computer!) When you want to move 
something in your living room, you pick it up and reposition it. Or if it's heavy, like a piece of 
furniture, you drag it and drop it. You can do the same thing with objects and with blocks of selected 
text in Word. 

 

 For a standard drag-and-drop operation, follow these steps:  

1. Select the text or object(s) you want to move or copy.  

2.  To copy, hold down the Ctrl key. You don't have to hold anything down if you want to 

move.  

3. 3. Position the mouse over the selection, and then click and hold down the left mouse button 

on it. 
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4.  4. Still holding down the left mouse button, drag the selection to a new location. Then 

release the mouse button.  

There are additional drag-and-drop options; to see them, use the right mouse button rather than the 
left one in the preceding steps. (Don't hold down the Ctrl key if you are using the right mouse button.) 
When you release the mouse button in step 4, a shortcut menu appears with these choices on it:  

• Move Here—The default operation; the same as regular dragging with the left mouse button.  

• Copy Here—The same as holding down the Ctrl key with the left-mouse-button drag.  

• Link Here—Creates a copy that retains a link to the original location, such that if the original 
changes, this copy changes too.  

• Cancel—Cancels the current drag-and-drop operation. 

Using Cut, Copy, and Paste 

One of the complaints that many people have with drag-and-drop is that they are simply not 
coordinated enough to manage positioning the mouse pointer in exactly the right spot while holding 
down keys and mouse buttons. People who have this problem may prefer to use the Cut, Copy, and 
Paste commands instead. Cut and Copy are very similar operations. Cut removes the selection from 
the document and places it on the Clipboard, which is a hidden holding area; Copy leaves the 
selection as is and places a copy of it on the Clipboard. After a Cut or Copy operation, you can then 
use Paste to place the Clipboard's content at the insertion point location. There are actually two 
Clipboards—the Windows Clipboard and the Office Clipboard. The Windows Clipboard holds only 
one item at a time; when you place a second item on that Clipboard, the first item is erased from it. 
The Office Clipboard has multiple slots for holding content. It uses the Windows Clipboard for one 
slot, but it can also hold 23 other items at the same time. I explain more about the Office Clipboard 
later in the chapter. Word offers ribbon, keyboard, and right-click methods for issuing the Cut, Copy, 
and Paste commands. 

 

If you would like to save something from the Clipboard so that it can be used later, but you don't 
want to save it in Word The Paste Special command enables you to define the format of the pasted 
copy, and in some circumstances also create a dynamic link to the original. 

5.6 Using Clipboard 

Use the Clipboard task pane to access the Office Clipboard's 24 separate areas for storing clips. By 
default, the Clipboard pane is fixed in location and size, but you can click the down arrow in its top-
right corner for a menu from which you can move and resize it. 

92



Unit 5: MS Word    

 

 

 LOVELY PROFESSIONAL UNIVERSITY  

 

 

Notes 

 Each time you copy something to the Clipboard, it is added to the Clipboard task pane's list, with 
the most recently added items at the top. To paste an item from it, position the insertion point and 
then click that item in the Clipboard task pane. To paste all the items at once, click Paste All. 

 To remove a single item from the Clipboard task pane, right-click the item and click Delete. 
(Alternatively, you can point at the item until a down arrow appears to its right. Click that down 
arrow to open the same menu as with right-clicking; then click Delete.) 

 To clear the entire Clipboard at once, click the Clear All button at the top. Clearing the Office 
Clipboard also clears the Windows Clipboard.  

To fine-tune how the Office Clipboard works, click the Options button. A menu appears with these 
options on it:  

• Show Office Clipboard Automatically—Displays the Office Clipboard automatically when 
copying items.  

• Show Office Clipboard when Ctrl+C Pressed Twice— Displays the Office Clipboard when Ctrl+C 
is pressed twice.  

• Collect Without Showing Office Clipboard—Copies items to the Office Clipboard but does not 
show the task pane unless you specifically call for it (by pressing Ctrl+C twice, for example).  

• Show Office Clipboard Icon on Taskbar—Displays an Office Clipboard icon in the notification area 
of the taskbar (near the clock) whenever the Office Clipboard is active. You can double-click that icon 
to display the Office Clipboard in the active application. (Remember, all Office apps share the Office 
Clipboard.)  

 

•Show Status Near Taskbar When Copying—Pops up a message near the Office Clipboard icon when 
something has just been copied to the Clipboard. 

 

 

 

5.7 Formatting Text 

The appearance of your documents helps to convey their message. Microsoft Word 2013 can help 
you develop professional-looking documents whose appearance is appropriate to their contents. You 
can easily format words and paragraphs so that key points stand out and the structure of your 
document is clear. You can also change the look of major elements within a document by applying 
predefined sets of formatting called styles, and you can change the look of selected text by applying 
predefined combinations called text effects. In addition, you can change the fonts, colors, and effects 
throughout a document with one click by applying a theme. 

Figure 7 Delete and 
copy  from clipboard 
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Applying styles to text 

You don’t have to know much about character and paragraph formatting to be able to format your 
documents in ways that will make them easier to read and more professional looking. With a couple 
of mouse clicks, you can easily change the look of words, phrases, and paragraphs by using styles. 
More importantly, you can structure a document by apply- ing styles that are linked to outline levels. 
In doing so, you build a document outline that is reflected in the Navigation pane and can be used 
to create a table of contents. Styles can include character formatting (such as font, size, and color), 
paragraph formatting (such as line spacing and outline level), or a combination of both. Styles are 
stored in the template that is attached to a document. By default, blank new documents are based on 
the Normal template. The Normal template includes a standard selection of styles that fit the basic 
needs of most documents. These styles include nine heading levels, various text styles including 
those for multiple levels of bulleted and numbered lists, index and table of contents entry styles, and 
many specialized styles such as those for hyperlinks, quotations, placeholders, captions, and other 
elements. 

 

 

                          Figure 8 Heading styles define a document outline 

Styles stored in a template are usually based on the Normal style and use only the default body and 
heading fonts associated with the document’s theme, so they all go together well. For this reason, 
formatting document content by using styles produces a harmonious effect. After you apply styles 
from the current style set, you can easily change the look of the entire document by switching to a 
different style set, which associates different formatting rules with the same styles. So if you have 
applied the Heading 1 style to a paragraph, you can change its formatting simply by changing the 
style set. Style sets are available from the Document Formatting menu on the Design tab. 

94



Unit 5: MS Word    

 

 

 LOVELY PROFESSIONAL UNIVERSITY  

 

 

Notes 

 

Figure 9 - Pointing to a style set in the gallery displays a live preview of the effects 

Applying Borders and Shading 

To enhance the appearance of the text in a paragraph, you can quickly add a border and shading to 
selected text. When you add a border, you can specify what sides you want to include or exclude. 
For example, you can add a border on just the top and the bottom and leave the sides open. Shading 
colors the background behind the selected text or paragraph. If you want to customize borders and 
shading by changing line style, color, and width preferences, you can make changes in the Borders 
and Shading dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Apply a Border 

Select the paragraph text you want to format.  

• Click the Home tab.  

• Click the Borders and Shading button arrow, and then click Figure  Border Color  to select the 
border commands to add or remove a border. 

Apply Paragraph Shading and Borders 

Figure 10 Border Color 
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1. Select the paragraph text you want to format. 

2.  Click the Home tab.  

3.  Click the Borders and Shading button arrow, and then click Borders and Shading.  

4.  Click the Borders tab. 

5. . Click to select the type of Setting you want for your border. 

6. . Click to select the type of Style.  

7. . Apply any other options you want.  

8. . Look in the preview box to see the new border.  

9. Click the Shading tab.  

10. Click to select the shading fill color you want to apply to your table.  

11. . Apply any other options you want. 

12. . Look in the preview box to see the new shading color.  

13.  Click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                              Figure 11 Shading Dialogue box 
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Summary 

• Word is a word processor, created by Microsoft Corporation, US. 

• The word screen contains the title bar, Menu bar, Toolbars, Ruler and etc. 

• World 2013 presents a new user interface which is quite different than previous of word. 

• The word’s document views contains normal views, outline, print layout, web layout and 

print preview. 

Keywords 

• Insertion Point: In graphics-based programs, the insertion point is the point where the next 

characters typed from the keyboard will appear on the display screen. A blinking vertical 

line usually represents the insertion point. You can reposition the insertion point by 

pressing the arrow keys or by moving the I-beam pointer. 

• Menu Bar: A horizontal menu that appears on top of a window. Usually, each option in a 

menu bar is associated with a pull-down menu. 

• Backspace: Remove characters to the LEFT of the insertion point. 

• Delete: Remove characters to the RIGHT of the insertion point. 

 

Self-Assessment Questions 

1.The process of removing unwanted part of an image is called: 

a) Hiding 

b) Bordering 

c) Cropping 

d) Cutting 

2.A number of letters that appears little above the normal text is called: 

a) Superscript 

b) Subscript 

c) Supertext 

d) Toptext 

3.A number of letters that appears little below the normal text is called: 

a) Superscript 

b) Subscript 

c) Supertext 

d) Toptext 

4.The direction of a rectangular page for viewing and printing is called: 

a) Orientation 

b) Direction 

c) Print Layout 

d) Preview 

5.A word processor would most likely be used to do_______ 

a) Keep an account of money spent. 
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b) Do a computer search in media center. 

c) Maintain an inventory. 

d)   Type a biography. 

6.How many types of alignment options are available under paragraph ribbon? 

a) 5 

b) 6 

c) 4 

d) 3 

7.Which is not in MS word? 

a) Italic 

b) Magic Tool 

c) Font 

d) Bold 

8._________ is a word processing software package which is used to type letters, documents, reports 
etc. 

a) MS Word 

b) Notepad 

c) Control Panel 

d) Desktop 

9.Which is not a Font Style? 

a) Bold 

b) Superscript 

c) Italic 

d) Regular 

10.The default Page orientation of word document is___ 

a) Landscape 

b) Long sides 

c) Portrait 

d) Double long side 

11. The name of the document is displayed on _______ 

a) Ruler 

b) Status bar 

c) Title bar 

d) View buttons 

12. What is the shortcut key to underline a text? 

a) Ctrl+B 

b) Ctrl+C 

c) Ctrl+U 

d) Ctrl+E 
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13.Ctrl+N is the shortcut key to open? 

a) A new file/document 

b) An existing file/document 

c) To save a file/document 

d) To print a file/document 

14.Which of the following option is not available in paragraph palette? 

a) Bullets and numbering 

b) Color the background of the text 

c) Alignment of text 

d) Superscript and Subscript 

 

15._______option we can customize our documents’ view that help us in studying and documenting 
in different  formats. 

a) Edit 

b) View 

c) Insert 

d) File 

Answers for Self-Assessment Question 

1. C 
2. A 3. B 4. A 

5. D 
6. C 7. B 8. A 

9. B 
10. C 11. C 

12. C 
13. A 14. D 15. B 

 

Review Questions 

1. Explain the various buttons displayed in the Preview window. 

2. Briefly explain the use of Formatting toolbar in Word. 

3. What is the function of the status bar in the Word? List down the information that is 

displayed in the status bar. 

4. What are the various views available to see a document in Word? 

5.  

Further Reading 

  

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister 

  

http://books.google.co.in/bkshp?hl=en 
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Unit 06: MS Word 

CONTENTS 

Objectives 

Introduction 

6.1 Finding and Replacing Text 

6.2 Working with Table, Chart and Excel Spreadsheet in MSWord 

6.3 Inserting Charts 

6.4 Correcting spelling and grammatical errors 

Summary 

Keywords 

Self-Assessment 

Answer for Self Assessment 

Review Questions 

Further Reading 

Objectives 

• Discussed finding and replacing the text in MS word.  

•  Explain proofing of documents and working with tables.  

• Discussed about collecting of various spelling errors as will as the quick spelling errors.  

• Discussed synonyms thesaurus and hyphenating documents. 

•  Explain the using and creating, insertion of Auto corrects and Auto text.  

 

Introduction 

The most basic function of MS Word is to create a document/file. Once a document has been 

created, the user may enter data—for example by typing some text. At any point after the 
document has been created, the user is allowed to save the contents. The document can then be 

accessed at a later time and modified as necessary. Documents can be printed out at any stage in 

this process. 

6.1  Finding and Replacing Text 

The Find and Replace option of Word is a convenient way of searching for a particular word in a 

document and replacing it with another. It can be used in situations where an error (not an error in 
spelling) has been committed consistently in a document and has to be corrected. The Find 

command moves to a specific point in the document quickly and the Replace command searches for 

and replaces the text. 

 

This opens Word’s Find and Replace window. In the “Find What” box, type the word or phrase 

you want to locate. If you only want to find text in your document, you can go ahead and click the 
“Find Next” button to have Word jump to the next occurrence of that word. Keep clicking it to 

browse through all the results. 

Bhanu, Lovely Professional University
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If you want to replace the text you find with something else, type the replacement text into the 
“Replace With” box. You can enter up to 255 characters in the both the “Find What” and “Replace 

With” boxes, by the way. 

Find Text 

You can use the Navigation pane to search for specific words or phrases in a document. 

1. Click Find on the Home tab.(The Navigation pane appears on the left, displaying the 

Results view.) 

SHORTCUT-> PRESS Ctrl+F. 

2. Click in the Search document box in the Navigation pane and type the text you want to 

find. 

The search runs automatically. Results are highlighted in the document, and the 

Navigation pane lists all instances of the word. 

3. Click a search result to jump to it in the document.You can use the arrows under the 

search box to jump to the Previous or Next search result. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Click Close when your are finished. 
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Advanced Find 

To search your documents for more specific items, such as certain capitalization or only whole 

words, use Advanced Find. 

1. Click Find button list arrow. 

2. Select Advanced Find.The Find and Replace dialog box opens. 

3. Type the word you're looking for in the Find box. 

By default, the Find and Replace dialog box only shows the basics—a search field. There are more 

options available if you expand the dialog box. 

4. Click the More button 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

The advanced options here let you set some options on how to conduct the search. 

5. Check the advanced criteria you want to use. 

TIP:You can choose to exactly match the case or only search for whole words. You can also use 

wildcards, or ignore punctuation and spacing. 

6. Click Find Next. Word navigates to and selects the next instance that fits the additional 

criteria. 

7. Click Close when you're done. 
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The Find and Replace dialog box closes. 

Replace Text 

If you’ve spelled something incorrectly in multiple places, Word can fix them all with just a few 

steps. 

 

1. Click Replace on the Home tab.The Find and Replace dialog box opens to the Replace tab.  

2. Type the word you need to replace in the Find what text field. 

3. Type the word you need to replace in the Replace with text field. 

4. Select a replacement option. 

• Replace: Replaces the first instance of the word. Keep clicking to fix them one at a time.  

• Replace All: Fixes all instances of the word at once. 

 

Once all the instances of the word have been replaced, a dialog box will pop up to let you 

know it’s complete. 

5. Click OK. 

6. Click Close when you're done. 
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The Find and Replace dialog box closes. 

6.2 Working with Table, Chart and Excel Spreadsheet in MSWord 

A table is a structure of vertical columns and horizontal rows. Each column and each row can be 

identified by a heading, although some tables have only column headings or only row headings. 

The box at the junction of each column and row is a cell in which you can store data (text or 

numeric information). 

 

Creating Table 

You can create tables in a Word document in the following ways:  

 

 

 

 

 

 

 

 

▪ To create a blank table of up to 10 columns and eight rows, click Table on the Insert tab. This 
displays the Insert Table gallery and menu. The gallery is a simple grid that represents columns 

and rows of cells. Pointing to a cell in the grid outlines the cells that would be included in a table 
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created by clicking that cell and displays a live preview of the prospective table. Clicking a cell in 
the grid inserts an empty table the width of the text column. The table has the number of rows and 

columns you indicated in the grid, with all the rows one line high and all the columns of an equal 

width. 

▪ To create a more customized empty table, click Insert Table on the Insert Table menu. This 

displays the Insert Table dialog box, in which you can specify the number of columns and rows and 

the width of the table and its columns.  

▪ To create a less clearly defined empty table, click Draw Table on the Insert Table menu. This 

displays a pencil with which you can draw cells directly in the Word document to create a table. 
The cells you draw connect by snapping to a grid, but you have some control over the size and 

spacing of the rows and columns. After drawing a base table, you can erase parts of it that you 

don’t want and adjust the The intended table dimensions (expressed as columns x rows) are shown 
in the gallery header. You can create a custom- 95 table, column, and row size by using tools on the 

Layout tool tab for tables. TIP When drawing a table, you can display the rulers or gridlines to help 

guide you in placing the lines.  

• To present data that already exists in the document (either as regular text or as a tabbed list) as a 

table, select the data and then click Convert Text to Table on the Insert Table menu. (Conversely, 
you can convert the active table to regular text by clicking Convert to Text in the Data group on the 

Layout tool tab.)  

• To create a table by entering data in a Microsoft Excel worksheet, click Excel Spreadsheet on the 

Insert Table menu. Enter the data you want in the spreadsheet that appears in the document—you 
can use Excel features such as functions and formulas to create or manipulate the data. Format the 

data in Excel as you want it to appear in Word. Then click in the document outside the spreadsheet 

window to insert a table- like snapshot of the data. You can modify the data by double-clicking the 
table and editing the content of the spreadsheet that opens. Tables appear in the document as a set 

of cells, usually delineated by borders or gridlines. (In some Quick Tables, borders and gridlines are 

turned off.) Each cell contains an end-of- cell marker, and each row ends with an end-of-row 

marker. 

When you point to a table, a move handle appears in its upper-left corner and a size handle in its 

lower-right corner. When the cursor is in a table, two Table Tools tabs—Design and Layout—

appear on the ribbon. 

 

        

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The basic methods for manipulating a table or its contents are as follows: 

 ▪ Insert rows or columns Simply point to the left edge of the table where you want to insert a row, 
or to the top of the table where you want to insert a column. A gray insertion indicator labeled with 

Figure 1 You can directly draw a table on a page 
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a plus sign appears as you approach a possible insertion point (after any existing row or column). 

When the insertion indicator turns blue, click to insert the row or column where indicated.  

To insert one or more rows or columns, select the same number of existing rows or columns 

adjacent to the location where you want to insert them. On the Mini Toolbar that appears, click 
Insert and then click Insert Above, Insert Below, Insert Left, or Insert Right. If the Mini Toolbar 

doesn’t appear, on the Layout tool tab, in the Rows & Columns group, click the Insert Above, Insert 

Below, Insert Left, or Insert Right button. 

▪ Insert cells: To insert one or more cells in a table, select the number of cells you want to insert 

adjacent to the location where you want to insert them, click the Rows & Columns dialog box 
launcher to open the Insert Cells dialog box, and then specify the direction to move adjacent cells to 

accommodate the new cells. 

 ▪ Delete table elements: Select one or more rows, columns, or cells. On the Mini Tool- bar that 
appears, or in the Rows & Columns group, click Delete, and then click Delete Cells, Delete 

Columns, Delete Rows, or Delete Table. 

 

 

 

 

 

▪ Resize an entire table: Point to the table, and then drag the size handle that appears in its lower-
right corner. Hold down the Shift key while dragging the size handle to maintain the original 

aspect ratio of the table.  

▪ Resize a single column or row: Drag the right border of a column to the left or right to manually 
set the width or double-click the border to adjust it to the narrowest width that fits its content. Drag 

the bottom border of a row up or down to manually set the height or use the commands in the Cell 

Size group on the Layout tool tab to manage column width and row height. 

 ▪ Move a table: Point to the table, and then drag the move handle that appears in its upper-left 

corner to a new location, or use the Cut and Paste commands in the Clip- board group on the Home 

tab to move the table.  

▪ Merge cells :Create cells that span multiple columns or rows by selecting the cells you want to 

merge and clicking the Merge Cells button in the Merge group on the Layout tool tab. For example, 
to center a title in the first row of a table, you can merge all the cells in the row to create one merged 

cell that spans the table’s width.  

▪ Split cells: Divide one cell into multiple cells by clicking the Split Cells button in the Merge group 
on the Layout tool tab and then specifying the number of columns and rows into which you want 

to divide the cell.  

▪ Sort information: Click the Sort button in the Data group on the Layout tool tab to sort the rows 
in ascending or descending order by the data in any column. For ex- ample, in a table that has the 

column headings Name, Address, ZIP Code, and Phone Number, you can sort on any one of those 

columns to arrange the information in alphabetical or numerical order. 
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Insert or delete elements from the mini toolbar 

Formatting tables 

Manually formatting a table to best convey its data can be a process of trial and error. With Word 

2013, you can quickly get started by applying one of the table styles available in the Table Styles 

gallery on the Design tool tab. The table styles include a variety of borders, colors, and other 

attributes that give the table a very professional appearance. 

 

 

 

 

 

 

 

 

 

 

 

 

Auto formatting table 

If you want to control the appearance of a table more precisely, you can use the commands on the 

Design and Layout tool tabs to format the table elements. You can also separately format the table 

content. As you saw in the previous exercise, you can apply character for- matting to the text in 
tables just as you would to regular text, by clicking buttons on the Mini Toolbar and in the Font, 

Paragraph, or Quick Styles groups on the Home tab. 

6.3 Inserting Charts 

When you create a new chart from within a Word document, Word and Excel work together to 
provide some pretty fancy functionality. A generic chart appears in the document, and a worksheet 

containing the sample data opens in Excel. You can then edit the sample data to create the chart 

that you want. You don’t have to save the Excel file; Word maintains its data with the document 

and it is available to you whenever you want to update it. 

 

Charts option from Illustration 

 

107



Unit 6: MS Word  

 LOVELY PROFESSIONAL UNIVERSITY  

Notes 

 

The Excel worksheet is composed of rows and columns of cells that contain values, which in 
charting terminology are called data points. Collectively, a set of data points is called a data series. 

As with Word tables, each worksheet cell is Figure 80 Chart option from Illustration 104 identified 

by an address consisting of its column letter and row number—for example, A2 is the first cell in 
the second row. A range of cells is identified by the address of the cell in the upper-left corner and 

the address of the cell in the lower-right corner, separated by a colon—for example, A2:D5 is the 

range of cells from the first cell in the second row to the fourth cell in the fifth row.  

To customize the chart, you replace the sample data in the Excel worksheet with your own data. 

Because the Excel worksheet is linked to the chart, when you change the values in the worksheet, 
the chart changes as well. To enter a value in a cell, you click the cell to select it, or move to the cell 

by pressing the Tab key or arrow keys, and then enter the data. You can select an entire column by 

clicking the column header—the shaded box containing a letter at the top of each column—and an 
entire row by clicking the row header—the shaded box containing a number to the left of each row. 

You can select the entire worksheet by clicking the Select All button—the box at the junction of the 

column and row headers. 

6.4 Correcting spelling and grammatical errors 

In the days of handwritten and typewritten documents, people might have tolerated a 

typographical or grammatical error or two because correcting such errors without creating a mess 

was difficult. Word-processing programs such as Word have built-in spelling and grammar 
checkers, so now documents that contain these types of errors are likely to reflect badly on their 

creators.  

. Word provides these three tools to help you with the chore of eliminating spelling and grammar 

errors: 

 ▪ AutoCorrect: This feature corrects common spelling and grammatical errors, replaces text codes 

with mathematical symbols, and automatically applies formatting based on text cues. AutoCorrect 
has a built-in list of frequently misspelled words and their correct spellings. If you frequently 

misspell a word that AutoCorrect doesn’t change, you can add it to the list in the AutoCorrect 
dialog box. If you deliberately enter a word that is on the AutoCorrect list and don’t want to accept 

the AutoCorrect change, you can reverse the correction by clicking the Undo button before you 

enter anything else, or by pointing to the bar that appears below the word and then clicking Undo.  

 ▪ Error indicators: Word indicates possible spelling errors with red wavy underlines, possible 

grammatical errors with green wavy underlines, and possible formatting errors with blue wavy 

underlines. You can right-click an underlined word or phrase to display suggested corrections and 

links to proofing resources. 

 ▪ Spelling and grammar checker: To check the spelling or grammar of selected text or the entire 

document, click the Spelling & Grammar button in the Proofing group on the Review tab. Word 
then works its way through the selection or the document and displays the Spelling pane or 

Grammar pane if it encounters a potential error.  

KEYBOARD SHORTCUT Press F7 to start checking the spelling and grammar from your current 

location in the document. 
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The pane that appears displays an explanation of the likely problem and suggests corrections. You 

can implement a suggestion by double-clicking it. 

Check spelling and Grammar 

All Microsoft Office programs can check the spelling and grammar of your files. In Microsoft Word 

2013 you’ll find the Spelling & Grammar options here: 

• Click Review > Spelling & Grammar (or press F7) to start the spelling and grammar checker and 

see the results in the Spelling and Grammar task pane. 

 

 

 

 

 

 

All  instances of a word, press g. Choose from these options as the spelling and grammar checker 

goes through each word: 

 1. Check the spelling and grammar all at once. 

 2. Check spelling and grammar automatically, as you type.  

3. Recheck the words you previously checked and chose to ignore (but changed your mind).  

Check spelling and grammar all at once: 

Checking all the spelling and grammar in your document is useful when you want to quickly proof 

your text. You can check for possible mistakes and then decide if you agree with the spelling and 

grammar checker.After you click Spelling & Grammar (or press F7) you can fix each error that 
Word finds in different ways. In the task pane at the right of your document, you will see the 

spelling and grammar choices: 

• Fix the error using Word’s suggestions If you want to fix the error by using one of the suggested 

words, select the word in the list of suggestions and click Change. (You can also click Change All if 
you know you’ve used this incorrectly spelled or used word throughout the document so that you 

don’t have to address it each time it pops up.) 

• Create a dictionary entry If the word is a real word that you use and one that you want Word—

and ALL of the Office programs—to recognize too, click Add 

. • Ignore the word Maybe you want to ignore this misspelled word (for whatever reason): Click 

Ignore or Ignore All. 

 

 

If you prefer to use the keyboard to review the results, press the underlined letter found 
on the buttons in the task pane. For example, to                       instances of a word, press 

g. 
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Check spelling and grammar automatically: 

Checking spelling and grammar while you type may be a preferred way for you to save time: You 
make the necessary corrections and changes while you’re writing, not waiting until after (you 

think) your document is complete. 

 1. First, to turn on (or off) automatic spelling and grammar checking, click File > Options > 
Proofing.  

2. As you can see in the picture above, you can choose to automatically check spelling, grammar—

one or the other, both, or neither—or even other options, such as contextual spelling. 

 3. Under Exceptions you can choose to hide grammar and spelling errors in your open document 

or, if you leave the options unchecked but keep any of the options above them checked, all of your 

new documents going forth will keep those settings. 

 

 Spelling and Grammar setting option 

How the automatic spelling checking works 

Word flags misspelled words with a red squiggly line under it as you work so that you can easily 

locate mistakes. 

 

When you right-click the misspelled word, you’ll see a menu where you can choose how you want 

to handle the mistake. 
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Option menu on right clicking. 

Summary 

• MS word tells us about specific functions, which we can use in the word documents. 

• Find and Replace option of word is convenient way of searching for particular word in whole 

document. 

• Numbering feature, it acts like the bullets only which used number instead of bullets in the text 

document. 

• Spelling and grammar button is the standard Toolbars to check the spelling and any 

graphemically errors in the text document. 

• Auto correct feature inserts text in the heard document automatically.  

Keywords 

• AutoComplete: AutoComplete is a feature in Microsoft Word that enables Word to guess 

what you are typing when you enter commonly used document words. This feature can 

save time if you know how to use it. 

• AutoCorrect: AutoCorrect is best used for creating shortcuts for words, phrases, and even 

images. For example, if you often type Microsoft Word, you could create a shortcut such 

as “msw”. Then any time you typed “msw”, it would expand to Microsoft Word.  

• AutoText: AutoText is best used for longer phrases or paragraphs (for example, 

“boilerplate” text for disclaimers or a standard closing for a letter). AutoText is also 

already setup with several standard AutoText entries. 

Self-Assessment 

1. Bullets and numbering falls under the category of which ribbon? 

A. Font 

B. Paragraph 

C. Styles 

D. Clipboard 

2. If I have to create a Menu of restaurant which option, will you choose to make it?  

A. Bullets 

B. Numbering 

C. Indent 

D. None of the above 
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3. If I wish to create a list of students in a serial order which option, will you choose to do so? 

A. Bullets 

B. Numbering 

C. Indent 

D. None of these 

 

4. When you type a number, a period, and then a space before a word, what happens when 

you press enter? 

A. Word creates a numbered list. 

B. Word asks if you want to create a numbered list. 

C. If you are not already in outline view, you are switched to it. 

D. None of the above. 

 

5. Which procedure opens the symbol dialog box, allowing you to choose from every symbol 

available for creating bullets? 

A. On the format menu, click font, and then click symbol. 

B. Right click the selected text and click bullet symbol on the shortcut menu. 

C. Click the bullets button on the formatting toolbar. 

D. In the customize bulleted list dialog box, click bullet. 

 

6. What are the horizontal sections of a table called? 

A. Cells 

B. Rows 

C. Columns 

D. None of these 

 

7. What tool can you use to automatically format your table? 

A. The magic right click button 

B. The AutoFormat command. 

C. The Edit Select All command. 

D. None of these 

 

8. What are the boxes or squares in a table called? 

A. Cells 

B. Square 

C. Row 

D. Column 

 

9. What is the use of tables? 

A. To organize the information 

B. To hold clipart 

C. To type paragraphs 

D. None of these 

 

10. What are the vertical sections of a table called? 

A. Rows 

B. Columns 
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C. Square 

D. Cells 

 

11. The spelling and grammar tool 

A. Indicates grammatical errors. 

B. Corrects spelling errors as you type. 

C. Identifies words with capitalization problems. 

D. All of the above 

 

12. The thesaurus tool is used to ___________ 

A. Finds repeated words in the document 

B. Check for synonyms and antonyms. 

C. Corrects misspelling word. 

D. None of the above 

 

13. The auto correct tool _____ 

A. Provided statistics about your document. 

B. Displays words with the same or similar meaning. 

C. Checks the grammar in the document. 

D. Checks for misspelled words as you type and underling them. 

 

14. Which option is used to convert a document into a different language? 

A. Translate 

B. Language 

C. Restrict editing. 

D. Read Aloud 

 

15. ______ tool is used to read your document in a human built in voice. 

A. Read Aloud 

B. Word Count 

C. Translate 

D. Resume Assistant 

 

Answer for Self Assessment 

1. B 2. A 3. B 4. A 5. D 

6. B 7. B 8. A 9. A 10. B 

11. D 12. B 13. D 14. A 15. A 
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Review Questions 

1. In your document, you have typed the word file as “file” but you want to find and replace 

all the occurrences of this word to “File”. How would you do this?  

2. How will you create an AutoText entry? 

3. What do you understand by AutoComplete feature of Word? 

4. Briefly explain how would you search a particular character in the document and replace 

it with another. 

Further Reading 

 

Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister 

 

http://books.google.co.in/bkshp?hl=en 
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Keywords 
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Purpose and Objectives 

• Understanding of handling Graphics in MS Word  

•  Explanation of setting page size and margins  

• Understanding of printing document  

•  Discussion of mail merge  

•  Working of mail merge 

 

Introduction  

Microsoft Word is part of the Microsoft Office. Its main function is for producing documents that can 

includes text, graphics, table, clip art. 

7.1 Handling Graphics 

Adding graphics or picture to illustrate your documents makes them more appealing. Graphics 

format falls into two camps: bitmap and vector. Bitmap graphics are composed of small dots, called 

pixels. Each pixel is represented by one or more bits in the computer’s memory that define colour 
and intensity. Vector graphics, in contrast comprise of a set of drawing instructions that describe the 

dimension and shape of every line, circle, arc, or rectangle. Word allows you to do much more than 

simply insert or place graphics. For our fourth lesson in this series, we will focus on the graphic 
design functions in Word such as pictures, SmartArt, screenshots, and other items that can be found 

on the “Insert” tab. 

These functions really breathe life into your drab black and white text documents. With a simple 

picture or chart, you can turn your term paper from meh to yeah! Luckily, there’s a whole range of 

ways you can add images to better illustrate (no pun intended) your point. 

We’ll wrap the lesson by changing gears a bit and discussing how to use more than one language in 

Word 2013. 

7.2 Image and Multimedia 

You don’t have to think of Word as simply a word processing program. It has requisite tools for 
doing some pretty nifty page layout. While it’s not a feature-complete or robust as a professional 
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page layout program such as Adobe InDesign. You can still get very professional looking results if 

you know what’s in your toolbox and how to use it. 

 

Pictures and Online Pictures 

Both “Pictures” and “Online Pictures” accomplish the same goal. The only difference is that 
“Pictures” means you can insert pictures locally, while “Online Pictures” allows you to insert images 

from an internet-based source such as clip art from Office.com, Bing, or OneDrive (formerly 
SkyDrive). You can also insert pictures from your Facebook profile or Flickr although you could 

always just save the pictures you want to insert to your computer and then insert them from there if 

you don’t want to connect Office to these profiles. 

 

 

Picture Tools 

As always, when you want to edit a picture or any element place in a Word document, you can click 

on it and the appropriate tab will appear on the Ribbon. 

With pictures, that tab is “Picture Tools.” Here we see you can make all kinds of corrections to the 

picture on-the-fly. For example, you can correct brightness and contrast, the color, add a border.  
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Where you position and how you wrap text will also play a large role in formatting your documents.  

 

Here we see those controls. In our documents, we don’t worry so much about word wrapping or 
positioning because Word isn’t the final step toward publishing online. However, if you’re going to 

produce something WYSIWYG (What You See is What You Get), such as for a PDF or print 

publication, then these things will definitely matter. 

 

 

Also, there are a couple ways you make changes to your pictures inline, such as resizing, rotating, 

and moving them. In the following image, you see these controls, many of which you will likely be 

familiar with. 
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When you click on an image in your document, you get a box on each corner, which will let you 

resize a picture. At the top, in the middle, is a circular arrow, grab this to freely rotate your picture. 
To move the image, hover the mouse over the image until the pointer is the four arrows, you can then 

click and drag the image anywhere you like. 

Finally, if you click on the little “Layout Options” button, you can change your text wrapping without 

going to the Ribbon. 

 

Clicking on “See more…” at the bottom of the “Layout Options” opens the full-blown “Layout” 

dialog. 

When you click on an image in your document, you get a box on each corner, which will let you 

resize a picture. At the top, in the middle, is a circular arrow, grab this to freely rotate your picture. 
To move the image, hover the mouse over the image until the pointer is the four arrows, you can then 

click and drag the image anywhere you like. 

Finally, if you click on the little “Layout Options” button, you can change your text wrapping without 

going to the Ribbon. 

Clicking on “See more…” at the bottom of the “Layout Options” opens the full-blown “Layout” 

dialog. 
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Note, the size tab both on the Ribbon the “Layout” dialog allows you to specifically resize, rotate, 

and scale your pictures, rather than relying wholly on winging it: 

 

We’d like to spend the whole day talking about formatting images in Word, but as you can see, there’s 

a ton of options at your disposal. Let’s move on now to other objects you can insert into your 

documents, starting with “Shapes.” 

Shapes 

Microsoft Word 2013 comes with an array of built-in shapes, which you can use to create callouts, 

boxes, stars, and other shapes. 

 

When you choose a shape, you simply draw it on a blank space on the page. It doesn’t matter if you 
get it perfect or just the way you want it because you can adjust it to your heart’s content once it is 

placed in your document. 

Note in the screenshot, the previously mentioned little “handles” you can use to resize and rotate 

your shapes. 
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At the bottom of the “Shapes” menu, there’s an option to create a “new drawing canvas.” This will 
open, what is essentially a text box for shapes. With this drawing canvas, you can create drawings 

using these shapes allowing you to create things like diagrams and flowcharts.  

SmartArt and WordArt 

SmartArt and WordArt tend to have some overlap, particularly if you create something using 
WordArt and then customize any of the text within it. Of course, you can use one or the other and 

never the twain shall meet, but we’re going to talk about them in the same section because one often 

leads to the other. 

 

Think of SmartArt as premade drawing canvases that you can insert into your document and then 

customize as you like. Simply pick an arrangement, such as a list, process, or cycle.  

 

As you can see, we created a graphic based on a “Continuous Block Process.” When we click on the 

text boxes, we can edit what is inside. There are also the usual grab handles needed to resize the 

image, and the “Layout Options” allowing you to wrap text to your preference. 
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If you use SmartArt, note that the Ribbon changes to reflect this. The “SmartArt Tools” features two 

tabs: “Design” and “Format.” Let’s cover each one and its features.  

The right half of the “Format” tab allows you to pick from a number of “SmartArt Styles” and you 

can also “Change Colors.” 

 

If you look at our previous example, you can see we applied an embossed, shiny effect and changed 

the colors of our text boxes and arrow. 

 

On the left half of the “Design” tab, you can “Create Graphic” so you can add shapes, bullets, text, 

and move things around. 
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The “Layouts” section lets you change how your graphic looks on the fly. Simply hover over any of 
the built-in options to see how it would look utilizing a different layout. Changes to the layout are 

not applied unless you first click on a style. 

 

The right side of the “Format” tab is used for affecting changes to text. These include “WordArt 

Styles” and other effects such as fill and outline. Beyond that, you can arrange multiple layers by 

sending them forward and backward. 

 

The “Layout” dialog pops out if you select the little arrow in the bottom-right corner of the “size” 

section or you can choose more options from any of the drop-down menus including “Position”, 

“Align”, and “Rotate.” 
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On the left side of the “Format” tab you can select any of your shapes and change them to another, 

and also make them larger or smaller. 

 

If you click on “Shape Styles” you will be able to choose from a selection of pre-defined shapes and 

colors. 
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Shift right just slightly and you will find controls to alter the fill. Choose from various “Theme 
Colors” or select your own. You can also use pictures, gradients, and textures for even more fill 

options. 

7.3 Charts 

Charts are a great way to visually display data sets and Word 2013 comes jam packed with a large 
assortment of Charts to choose from, including columns, pie, bar charts and much, much more. Check 

out the screenshot for an idea of just how many options there are: 

 

Using the “Design” tab, if you don’t like the colors or style of your chart, you can instantly apply 

changes to it without having to generate a new one. 

 

7.4 Screenshots 

The “Screenshot” feature will allow you to take a screen clip, which is automatically pasted in you 

document. 

 

When you use the screenshot function, it will let you choose between any currently open windows, 
or you can select “Screen Clipping,” which will minimize Word allowing you to take a selection or 

full shot of your desktop. So for example, if you want to simply insert a shot of your desktop and its 

icons, you would first need to minimize everything you have open. 
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There’s a myriad of ways you can take and add screenshots, so we’re not going to dwell on it. Just 
note this feature, if you’re unfamiliar with adding screenshots, and you want an easy way to do it in 

Word. 

Online Video 

You can insert “Online Video” such as Bing, YouTube, or video embed code into your document.  

 

When you embed a video, it will appear as if it is a regular picture, complete with grab handles and 

text wrap controls. 

 

Further, you can adjust how the emedded video thumbnail appears (as a picture) using the “Picture 

Tools” so you can make adjustments to the color, add a border, correct the contrast and brightness, 

and more. 

 

So you see, we simply applied a “picture style” and add a purple border. This is only a fraction of 

the stuff you can do, so if you to add some really nice looking effects and create a nice looking 

document that really pops, you should take your time to familiarize yourself with everything. 
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7.5 Mail Merge 

Mail Merge is a useful tool that allows you to produce multiple letters, labels, envelopes, name tags, 
and more using information stored in a list, database, or spreadsheet. When performing a Mail 

Merge, you will need a Word document (you can start with an existing one or create a new one) and 

a recipient list, which is typically an Excel workbook. 

To use Mail Merge: 

1. Open an existing Word document, or create a new one. 

2. From the Mailings tab, click the Start Mail Merge command and 

select Step-by-Step Mail Merge Wizard from the drop-down menu. 

 
The Mail Merge pane will appear and guide you through the six main steps to complete a merge. 

The following example demonstrates how to create a form letter and merge the letter with a recipient 

list. 

Step 1. 

From the Mail Merge task pane on the right side of the Word window, choose the type of 

document you want to create. In our example, we'll select Letters.  

Then click Next: Starting document to move to Step 2. 
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Step 2:Select Use the current document, then click Next: Select recipients to move to Step 3. 

 
 

Step 3: 

Now you'll need an address list so Word can automatically place each address into the document. 
The list can be in an existing file, such as an Excel workbook, or you can type a new address list from 

within the Mail Merge Wizard. 

Select Use an existing list, then click Browse to select the file. 
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1. Locate your file, then click Open. 

 

2. If the address list is in an Excel workbook, select the worksheet that contains the 

list, then click OK. 

 

3. In the Mail Merge Recipients dialog box, you can check or uncheck each box to control 

which recipients are included in the merge. By default, all recipients should be selected. 

When you're done, click OK. 

 

4. Click Next: Write your letter to move to Step 4. 
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If you don't have an existing address list, you can click the Type a new list button and click Create, 

then type your address list manually. 

Step 4: 

Now you're ready to write your letter. When it's printed, each copy of the letter will basically be the 

same; only the recipient data (such as the name and address) will be different. You'll need to 

add placeholders for the recipient data so Mail Merge knows exactly where to add the data. 

To insert recipient data: 

1. Place the insertion point in the document where you want the information to appear.  

 

2. Choose one of the placeholder options. In our example, we'll select Address block. 
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3. Depending on your selection, a dialog box may appear with various 

customization options. Select the desired options, then click OK. 

 

4. A placeholder will appear in your document (for example, «AddressBlock»). 
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5. Add any other placeholders you want. In our example, we'll add 

a Greeting line placeholder just above the body of the letter. 

 
6. When you're done, click Next: Preview your letters to move to Step 5. 
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For some letters, you'll only need to add an Address block and Greeting line. But you can also add 
more placeholders (such as recipients' names or addresses) in the body of the letter to personalize it 

even further. 

Step 5: 

1. Preview the letters to make sure the information from the recipient list appears 

correctly in the letter. You can use the left and right scroll arrows to view each version 

of the document. 

 

2. If everything looks correct, click Next: Complete the merge to move to Step 6. 
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Step 6: 

1. Click Print to print the letters. 

 

2. A dialog box will appear. Decide if you want to print All of the letters, the current document 

(record), or only a select group, then click OK. In our example, we'll print all of the letters. 

 

3. The Print dialog box will appear. Adjust the print settings if needed, then click OK. The 

letters will be printed. 
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Summary 

• Word is a word processor, created by Microsoft Corporation, US. 

• The word screen contains the title bar, Menu bar, Toolbars, Ruler and etc. 

• World 2013 presents a new user interface which is quite different than previous of word. 

• The word’s document views contains normal views, outline, print layout, web layout and 

print preview 

Keywords 

Mail Merge Tool: Word’s Mail Merge feature allows you to quickly create personalized 

correspondence and other documents by combining (merging) information from two different files.  

Self-Assessment 

1. What makes your document attractive? 

A. Text 

B. Picture 

C. Captions 

D. Bullets 

2. How to insert callouts to your document? 

A. Using shapes drop down list. 

B. Using mailing drop down list. 

C. Using table drop down list. 

D. None of these. 

3. Which tab to click when we want to insert pictures, tables and clip art? 

A. Mailing 

B. Layout 

C. Insert 

D. File 

Lab Exercise 

Open our practice document and practice recipient list and perform mail 

merge 
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4. What is CROP tool used for? 

A. To cut a picture 

B. To paste a picture 

C. To download picture 

D. To remove a picture 

 

5. What is a predefined text format? 

A. Shapes 

B. WordArt 

C. ClipArt 

D. Bookmark 

 

6. What happens when you click on Insert >> Picture? 

A. It inserts a picture into document. 

B. It lets you choose clipart to insert into document. 

C. It opens an option of adding picture as well as online picture taskbar. 

D. None of above 

 

7. Under the Illustrations ribbon which of this option is not available? 

A. Shapes 

B. Icons 

C. Smart Art 

D. Orientation 

8. If you want to draw a shape in your document, what steps you need to follow? 

A. Insert>> Shapes. 

B. Design>>Shapes 

C. Insert>> Picture>> Shapes. 

D. Not of these 

 

9. Find the odd on out in the shape categories. 

A. Lines 

B. Basic Shapes 

C. Flow chart 

D. Smart chart 

10. What is the name of the TOOLBAR that we must see BEFORE we can put in Word Art? 

A. View 

B. Standard 

C. Insert 

D. Mailing 

 

11. What does the icon for Word Art look like? 

A. A blue letter "A" 

B. A blue letter "W" 

C. A black letter "A" 

D. A black letter "W" 
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12. Which of the following do you use to change margins? 

A. Layout Menu    

B. Design Menu   

C. View Menu 

D. Reference’s menu 

13. By default, what is the page orientation of a word document? 

A. Landscape 

B. Portrait 

C. Envelope 

D. Letter 

 

14. What tab in MS Word you'll use to access Mail Merge options? 

A. Home tab 

B. Insert tab 

C. References tab 

D. Mailings tab 

 

15. _______ enables us to send the same letter to different persons. 

A. Macros 

B. Template   

C. Mail merge 

D. None 

Answers for Self-Assessment 

1. B 2. A 3. C 4. D 

5. B 6. C 7. D 8. A 

9. D 10. C 11. A 12. A 

13. B 14. D 15. C  

 

Further Reading 

 
Fundamental Computer Skills, Feng-Qi Lai, David R. Hofmeister 

 
http://books.google.co.in/bkshp?hl=en 
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CONTENTS 

Purpose and Objective 

Introduction 

8.1 CREATING A NEW DOCUMENT 

8.2 SAVING YOUR DOCUMENT 

8.3 What is a Workbook? 

8.4 Formatting 

8.5 Formatting Rows and Columns 

8.6 Functions in Formula 

8.7 Formulas and Functions 

Summary 

Keywords 

Self-Assessment 

Review Questions 

Answer for Self- Assessment 

Further Reading 

Purpose and Objective 

•   Discuss the starting of excel. 

•  Explain the excel window in worksheets.  

•  Discuss the creation of excel sheet and saving cash sheets in excel format. 

•  Discuss entering of data and explore number format. 

•  Explain the sort function and entering of dates. 

•  Explain cells and formality of cells.  

•  Discuss excel function, in date time, financial, logic, mathematical and 

trigonometric function. 

Introduction 

This application is one of the most useful tools to carry out most of the common scientific and 
statistical tasks in a faster way. The data once entered in to a worksheet can be manipulated to carry 

out many results and also using the same data or its output to plot a graph. This Application has a 
standard library of mathematical, scientific and statistical formulae and these facilities can be used to 

estimate the result. The following topics will describe how to use this application from first principles. 

Microsoft Excel is one of the most popular spreadsheet applications that helps you manage data, 
create visually persuasive charts, and thought-provoking graphs. Excel is supported by both Mac 

and PC platforms. Microsoft Excel can also be used to balance a checkbook, create an expense report, 

build formulas, and edit them. 

Bhanu, Lovely Professional University
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8.1 CREATING A NEW DOCUMENT 

Opening Microsoft Excel 

To begin Microsoft Excel, Go to Applications > Microsoft Excel (Figure 1). When opened a Dialogue 

box on the 

screen, showing you a few templates and blank excel sheets (Figure 2.) if this does not happen click 

File > New Workbook. 

 

Figure 2 Navigate to Microsoft Excel 

8.2 SAVING YOUR DOCUMENT 

Computers crash and documents are lost all the time, so it is best to save often. 

Saving Initially 

Before you begin you should save your document. To do this, go to File > Save As. Microsoft Excel 

will open a dialog box (Figure 3) where you can specify the new file’s name, location of where you 
want it saved, and format of the document. Once you have specified a name, place, and format for 

your new file, press the Save button. 

Note:  Specifying your file format will allow you to open your document on a PC as well as a Mac. 
To do this you use the drop down menu next to the Format option. Also, when you are specifying a 
file extension (i.e. .doc) make sure you know what you need to use. 

Figure 1 opening of a workbook 
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Figure 3 Saving a file dialog box 

Saving Later 

After you have initially saved your blank document under a new name, you can begin your project. 

However, you will still want to periodically save your work as insurance against a computer freeze 

or a power outage. To save, click File > Save 

Ribbon 

Microsoft Excel uses a ribbon toolbar to allow you to modify your document. Both Mac and Pc have 

the same ribbon toolbar. If you do not see these toolbars, or to open up other toolbars, go to View > 
Ribbon and place a checkmark by the toolbar you wish to open. Excel will also allow you to customize 

your toolbar by going to View > Customize Views. 

 

On Mac, there is grey toolbar (figure above) located at the top of the green ribbon that contains any 

extra functions that is not in the main Excel ribbon. On Pc, excel has all of its functions in the main 

ribbon.  

The Ribbon: (Figure 4). This toolbar contains tabs of Home, Insert, Page Layout, Formulas, Data, 

Review, and View.  Each tab serves a different purpose in customizing your document or having 

access to specific tools to help aid in whatever you are working on. 

 

Figure 4 standard tool bar 

The Formatting Palette: (Figure 5) is on the Home tab of the Ribbon. This palette contains icons for 

common formatting actions, such as Font Style, Font Size, Bold, Italic, Underline,  Alignment, 

Borders, Shading, Orientation, Gridlines, and Margins. 

 

Figure 5 Formatting Palette 

8.3  What is a Workbook? 

In Excel 2016, when we open up a new workbook, it now includes only one worksheet. There can be 

the max of 1,048,576 rows and 16,384 columns in an excel worksheet. 

Worksheet 

Excel files are known as workbooks. Each workbook hold one or more worksheets (also called a 

"spreadsheets")Whenever we create a new Excel workbook, it will include one worksheet named 

Sheet1. A worksheet is a framework of columns and rows where column are identified by letters 
running across the top of worksheet, and rows are identified by numbers running down the left side 

of the worksheet. 
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Figure 6 Worksheet 

When working with a high amount of data, we can create multiple worksheets to help organize our 
workbook and make it easier to find content. We can also group worksheets to quickly add data to 

multiple worksheets at the same time. 

To rename a worksheet 

Whenever we create a new Excel workbook, it will include one worksheet named Sheet1. We can 

rename a worksheet to reflect its content better. In this example, we will develop a training log 

organized by month. 

1. Right-click the worksheet we wish to rename, then select Rename from the worksheet menu. 

2. Type the desired name for the worksheet. 

 

3. Click anywhere outside of the worksheets, or press the Enter on our keyboard. The 

worksheet will be renamed. 

To insert a worksheet 

1. Locate and select the new sheet button. 
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2. A new, blank worksheet will occur. 

Note: To change the default number of worksheets, navigate to backstage 
view, click Options, and then choose the desired amount of worksheets 
to contain in each new workbook. 

 

8.4  Formatting 

Formatting the Spreadsheet 

The default page view for Microsoft Excel spreadsheets displays all gridlines and open up in portrait 

orientation. To change the gridlines, look at the fifth tab on the Formatting Palette, under Sheet 

uncheck the view box. This will eliminate any gridlines from the spreadsheet. To change the page 
orientation, look at the fifth tab on the Formatting Palette, under Orientation and check Landscape 

(Figure 7). 

 

Working with cells 

Cells are an important part of any project being used in Microsoft Excel. Cells hold all of the data that 

is      being used to create the spreadsheet or workbook. To enter data into a cell you simply click once 

inside of the desired cell, a green border will appear around the cell (Figure 9). This border indicates 

that it is a selected cell. You may then begin typing in the data for that cell. 
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Figure 7 Entering data 

Changing an Entry Within a Cell 

You may change an entry within a cell two different ways: 

• Click the cell one time and begin typing. The new information will replace any information 

that was previously entered. 

• Double click the cell and a cursor will appear inside. This allows you to edit certain pieces 

of information within the cells instead of replacing all of the data. 

Cut, Copy, and Paste 

You can use the Cut, Copy and Paste features of Excel to change the data within your spreadsheet, 

to move data from other spreadsheets into new spreadsheets, and to save yourself the time of re-

entering information in a spreadsheet. Cut will actually remove the selection from the original 
location and allow it to be placed somewhere else. Copy allows you to leave the original selection 

where it is and insert a copy elsewhere. Paste is used to insert data that has been cut or copied.  

To Cut or Copy: 

Highlight the data or text by selecting the cells that they are held within. 

Go to Edit > Copy (Command-X) or Edit > Cut  

Click the location where the information should be placed. Go to Edit > Paste  

Formatting Cells 

There are various different options that can be changed to format the spreadsheets cells differently. 

When changing the format within cells you must select the cells that you wish to format.  

To get to the Format Cells dialog box select the cells you wish to change then go to Format > Cells.  
A box will appear on the screen with six different tab options (Figure 8). Explanations of the basic 

options in the format dialog box are bulleted below. 
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Number:  Allows you to change the measurement in which your data is used. (If your data is 

concerned with money the number that you would use is currency) 

Alignment:  This allows you to change the horizontal and vertical alignment of your text within each 
cell. You can also change the orientation of the text within the cells and the control of the text within 

the cells as well. 

Font: Gives the option to change the size, style, color, and effects. 

Border:  Gives the option to change the design of the border around or through the cells.  

8.5 Formatting Rows and Columns 

When formatting rows and columns you can change the height, choose for your information to autofit 
to the cells, hide information within a row or column, un-hide the information. To format a row or 

column go to   Format > Row (or Column), or Home tab then format button for PC, then choose which 

option you are going to use (Figure 11). The cell or cells that are going to be formatted need to be 

selected before doing this. 

143



Office Automation Tools   

 

 

 LOVELY PROFESSIONAL UNIVERSITY  

 

 

Notes 

Adding Rows and Columns 

When adding a row or column you are inserting a blank row or column next to your already 

entered data. Before you can add a Row you are going to have to select the row that your wish for 
your new row to be placed in its place. (Rows are on the left hand side of the spreadsheet) once 

the row is selected it is going to highlight the entire row that you chose. To insert the row you 

have to go to Insert > Row (Figure 8 ). The row will automatically be placed on the spreadsheet 
and any data that was selected in the original row will be moved down below the new row.  

Another way is using the Insert in the Formatting Palette. 

 

 

 

Figure 9 Inserting Column and row 

 

Figure 8 Formatting Palette. 
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Before you can add a Column you are going to have to select a column on the spreadsheet that is 

located in the area that you want to enter the new column. (Columns are on the top part of the 
spreadsheet.) Once the column is selected it is going to highlight the entire row that you chose. To 

insert a column you have to go to Insert > Column (Figure 9). The column will automatically be place 

on the spreadsheet and any data to the right of the new column will be moved more to the right.  

8.6 Functions in Formula 

Many formulas you create use available worksheet functions. These functions enable you to greatly 

enhance the power of your formulas and perform calculations that are difficult if you use only the 

operators. For example, you can use the LOG or SIN function to calculate the Logarithm or Sin ratio. 

You can’t do this complicated calculation by using the mathematical operators alone. 

Using Functions 

When you type = sign and then type any alphabet you will see the searched functions as below. 

 

Suppose you need to determine the largest value in a range. A formula can’t tell you the answer 

without using a function. We will use formula that uses the MAX function to return the largest value 

in the range B3:B8 as =MAX(A1:D100). 
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Another example of functions. Suppose you want to find if the cell of month is greater than 1900 then 
we can give Bonus to Sales representative. The we can achieve it with writing formula with IF 

functions as =IF(B9>1900,"Yes","No") 

 

 

Function Arguments 

In the above examples, you may have noticed that all the functions used parentheses. The information 

inside the parentheses is the list of arguments. 

Functions vary in how they use arguments. Depending on what it has to do, a function may use.  

No arguments − Examples − Now(), Date(), etc. 

One argument − UPPER(), LOWER(), etc. 

A fixed number of arguments − IF(), MAX(), MIN(), AVERGAGE(), etc. 

Infinite number of arguments 

Optional arguments 

8.7 Formulas and Functions 

A formula is an expression which calculates the value of a cell. Functions are predefined formulas 

and are already available in Excel. 

For example, cell A3 below contains a formula which adds the value of cell A2 to the value of cell A1. 
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For example, cell A3 below contains the SUM function which calculates the sum of the range A1:A2. 

 

Enter a Formula: 

To enter a formula, execute the following steps: 

1. Select a cell. 

2. To let Excel know that you want to enter a formula, type an equal sign (=).  

3. For example, type the formula A1+A2. 

 

 

Change the value of cell A1 to 3. 

 

 

 

  
instead of typing A1 and A2, simply select cell A1 and cell A2. 
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Excel automatically recalculates the value of cell A3. This is one of Excel's most powerful features! 

Edit a Formula 

When you select a cell, Excel shows the value or formula of the cell in the formula bar. 

 

1. To edit a formula, click in the formula bar and change the formula. 

 

 

2. Press Enter. 

 

 

Operator Precedence 

Excel uses a default order in which calculations occur. If a part of the formula is in parentheses, that 

part will be calculated first. It then performs multiplication or division calculations. Once this is 

complete, Excel will add and subtract the remainder of your formula. See the example below. 
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First, Excel performs multiplication (A1 * A2). Next, Excel adds the value of cell A3 to this result. 

Another example, 

 

First, Excel calculates the part in parentheses (A2+A3). Next, it multiplies this result by the value of 

cell A1. 

Copy/Paste a Formula 

When you copy a formula, Excel automatically adjusts the cell references for each new cell the 

formula is copied to. To understand this, execute the following steps. 

1. Enter the formula shown below into cell A4. 

 

2a. Select cell A4, right click, and then click Copy (or press CTRL + c) 

 

..next, select cell B4, right click, and then click Paste under 'Paste Options:' (or press CTRL + v).  
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2b. You can also drag the formula to cell B4. Select cell A4, click on the lower right corner of cell A4 

and drag it across to cell B4. This is much easier and gives the exact same result! 

 

Result. The formula in cell B4 references the values in column B. 

 

Insert Function 

Every function has the same structure. For example, SUM(A1:A4). The name of this function is SUM. 

The part between the brackets (arguments) means we give Excel the range A1:A4 as input. This 
function adds the values in cells A1, A2, A3 and A4. It's not easy to remember which function and 

which arguments to use for each task. Fortunately, the Insert Function feature in Excel helps you with 

this. 

To insert a function, execute the following steps. 

1. Select a cell. 

2. Click the Insert Function button. 

 

The 'Insert Function' dialog box appears. 
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3. Search for a function or select a function from a category. For example, choose COUNTIF from the 

Statistical category. 

 

4. Click OK. 

The 'Function Arguments' dialog box appears. 

5. Click in the Range box and select the range A1:C2. 

6. Click in the Criteria box and type >5. 

7. Click OK. 

 

Result. The COUNTIF function counts the number of cells that are greater than 5. 

 

instead of using the Insert Function feature, simply type =COUNTIF(A1:C2,">5"). 

When you arrive at: =COUNTIF( instead of typing A1:C2, simply select the range 

A1:C2. 
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Functions 

Below is the list of some functions which are very helpful in excel. 

1 Count and Sum: The most used functions in Excel are the functions that count and sum. 

You can count and sum based on one criteria or multiple criteria. 

2 Logical: Learn how to use Excel's logical functions, such as IF, AND, OR and NOT. 

3 Cell References: Cell references in Excel are very important. Understand the difference 

between relative, absolute and mixed reference, and you are on your way to success. 

4 Date & Time: To enter a date, use the "/" or "-" characters. To enter a time, use the ":" 

(colon). 

5 Text: Excel has many functions to offer when it comes to manipulating text strings. 

6 Lookup & Reference: Learn all about Excel's lookup & reference functions, such as 

VLOOKUP, HLOOKUP, MATCH, INDEX and CHOOSE. 

7 Financial: This chapter illustrates Excel's most popular financial functions. 

8 Statistical: An overview of some very useful statistical functions in Excel. 

9 Round: This chapter illustrates three functions to round numbers in Excel. ROUND, 

ROUNDUP and ROUNDDOWN. 

10 Formula Errors: This chapter teaches you how to deal with some common formula errors. 

11 Array Formulas: This chapter helps you understand array formulas in Excel. Single cell 

array formulas perform multiple calculations in one cell. 

Most used functions 

Let's check out the 10 most used Excel functions. 

1. COUNT 

To count the number of cells that contain numbers, use the COUNT function in Excel.  
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Figure 10 Count function 

Note: use COUNTA to count all cells that are not empty. COUNTA stands for count all.  

2. SUM 

To sum a range of cells, use the SUM function in Excel. The SUM function below sums all 

values in column A. 

 

Note: you can also use the SUM function to sum an entire row. For example, =SUM(5:5) sums all 

values in the 5th row. 

3. IF 

The IF function checks whether a condition is met, and returns one value if true and another 

value if false. 

Explanation: if the score is greater than or equal to 60, the IF function shown above returns 
Pass, else it returns Fail. To quickly copy this formula to the other cells, click on the lower 

right corner of cell C2 and drag it down to cell C6. 
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4. AVERAGE 

To calculate the average of a group of numbers, use the AVERAGE function (no rocket 

science here). The formula below calculates the average of the top 3 numbers in the range 

A1:A6. 

 

Explanation: the LARGE function returns the array constant {20,15,10}. This array constant is used as 

an argument for the AVERAGE function, giving a result of 15. 

5. COUNTIF 

The COUNTIF function below counts the number of cells that contain exactly star + a series 

of zero or more characters. 

Explanation: an asterisk (*) matches a series of zero or more characters. Visit our page about 

the COUNTIF function for more information and examples. 

 

6. SUMIF 

The SUMIF function below sums values in the range B1:B5 if the corresponding cells in the 

range A1:A5 contain exactly circle + 1 character. 
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Explanation: a question mark (?) matches exactly one character. Visit our page about the 

SUMIF function for more information and examples. 

 

7. VLOOKUP 

The VLOOKUP function below looks up the value 53 (first argument) in the leftmost column 

of the red table (second argument). The value 4 (third argument) tells the VLOOKUP 

function to return the value in the same row from the fourth column of the red table.  

 

 

8. MIN 

To find the minimum value, use the MIN function. It's as simple as it sounds. 

 

9. MAX 

To find the maximum value, use the MAX function. 
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10. SUMPRODUCT 

To calculate the sum of the products of corresponding numbers in one or more ranges, use 

Excel's powerful SUMPRODUCT function. 

 

Explanation: the SUMPRODUCT function performs this calculation: (2 * 1000) + (4 * 250) + (4 * 100) 

+ (2 * 50) = 3500. 

 

Summary 

• Exploring the Excel Window, in which when we start working, we begin using work is called 

worksheet. 

•Creation of worksheet in which we can say the worksheet that worksheet is used for mummeries 

tasks. 

•Excel function must commonly use excel functions are used by grasped. 

Keywords 

Documents: A document is a work of non-fiction writing intended to store and communicate 

information, thus acting as a recording. Documents are often the focus and concern of business 
administration and government administration. The word is also used as a verb as “documenting” 

describes the process of making a document.  

Excel Worksheets: The worksheets are used for numerous tasks such as to collect and analyze 
information, including records, notes, activity budgets, professional organization information, data, 

financial reports, nutritional diaries, and legislative voting records. 

Format Cell: When you enter data into a cell in Excel, it is handled differently depending on what 
type of formatting you have assigned to the cell. For example, if you choose Currency formatting, 

Excel will automatically convert 3 into $3.00; if you choose Date formatting, Excel would convert 3/1 

to March 1, 2002; and if you choose Percent formatting, Excel would change 0.3 to 30%. 
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Self-Assessment 

1.Which of the following is a selected cell? 

A. current command 

B. default option 

C. active cell 

D. default cell 

2.Functions in MS Excel must begin with ___ 

A. An () sign 

B. An Equal Sign 

C. A Plus Sign 

D. A > Sign 

3.Which function in Excel checks whether a condition is true or not ? 

A. SUM 

B. IF 

C. COUNT 

D. AVG 

4.In Excel, Columns are labelled as ___ 

A. A, B, C, etc 

B. 1,2,3 etc 

C. A1, A2, etc. 

D. $A$1, $A$2, etc. 

5.You want to calculate the number of nonblank cells in your worksheet. Which function should be 

used? 

A. SUM 

B. COUNTA 

C. MAX 

D. MIN 

 

6. What is the intersection of a column and a row on a worksheet called? 

A. Column 

B. Value 

C. Address 

D. Cell 

7. ____ appear at the bottom of the Excel window. 

A. Title bar 

B. Formula bar 

C. Work sheet tabs 

D. Name box 

8. What are the basic rectangular building blocks of a spreadsheet? 
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A. Cells 

B. Zoom slider 

C. Help button 

D. All of these 

9. Which of the following is not a term pertaining to spreadsheets? 

A. Cell 

B. Character 

C. Browser 

D. Formula 

10. Excel is a program that is used to prepare a ______ 

A. Slide presentation 

B. Spreadsheet 

C. Text document 

D. Database 

11. This is not a function category in Excel. 

A. Logical 

B. Text 

C. Financial 

D. Data series 

12. Which of the following is a bar near the top of the Excel window where you can enter or edit cell 

entries or formulas? 

A. Cell pointer 

B. Column marker 

C. Fill handle 

D. Formula bar 

 

13. Each excel file is a workbook that contains different sheets. Which of the following cannot be a 

sheet in workbook? 

A. work sheet 

B. chart sheet 

C. module sheet 

D. data sheet 

14. Long text can be broken down into many lines within a cell. You can do this through___  

A. Wrap text 

B. Merge text 

C. Justify text 

D. None of these 

 

15. Which of these options are shown while formatting a cell? 

A. Number 

B. Alignment 

C. Protection 

D. All of the above 
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Review Questions 

1. What are some ways to use Excel? 

2. How many rows and columns are there in an excel? 

3. How many worksheets can an Excel workbook have? 

4. What is the difference between Microsoft Excel and Microsoft Word? 

5. What are the advantages of Microsoft Excel? 

6. How do you explain a Microsoft Excel? 

7. What do you mean by naming a cell? 

8. What are functions? 

 

Answer for Self- Assessment 

1. C 2. B 3. B 4. A 

5. B 6. D 7. C 8. A 

9. C 10. B 11. D 12. D 

13. D 14. A 15. D  

 

Further Reading 

  
https://bookboon.com/en/excel-ebooks 

  
https://www.javatpoint.com/excel-tutorial 
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Purpose and Objectives 

• Explanation of Graph and chart in Excel  

•  Understanding of Design corner  

•  Process of printing Excel sheet 

Introduction 

Excel is a Window-based spreadsheet created by Microsoft Corporation, US. It includes all standard 
features of a spreadsheet package like automatic recalculation, graphs, and functions. It also includes 

several advanced utilities like the facility to include other objects within a spreadsheet and pivot 

tables and form designing’. Excel can be used for a variety of applications. It is commonly used to 
automate financial statements, business forecasts, inventory control, and accounting. The package 

provides statistical, financial and scientific functions. Therefore, Excel can be used in many scientific 
and engineering environments to analyze numeric data. Excel is currently the best-selling Windows 

spreadsheet. 

9.1 Cell References 

Cell references in Excel are very important. Understand the difference between relative, absolute and 

mixed reference, and you are on your way to success. 

Relative References 

By default, Excel uses relative references. See the formula in cell D2 below. Cell D2 references (points 

to) cell B2 and cell C2. Both references are relative 

 

Bhanu, Lovely Professional University
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1. Select cell D2, click on the lower right corner of cell D2 and drag it down to cell D5.  

 

Cell D3 references cell B3 and cell C3. Cell D4 references cell B4 and cell C4. Cell D5 references cell 

B5 and cell C5. In other words: each cell references its two neighbors on the left.  

Absolute Reference 

1. To create an absolute reference to cell H3, place a $ symbol in front of the column letter and 

row number ($H$3) in the formula of cell E3. 

 

 

2. Now we can quickly drag this formula to the other cells. 
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The reference to cell H3 is fixed (when we drag the formula down and across). As a result, the correct 

lengths and widths in inches are calculated. 

Mixed References 

Sometimes we need a combination of relative and absolute reference (mixed reference). 

1. See the formula in cell F2 below. 

 

2. We want to copy this formula to the other cells quickly. Drag cell F2 across one cell, and 

look at the formula in cell G2. 

 

 

Do you see what happens? The reference to the price should be a fixed reference to column 

B. Solution: place a $ symbol in front of the column letter ($B2) in the formula of cell F2. In 

a similar way, when we drag cell F2 down, the reference to the reduction should be a fixed 

reference to row 6. Solution: place a $ symbol in front of the row number (B$6) in the formula 

of cell F2. 
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3. Now we can quickly drag this formula to the other cells. 

 

NOTE: we don't place a $ symbol in front of the row number of $B2 (this way we allow the 

reference to change from $B2 (Jeans) to $B3 (Shirts) when we drag the formula down). In a 

similar way, we don't place a $ symbol in front of the column letter of B$6 (this way we 

allow the reference to change from B$6 (Jan) to C$6 (Feb) and D$6 (Mar) when we drag the 

formula across). 

9.2 Working with Charts 

Charts are an important part to being able to create a visual for spreadsheet data. In order to create a 

chart within Excel the data that is going to be used for it needs to be entered already into the 

spreadsheet document. Once the data is entered, the cells that are going to be used for the chart need 
to be highlighted so that the software knows what to include. Next, click on the Charts Tab that is 

located right above the spreadsheet. Once it is clicked the tab will highlight green and all of the 

various charts within Excel will appear. 

 

You may choose the chart that is desired by clicking the icons that are displayed. Once the icon is 
chosen the chart will appear as a small graphic within the spreadsheet you are working on. To move 

the chart to a page of its own select the border of the chart and Ctrl > Click. This will bring up a drop 

down menu, navigate to the option that says Move Chart. This will bring up a dialog box that says 

Chart Location. 

From here you will need to select the circle next to As A New Sheet and name the sheet that will hold 

your chart. The chart will pop up larger in a separate sheet but in the same workbook as your entered 

data. 
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Chart Design 

 

There are various different features that you can change to make your chart more appealing. To be 

able to make these changes you will need to have the chart selected or view the chart page that is 

within your workbook. Once you have done that the Formatting Palette will change to show features 

that were not there before. These features include: 

Chart Options: 

Titles: Here you can change the Chart Title, Vertical Axis Title, and Horizontal Axis Title by clicking 
the drop down menu and selecting which one you will change and entering the name into the empty 

box below. 

Axes:  You may change which axes are shown on the charts graph and which are not.  

Gridlines: This feature allows you to change which gridlines (major and minor) are shown on the 

charts graph and which are not. 

Chart Style: 

Here you are able to change the color of the bars that are within your chart.  

Quick Styles and Effects: 

 Here you can add gradients, fill, drop shadows, and reflections to your chart depending on what is 

Charts and Graphs 

Charts and graphs are used to make information clearer and easier to understand. A good picture is 

worth a thousand numbers. The most common place for people to see charts and graphs is in the 
news. News publishers use graphics all the time to show comparisons and explain important trends 

for things such as weather, gas prices, crime rate, or who is winning an election and by how much. 

Charts and graphs are also critical to engineers, scientists and financial analysts who use them to help 
visualize large amounts of information, make better decisions, and communicate their results to other 

people. 

There are good reasons for learning to create graphs by hand, but there are also some great tools that 
everyone ought to learn how to use at some point, such as Excel. The purpose of this article is to 

highlight some of the common types of graphs and charts that you can create with Excel, explain 

when you might use the different types, and provide a great set of resources for learning about and 

teaching about charts and graphs. 

Bar Graphs 

A bar graph is a graph that shows you information about two or more discrete objects, events, 
locations, groups of people, etc. You can use the bar graph to make comparisons. For example, if you 

count the number of students in your class who are girls and the number who are boys, you could 

make a bar graph to compare the totals. One bar would represent the number of boys, and another 

bar would represent the number of girls. 

 

Figure 1 Example of a bar graph created with Excel. 
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A column chart in Excel is just a bar graph where the bars are displayed as columns. Instead of the 
labels or categories listed on the left, they are listed on the bottom. The example below shows how 

you can set up the data table for creating a column chart showing the number of apples eaten in a 

particular month. 

Figure 2 Example of a column chart created using Excel 

Line Graphs 

A line graph is great for showing continuous change over time. For example, you could use a line 

graph to watch the changes in temperature in the month of March. If it is hotter one day than on the 
day before, the line will go up. If it is cooler, it will go down. By analyzing the line graph, you can 

get a better idea of the changes that took place as time went on. You can also easily determine when 

the value you are graphing was highest or when it was lowest. Including 2 lines on the same graph 
lets you visualize comparisons, such as the difference between the High and Low temperatures for 

each day. 

Figure 3 Example of a line graph in Excel 

You can create a line graph from the same data table as a bar graph, and vice versa. But, what you 
decide to use should largely depend upon whether you are showing how something changes over 

time (line graph) or showing comparisons between discrete things (bar graph). 

It is important to be aware of color choices when using graphs. People often associate meanings with 
different colors, such as red for hot and blue for cold, so in the example above it could be confusing 
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if the colors of the lines were switched. It makes more sense for red to be used for the High 

temperature and blue to be used for the Low temperature. 

Pie Charts 

A pie chart is a circular graph where the pieces of the pie are used to represent a percentage of a 

whole. For example, if you took a survey of the students in your class and asked them each about 
their favorite pizza, you could use the results to make a pie chart that would show what toppings 

earned the most votes. In this case, each triangle would represent a different topping. The triangle 
with the largest area would represent the topping that got the most votes, while the toppings that got 

the least votes would be represented by smaller triangles. 

 

Figure 4 Example of a pie chart in Excel 

In the example above, it is pretty easy to see that Pepperoni was the favorite. It is also easy to see that 

Pepperoni received the same amount of votes as all of the others combined. That would not be as 
easy to see if you were just staring at the numbers in the table. One problem with a pie chart is that 

it can take up a lot of space to show only a little bit of information. 

Another major problem with pie charts is making comparisons between a lot of different things, and 
especially when you have a lot of little slices. To help with that, Excel provides a "Bar of Pie" graph 

that breaks out some of the pieces into a separate stacked bar graph like in the example below. 

Figure 5 Example of a "bar of pie" graph in Excel 

People already have a hard time comparing sizes of areas when they are fairly close in size. But, it is 

even harder when the areas are different shapes. If you tried to compare Sausage and Bacon in the 

above example (without using the data table), you could end up coming to an incorrect conclusion. 
Can you tell why? Is the Sausage slice larger or smaller than the Bacon? Without the numbers to help 

you, you probably couldn't tell for sure. In fact, the Sausage received 3 votes and the Bacon only 
received 2. It turns out that the sizes of the rectangles can only be compared within the stacked bar 
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the difficulty between comparing rectangles and pie slices, but also because the total area of the 

stacked bar chart is not the same as the total area of the "Other" slice from which it was taken. 

Area Charts 

An area chart or area graph combines some of the characteristics of line graphs with the 
characteristics of bar graphs. It looks like a line graph with shading underneath the line. Sometimes, 

the shading can help add meaning to a line graph. For example, if a line graph represented the height 
of water in a reservoir over time, shading the area under the line could make the line graph look like 

actual water rising and falling. 

Stacked area charts and stacked column charts provide a way to compare differences or proportions 
over time or between different locations or groups of people. The height of each of the areas as well 

as the total height of all the areas may change over time. If you had a series of pie charts that 

compared the same items from month to month, all of that information could be displayed in a single 
area chart. For example, let's say that a teacher offered the same pizza topping survey to each of her 

classes over a period of 10 years. You can display that information as an area chart like the image 

below. 

 

Figure 6 Example of a stacked area chart in Excel 

This type of area chart is time-based (same survey offered year after year), but it's not truly 

continuous because the class stays the same throughout the entire year. So, this is a case where it 
might be more appropriate to show the graph as a stacked column chart (see below) which will depict 

the results as discrete events. Everything about the data table and the graph is pretty much the same. 

All you have to do is change the chart type. 

 

Figure 7 Example of a stacked column chart in Excel 

XY Graph (Scatter Plot) 

An X-Y graph, also called a coordinate graph or scatter plot, is a graph that shows different ordered 
pairs on an X-Y axis (Cartesian coordinate system). X-Y graphs are used to look at and find patterns 

in sets of data and to plot mathematical formulas. The points on the graph may form a straight line 

or a curved line, and may be connected with a line. Unlike bar graphs and line graphs, the line in an 
X-Y graph can curve back on itself, forming complex patterns such as the spirograph shown on the 
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right. In some cases, the points may not form a line at all. They might just be shown as a bunch of 

random dots scattered all over the place (thus the name). 

To plot a point on graph paper, you first need to draw the coordinate system and then you simply 

find the point's x-coordinate, move straight up or down the line to its y-coordinate, and draw a point. 
To create a scatter plot in Excel, you first create a simple table with one column for listing the X-

coordinates and a second column for the Y-coordinates, select the data table, then insert the scatter 

chart by choosing it from a menu. 

 

Figure 8 Example of a scatter plot in Excel 

9.3  Page Orientation 

Excel offers two page orientation options: landscape and portrait. Landscape orients the page 

horizontally, while portrait orients the page vertically. Portrait is especially helpful for worksheets 
with a lot of rows, while landscape is best for worksheets with a lot of columns. In the example below, 

portrait orientation works best because the worksheet includes more rows than columns. 

Figure 9 Page Orientation 
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1. Click the Page Layout tab on the Ribbon. 

2. Select the Orientation command, then choose either Portrait or Landscape from the 

drop-down menu. 

 

3. The page orientation of the workbook will be changed. 

To format page margins: 

A margin is the space between your content and the edge of the page. By default, every workbook's 

margins are set to Normal, which is a one-inch space between the content and each edge of the page. 
Sometimes you may need to adjust the margins to make your data fit more comfortably on the page. 

Excel includes a variety of predefined margin sizes. 

1. Click the Page Layout tab on the Ribbon, then select the Margins command. 

2. Select the desired margin size from the drop-down menu. In our example, we'll 

select Narrow to fit more of our content on the page. 
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3. The margins will be changed to the selected size. 

To include Print Titles: 

If your worksheet uses title headings, it's important to include these headings on each page of your 

printed worksheet. It would be difficult to read a printed workbook if the title headings appeared 
only on the first page. The Print Titles command allows you to select specific rows and columns to 

appear on each page. 

1. Click the Page Layout tab on the Ribbon, then select the Print Titles command. 

 

             

2. The Page Setup dialog box will appear. From here, you can choose rows or 

columns to repeat on each page. In our example, we'll repeat a row. 

3. Click the Collapse Dialog button next to the Rows to repeat at top: field. 

4. The cursor will become a small selection arrow and the Page Setup dialog box 

will be collapsed. Select the row(s) you want to repeat at the top of each 

printed page. In our example, we'll select row 1. 
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5. Row 1 will be added to the Rows to repeat at top: field. Click the Collapse 

Dialog button again. 

6. The Page Setup dialog box will expand. Click OK. Row 1 will be printed at the 

top of every page. 

 

To insert header and footers 

You can make your workbook easier to read and look more professional by including headers and 

footers. The header is a section of the workbook that appears in the top margin, while the footer 
appears in the bottom margin. Headers and footers generally contain information such as page 

number, date, and workbook name. 

1. Locate and select the Page Layout view command at the bottom of the Excel 

window. The worksheet will appear in Page Layout view. 

2. Select the header or footer you want to modify. In our example, we'll modify 

the footer at the bottom of the page. 

 

 

171



Unit 9: MS Excel, Printing   

 LOVELY PROFESSIONAL UNIVERSITY  

Notes 

3. The Header & Footer Tools tab will appear on the Ribbon. From here, you can 

access commands that will automatically include page numbers, dates, and 

workbook names. In our example, we'll add page numbers. 

 

4. The footer will change to include page numbers automatically. 

 

 

 

 

 

 

 

 

 

9.4 Pivot Tables 

A pivot table is essentially a dynamic summary report generated from a database. The database can 
reside in a worksheet (in the form of a table) or in an external data file. A pivot table can help 

transform endless rows and columns of numbers into a meaningful presentation of the data. Pivot 

tables are very powerful tool for summarized analysis of the data. 

Pivot tables are available under Insert tab » PivotTable dropdown » PivotTable 

Our data set consists of 213 records and 6 fields. Order ID, Product, Category, Amount, Date and 

Country. 

 

Insert Pivot Table 

To insert a pivot table, execute the following steps. 

  

Open an existing worksheet change the orientation to landscape, try modifying the 
margins, try using print title command by adding row and column on each page of 

your workbook and insert Header and Footer. 
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2. On the Insert tab, in the Tables group, click PivotTable. 

 

The following dialog box appears. Excel automatically selects the data for you. The default location 

for a new pivot table is New Worksheet. 

3. Click OK. 

 

Drag Fields 

The PivotTable Fields pane appears. To get the total amount exported of each product, drag the 

following fields to the different areas. 

1. Product field to the Rows area. 

2. Amount field to the Values area. 

3. Country field to the Filters area. 
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Below you can find the pivot table. Bananas are our main export product. That's how easy pivot 

tables can be! 

Sort 

To get Banana at the top of the list, sort the pivot table. 

1. Click any cell inside the Sum of Amount column. 

2. Right click and click on Sort, Sort Largest to Smallest. 

 

Result: 

 

9.5 Data Validation  

Excel Data Validation is a feature that restricts (validates) user input to a worksheet. Technically, you 

create a validation rule that controls what kind of data can be entered into a certain cell. 

Here are just a few examples of what Excel's data validation can do: 

• Allow only numeric or text values in a cell. 

• Allow only numbers within a specified range. 

• Allow data entries of a specific length. 

• Restrict dates and times outside a given range. 

• Restrict entries to a selection from a drop-down list. 

• Validate an entry based on another cell. 

• Show an input message when the user selects a cell. 

• Show a warning message when incorrect data has been entered. 

• Find incorrect entries in validated cells. 
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In this example, we restrict users to enter a whole number between 0 and 10. 

 

Create Data Validation Rules 

To create the data validation rule, execute the following steps. 

1. Select cell C2. 

2. On the Data tab, in the Data Tools group, click Data Validation. 

 

On the Settings tab: 

3. In the Allow list, click Whole number. 

4. In the Data list, click between. 

5. Enter the Minimum and Maximum values. 

 

 

Input Message 

Input messages appear when the user selects the cell and tell the user what to enter. 

On the Input Message tab: 

1. Check 'Show input message when cell is selected'. 

2. Enter a title. 

3. Enter an input message. 
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Error Alert 

If users ignore the input message and enter a number that is not valid, you can show them an error 

alert. 

On the Error Alert tab: 

1. Check 'Show error alert after invalid data is entered'. 

2. Enter a title. 

3. Enter an error message. 

 

4. Click OK. 

Data Validation Result 

1. Select cell C2. 
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Result: 

 

 

9.6  What-If Analysis 

What-If Analysis in Excel allows you to try out different values (scenarios) for formulas. The 

following example helps you master what-if analysis quickly and easily. 

Assume you own a book store and have 100 books in storage. You sell a certain % for the highest 

price of $50 and a certain % for the lower price of $20. 

 

If you sell 60% for the highest price, cell D10 calculates a total profit of 60 * $50 + 40 * $20 = $3800.  

Create Different Scenarios 

But what if you sell 70% for the highest price? And what if you sell 80% for the highest price? Or 90%, 

or even 100%? Each different percentage is a different scenario. You can use the Scenario Manager to 

create these scenarios. 

Note: You can simply type in a different percentage into cell C4 to see the corresponding result of a 

scenario in cell D10. However, what-if analysis enables you to easily compare the results of different 

scenarios.  

1. On the Data tab, in the Forecast group, click What-If Analysis. 

 

2. Click Scenario Manager. 

 

The Scenario Manager dialog box appears. 
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3. Add a scenario by clicking on Add. 

 

4. Type a name (60% highest), select cell C4 (% sold for the highest price) for the Changing 

cells and click on OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Enter the corresponding value 0.6 and click on OK again. 

 

 

 

 

 

 

 

 

6. Next, add 4 other scenarios (70%, 80%, 90% and 100%). 

Finally, your Scenario Manager should be consistent with the picture below: 

178



Office Automation Tools  

 LOVELY PROFESSIONAL UNIVERSITY  

Notes 

 

Goal Seek 

What if you want to know how many books you need to sell for the highest price, to obtain a total 

profit of exactly $4700? You can use Excel's Goal Seek feature to find the answer. 

1. On the Data tab, in the Forecast group, click What-If Analysis. 

 

2. Click Goal Seek. 

 

 

 

 

The Goal Seek dialog box appears. 

3. Select cell D10. 

4. Click in the 'To value' box and type 4700. 

5. Click in the 'By changing cell' box and select cell C4. 

6. Click OK. 

 

Result. You need to sell 90% of the books for the highest price to obtain a total profit of exactly $4700. 

  

Note: to see the result of a scenario, select the scenario and click on the Show button. Excel 

will change the value of cell C4 accordingly for you to see the corresponding result on the 

sheet. 
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9.7  Printing 

To print your document, go to File > Print, select your desired settings, and then click Print. It is also 

possible to print by using the Print icon on the Standard toolbar, however this does not bring up the 

Print dialogue box that allows you to change your printing options, so it is advisable to use the other 

method. 

 

To be able to change the orientation of your page for printing you can click on the Page Setup button 

under the option to Print. 

Summary 

• Pivot tables: Using this feature, the user can view the data in summarized table form.  

•  Advanced analytical tools: Goal seeking, a powerful Solver feature, and the analysis 

ToolPak add-in features, provides extensive statistical, financial, engineering, and scientific 

functions and procedures. 

• Great charts: Excel’s charting features enable the user to modify and augment a wide 

assortment of graph types. 

 Self- Assessment 

1. There are three types of cell references. Relative and Mixed are two of them. What is the 

third? 

A. Static 

B. Solid 
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D. None of these 

 

2. Which of the following is an absolute cell reference? 

A. !A!1 

B. $A$1 

C. #a#1 

D. A1 

3. A visual representation of worksheet data. 

A. Column 

B. Data 

C. Chart 

D. Legend 

 

4. Under which ribbon menu or tab will you find the chart type commands? 

A. File 

B. Data 

C. Insert 

D. Charts and Graphs 

 

5. You want to track the progress of the stock market on a daily basis. Which type of chart 

should you use? 

A.  Pie chart 

B.  Row chart 

C.  Line chart 

D. Column chart 

6. The chart wizard term data series refers to_______ 

A. A chart legend 

B. A collection of chart data markers 

C. A set of values you plot in a chart. 

D. A data label. 

 

7. The Chart wizard term data categories refers to; 

A.  A chart plot area 

B.  A horizontal axis 

C.  The organization of individual values with a chart’s data series 

D.  The data range that supply chart data. 

 

8. Page layout view displays 

A.  the page in normal view 

B.  pages exactly as they will appear when printed. 

C.  preview of where pages will break when printed. 

D. none of the above 

 

9. Sheet properties include_________ 

A. sheet size 
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B. title 

C. categories 

D. all of the above 

 

10. Portrait and Landscape are two types of what? 

A. Arrangements 

B. Orientation 

C. Margins 

D. Page Breakas 

 

11. What dialog box allows you to change a field name in a PivotTable? 

A. Field Options 

B. Field Pane 

C. Field Settings 

D. Field Structure 

12. Under which tab and in which function group will you find the option to insert a Pivot 

Table? 

A. Under the Insert tab in the Tables group or Pivot table menu 

B. Under the Formulas tab in the Data Analysis group. 

C. In the Data group in the Pivot Tables group 

D. In the Data group in the Tables group 

 

13. Which of the following is NOT a box in the PivotTable Fields List? 

A. Column Labels 

B. Report Filter 

C. Values 

D. Formulas 

 

14. Excel is a good application for What IF analysis. Which of the following tool help you for 

this? 

A. Formul Auditing      

B. Research 

C. Trach Change 

D. Goal Seek 

15. To apply Goal Seek command your cell pointer must be in___ 

A. The Changing cell whose value you need to find. 

B. The Result Cell where formula is entered. 

C. The cell where your targeted value is entered. 

D. None of the above 

 Review Questions 

1. How will you make the cell address in a formula absolute? 

2. How is relative addressing different from absolute addressing?  

3. Discuss the different kinds of errors that could occur while working in Excel.  

4. Briefly explain the AutoSum tool available in Excel. 

5. What are Excel Headers and Footers?  
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7.  

Answer for Self-Assessment 

1. C 
2. B 3. C 4. C 

5. C 
6. B 7. B 8. C 

9. D 
10. B 11. C 12. A 

13. D 
14. D 15. B  

 

Further Reading 

 
https://bookboon.com/en/excel-ebooks 

 
https://www.javatpoint.com/excel-tutorial 
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UNIT 10: MS PowerPoint 

CONTENTS 

Purpose and Objectives 

Introduction 

10.1 What is a PowerPoint? 

10.2 PowerPoint 2016 Editing Window (Normal View) 

10.3 PowerPoint Slide 

10.4 Applying a Theme 

10.5 TEXT 

10.6 Saving a Presentation 

Summary 

Keywords 

Self-Assessment 

Review Questions 

Answers for Self-Assessment 

Further Readings 

Purpose and Objectives 

• Explanation of starting of MS PowerPoint . 

•  Understand the starting power point slides. 

•  Process of applying different color schemes  

• Explain enhancing text in MS PowerPoint. 

Introduction 

MS PowerPoint is a very powerful means of making an effective presentation. lt generates 
presentation slides rich in graphics Audio and Video. The slides generated on power point can be 
played on a PC or their print-outs cab be projected on an over head projector. When played on a PCit 
works more like a web-page in an easy-to-move-around way. The slides generated in PowerPoint are 
stored in files of extension <.ppt>. There are, although. Various way to create a PowerPoint 
presentation e.g. generate the slides from MS Word or MS Excel and develop a presentation from 
PowerPoint itself. Microsoft PowerPoint is one of the most popular presentation programs supported 
by both Mac and PC platforms. Microsoft PowerPoint can be used to create interactive presentations 
for classroom, business, or personal use. 

10.1 What is a PowerPoint? 

PowerPoint is a graphical presentation program used to organize and presentinformation. PowerPo
int presentations consist of a number of individual pages or "slides.” Slides may contain text, graphi
cs, sound, movies, and other objects that can be freely arranged.  

 
Presentations can be printed, displayed live on a computer, or navigated through at the command o
f the presenter. For larger audiences, the presentation is often projected onto 
a large screen. Handouts, speaker notes, or outlines can also be produced from the slides.  

10.2 PowerPoint 2016 Editing Window (Normal View)  

The Normal View in PowerPoint features several commonly used Tabs, Panes, and Tools. We’ll use
 Normal View as we create and design our presentation.  

Bhanu, Lovely Professional University
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The Ribbon 

The Ribbon replaces the menu bar seen in previous versions of PowerPoint. The Ribbon groups ite
ms that are most likely to be used together. There are several frequently used 
tabs, such as File, Home, Insert, Design and View. Clicking on each tab activates a group 
of relative commands, menus, and buttons. There are also contextual tabs that only show 
up only when needed, such as Text Box Tools, Picture Tools, Drawing Tools and Chart 
Tools. To activate those tools, click on the associated object.  

 

Figure 1 The Ribbon 

Microsoft PowerPoint uses several tabs to allow you to modify your document. When you first open 
PowerPoint, usually the tabs discussed below will open. If you do not see these tabs, go to View > 

Ribbon. 

The Menu bar: (Figure 2). This is constructed solely of word commands and not icons (pictures). The 
Menu bar contains all the options available to you in Microsoft PowerPoint. 

 

Figure 2 The Menu bar 

On the Ribbon under the Home Tab, contains a text editor and the new slide icon. The Home Tab 
contains icons such as Paste, Cut, Copy, Format and Layout (Figure 3). 

Figure 3 Home Tab 

The Insert Tab on the Ribbon toolbar contains several categories for formatting the design and 
elements of your presentation. These include: New Slide, Table, Charts, and Word Art(Figure 4) 

 

Figure 4 Insert Tab 
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Opening a PowerPoint 

To open a PowerPoint 2016 presentation, click on the File tab in the upper left corner.  

 

The most common choices for opening a presentation are:  

• New ‐ allows you to open a Blank presentation or you may choose from a selection of Tem

plates and Themes.  

• Open ‐ lets you navigate to an existing file to view and/or modify a presentation that has 

already been created.  

• Recent – displays a list of your most recently created presentations and their file locations.  

Creating New Presentation 

The New selection gives you several options:  

• Blank presentation creates a new presentation using default settings for text and colo

r. Theses slides will not include content or design elements.  

• Templates and Themes are used to create a new presentation based on predesigned s

lide styles. These options also do not include content.  

• New from existing will use the formatting of a previously created presentation.  

For this exercise, we’ll start with a Blank presentation. Select New,choose Blank 
presentation and click on the Create icon.  

 

10.3 PowerPoint Slide 

When you choose to create a blank presentation, PowerPoint will open a presentation 
with a Title Slide. Once the Title Slide is open, you’ll see a slide with two placeholder text 
boxes for a title and a subtitle. Click inside the placeholder box and type to add the title. 
If you want a subtitle, click and type inside the smaller placeholder. If you don’t want a 
subtitle, you can just ignore its placeholder box. 
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To add a New Slide, make sure you’re on the Home tab. The New Slide button will add 
slides to your presentation.  

 

The New Slide button has two parts:  

Clicking on the top part will automatically insert a new slide. If you have just created a Title slide, t
he new default layout will be a Title and Content slide (for 
details, see the section on slide layouts).  

Clicking on the bottom will give you a choice of layouts. You can choose which 
layout you want for your next slide. Select a slide layout by clicking on its image in the Office The

me gallery.  

Slides Layout 

There are several standard slide layouts to choose from when adding new slides. 
A unique layout can be chosen by clicking on the bottom half of the New Slide button in the Home 
tab. When the layout gallery opens, click on the style you want and a new slide with that layout wil
l appear in your presentation. Each layout caption describes the layout type. Content can be text, ta
bles, charts,graphics, pictures, clip art, or video.  If you decide later that the layout you choose 
doesn’t work well for a particular slide, select the slide by clicking on it in the 
Thumbnail pane. Next, click on the Layout button in the Slides group of the Home tab.  

Click on a new layout and it will change the layout of the slide.  
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10.4 Applying a Theme 

Once a new presentation has been created, a design or color scheme can be added. 
Remember to use color carefully to enhance your presentation, not detract from it. You will want to 
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maintain good contrast between the background color and the text color. 
Consider using a light colored background and dark text (or vice versa), but avoid busy 
backgrounds and primary colors. Use sans serif fonts like Arial, Calibri, and Helvetica for titles and 
size them between 44 – 60 points. Subheadings should be between 32 – 40 points, and body text bet
ween 18 – 32 points. Try not to use more than two fonts. PowerPoint has many preset designs and t
hemes that include complimentary colors and 
fonts. To add a theme to a presentation, go to the Design tab in the ribbon. There are 
several themes immediately available. To use one of the built‐in themes, just click on its thumbnail. 

 

On the right side of the Theme thumbnails, there’s a scroll bar and an Arrow Down 
button, which will offer more designs, as seen below. If you’re online, you can get more 
themes from Microsoft Office Online. (Your office program must be a genuine Office 
product to get online templates).  

 

If you don’t want to use a theme, you can add Background Styles.  

From this selection, 
you can add some preset background styles that change according to the colors you’ve chosen. 

 

Using the Format Background feature, you can choose fill colors, 
gradients, transparencies, textures, or pictures for your background.When you have the desired bac
kground fill effect, select Close to apply it to the selected slide or choose Apply to All to add the 
background to all of the slides in the presentation. Designs can be added to all of the slides or to sel
ected slides. To select multiple slides, click on a slide in the Thumbnail pane of the 
navigation bar and then hold down the control key and click on any 
other slides you want to apply the design to.  
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10.5 TEXT 

Formatting Bulleted List 

In PowerPoint, you can easily modify a slide’s default bulleted list. Click inside the text 
box, and the Format tab will automatically be highlighted. Click on the drop down triangle 
next to the Bullets button in the Paragraph group.  

 

From the Bullets and Numbering menu you can make various changes to your list:  

• The bullet size relative to the text  

• The color of the bullet  

• The shape of the bullet using either a picture or a character.   

You may also want to adjust line spacing 

between paragraphs or lists. You can do thisthrough the Paragraph group of tools by 

clicking the Line Spacing button and selecting Line Spacing Options. Indents and Spacing 

controls will open in a separate dialog box.  
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 Task 

Give the steps for adding the Power point wizard and add bullets and numbering 
to it by using any built in template. 

 

 

10.6 Saving a Presentation 

You can save a file by clicking the File tab, choosing Save, typing a descriptive name into 
the File Name window, and then clicking the Save button. 

 

If others will need to open your file with previous versions of 
PowerPoint, use the Save As option and select PowerPoint 97 – 2003 
Presentation from the Save as type menu. 

Save and Send to Others  

If you need to send your presentation to someone else, the best way to is to use the Save & Send 
option. You can send an attachment of your file using Send Using Email, but if you have large media 
files, such as videos, you’ll need to compress those first to make a smaller file. On the Home 
Select the Info tab and click the Compress Media button and choose Presentation Quality. Note: 
Only available if you have inserted media.   
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You also have the option to Package Presentation for CD. 
This allows you to add other files or to add a PowerPoint Viewer so that the presentation can be ru
n on a computer 
that does not have the PowerPoint program. You can also add any linked files such as 
video or audio. 

Summary 

• PowerPoint is a powerful presentation package of Microsoft. 

• Power point’s build in templates can used as the basis for the presentation. 

Keywords 

Blank presentation: From the General tab select Blank Presentation to build the 
presentation from scratch with no preset graphics or formatting. Or else select Open. 

Auto layout: After selecting the presentation type, it will prompt to choose the layout of the 
new slide. These layouts include bulleted lists, graphs and/or images. 

 Lab Exercise 

Explain different ways to view slides in PowerPoint. 

Self-Assessment 

1. Material consisting of text and numbers is best presented as______ 

A. A table slide 

B. A bullet slide 

C. A title slide 

D. All of the above 

 

2. From which menu you can access Picture, text box, chart etc? 

A. File 

B. Edit 

C. Insert 

D. View 

 

3. Which of the following should be used when you want to add a slide to an existing 

presentation? 

A. File, add a new slide 

B. Insert, New slide 

C. File Open 
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D. File, New 

4. In which menu can you find features like Slide themes, Slide variants etc.? 

A. Insert Menu 

B. Format Menu 

C. Tools Menu 

D. Design Menu 

5. _____ is a presentation program. 

A. U-torrent 

B. Mozilla Firefox 

C. MS PowerPoint 

D. Slide Panel 

6. In PowerPoint, the header and footer button can be found on the insert tab in what group? 

A. Tables group 

B. Text group 

C. Object group 

D. Illustrations group 

7. The slide that is used to introduce a topic and set the tone for the presentation is called 

the_______ 

A. Title slide 

B. Bullet slide 

C. Table slide 

D. Graph slide 

8. Which tab is not available on left panel when you open a presentation? 

A. Outline 

B. Slides 

C. Notes 

D. All of above are available. 

9. Which of the following statements is not true? 

A. You can type text directly into a PowerPoint slide but typing in text 

box is more convenient. 

B. From Insert menu choose Picture and then File to insert your 

images into slides. 

C. You can view a PowerPoint presentation in Normal, Slide Sorter or 

Slide Show view. 

D. You can show or hide task pane from View >> Toolbars 

10. PowerPoint presentations are widely used as ______ 

A. note outlines for teachers. 

B. project presentations by students 

C. communication of planning 

D. All of above 

11. A new presentation can be created from_______ 

A. Blank Presentation 

B. From Existing Presentation 

C. From Design Template 

D. All of above 
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12. What lets you to create new presentation by selecting readymade font color and graphics 

effects? 

A. Presentation Template 

B. Master Slide 

C. Design Template 

D. Animation Scheme 

13. Which short cut key inserts a new slide in current presentation? 

A. Ctrl+N 

B. Ctrl+S 

C. Ctrl+V 

D. Ctrl+X 

14. Which of the following method can insert a new slide in current presentation? 

A. Right click on the Slide panel and choose New Slide. 

B. From Insert menu choose New Slide 

C. Click on New Slide button on toolbar. 

D. All of above. 

15. What is the best way to create another copy of a slide? 

a. Click the slide then press Ctrl+A and paste in new slide. 

b. From Insert Menu choose Duplicate Slide 

c. Redo everything on a new slide that you had done on previous Slide. 

d. None of above 

Review Questions 

1. What is MS PowerPoint? 

2. How can you run a presentation? Write down the steps. 

3. Explain the steps of creating a new presentation and saving it. 

Answers for Self-Assessment  

1. B 2. C 3. B 4. D 5. C 

6. B 7. A 8. C 9. A 10. D 

11. D 12. C 13. A 14. D 15. B 

 

Further Readings 

  

 

A Study of Computer Fundamental, Shu-Jung Yi. 

  

 

http://books.google.co.in/bkshp?hl=en 
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Unit 11: MS PowerPoint 

CONTENTS 

Objectives 

Introduction 

12.1  PowerPoint view 

12.2  Adding Auto shapes and Flowcharts 

12.3 Transitions and Multimedia 

12.4  Adding Transition between Slides 

12.5  Slide Show 

12.6  Adding audio content to slides 

Summary 

Self- Assessment Questions 

Review Questions 

Answers for Self-Assessment 

Further Reading 

Objectives 

• Understand graphics.  

•  Explain the auto shapes. 

•  Understand the printing presentation.  

•  Explain the process of adding multimedia content. 

Introduction 

PowerPoint supports multiple views to allow users to gain the maximum from the features available 

in the program. Each view supports a different set of functions and is designed accordingly.  

PowerPoint views can be accessed from two locations: 

• Views can be accessed quickly from the bottom bar just to the left of the zoom settings.   
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• Views can also be accessed from the Presentation Views section in the View ribbon 

 

11.1 PowerPoint view 

PowerPoint provides you several views to look through your presentations. Each of these views is 

discussed in detail here. The view buttons are available at the lower left corner of the screen. The 

group of four buttons located to the left of the Zoom control, near the bottom of the screen, lets you 

switch between PowerPoint views. 

 

Figure 1 View Dialog Box 

Normal View 

Normal view is the most common view available to you. It is the default view of PowerPoint. It 

displays slide contents in the left pane while the present slide is displayed in the right pane. It shows 
a combination of slide, outline, and notes page views. This view is helpful when one has to work in 

multiple areas at once; add text in outline and see how it appears on the slide; type the notes that will 

remain with the current slide. 

Step 1: Select the slide to be moved. 

Step 2: Left click on the slide and drag it to the position in the sequence where you want to place it. 

PowerPoint will indicate the insert position with a line in-between existing slide. 
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Step 3: When you get to the right position release the left click button to insert the slide. Alternately 

you can also cut the selected slide and paste it back in the sequence as shown below. 

 

 

Outline View 

This view allows for you to change the order of the slides in which they appear(Figure 2). To do this 

click the desired slide and drag. Once you start dragging a grey line will appear. Drag the slide up 

or down until you see the grey line to the right of the correct slide where you would like to move it . 
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Figure 2 Outline View 

Slide Sorter 

This feature allows you to see thumbnails of your slides in a horizontal view. This view allows for 

you to make easy changes to several slides at once. If you had recorded timing for your slides, Slide 

Sorter will also show you your recorded times below the particular slide(Figure 3) 

 

Figure 3 Slide Sorter 

Let us now understand how the Slide Sorter View works.  

Step 1: Select the slide to be moved.  

Step 2: Left click on the slide and drag it to the position in the sequence where you want to place it. 

PowerPoint will indicate the insert position with a line in-between existing slide. 

 

Step 3: When you get to the right position, release the left click button to insert the slide.   
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Alternately you can also cut the selected slide and paste it back in the sequence as shown below.   

 

Notes 

This section allows you to add notes for the presentation. These notes will not be displayed on the 

screen during the presentation; these are just quick reference for the presenter. The Notes Page allows 
for you to add notes to any slide you want. This comes in handy to where you are visually able to see 

slide notes while giving your presentation.  

To access this, click on Notes Page located under the View Tab (Figure 4). Then a text box will appear 

with a slide number that has been selected. Type your Notes. Then, go back to Normal and you 

should see your Notes located under the slide preview. 

 

Figure 4 Notes page 
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Slide Master 

The Slide Master is where all the information such as background, color, and theme are stored. Every 
PowerPoint has at least one Slide Master. In the Slide Master, you can change any of these particular 

things. Once you have selected Slide Master in the View Tab, (Figure 5) you will be given different 

types of layouts to choose from. 

 

Figure 5 Slide Master 

11.2 Adding Auto shapes and Flowcharts 

Auto shapes 

To emphasize important points in your presentation, you might want to include PowerPoint auto 

shapes in addition to text. The Shapes you draw in PowerPoint are objects that can be sized, moved, 

copied, and formatted in a variety of ways to suit your needs.  

PowerPoint provides several tools for creating several types of shapes including arrows, banners, 

stars, rounded rectangles, circles, squares, and more. Shapes can be worked with individually or they 
can be grouped and treated as one shape. To create almost any shape in PowerPoint, you click on a 

tool from the Drawing toolbar or from the PowerPoint AutoShapes menu and then drag in the 

location where you want the shape to appear. 
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Flowcharts 

Flowcharts are used to create diagrams in Microsoft PowerPoint. 

To insert a Flowchart in PowerPoint: click  Insert Tab > SmartArt. (Figure 6).  Once the SmartArt 

button is expanded, you will have several options to choose from, such as List, Process, Hierarchy, 

etc. To insert Shapes, click the Insert Tab > Shapes (Figure 7). SmartArt Shapes will allow you to 
manipulate the shapes in Flowchart, as well as in text boxes. To resize the Shapes, simply click and 

drag any of the four corners on the object. 

 

Figure 6 Flowcharts 

 

Figure 7 Auto shapes 

11.3 Transitions and Multimedia 

A PowerPoint presentation might be designed to provide ancillary information for a live 

presentation, or to stand alone as an information source. Regardless of the method of delivery, a 

presentation has no value if it does not keep the attention of the audience. An element that can make 
the difference between an adequate presentation and a great presentation is the judicious use of 

animated content, sound, and videos. By incorporating these dynamic effects, you can grab and keep 

the attention of your audience. You can emphasize key points, control the focus of the discussion, 
and entertain in ways that will make your message memorable. With PowerPoint 2016, you have so 

many opportunities to add pizzazz to your slides that it is easy to end up with a presenta tion that 
looks more like an amateur experiment than a professional slide show. When you first start adding 
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animations, sound, and videos to your slides, it is best to err on the conservative side. As you gain 
more experience, you’ll learn how to mix and match effects to get the results you want for a particular 

audience. This chapter guides you through procedures related to animating text and pictures on 

slides, customizing animation effects, adding audio and video content to slides, compressing media 

to decrease file size, and adding and managing slide transitions. 

Animate text and pictures on slides 

In the context of PowerPoint, animation refers to the movement of an element on a slide. When used 

appropriately, animated slide elements can both capture the audience’s attention and effectively 
convey information. You can animate any individual objects on a slide, including text containers, 

pictures, and shapes. (You can’t animate objects that are part of the slide background or slide master, 

other than as part of the transition between slides.) 

Thoughtfully designed animations can be very informative, particularly for audience members who 

are more receptive to visual input than to auditory input. Animations have the added benefit of 
providing a consistent message with or without a presenter to discuss or externally illustrate a 

process. 

 

Figure 8 Elements of multipart animations 

You can configure four types of animations: the appearance, movement, emphasis, and 

disappearance of objects on the slide. There are multiple options within these four categories. The 

options are categorized as Basic, Subtle, Moderate, and Exciting (although you might have a different 
concept of “exciting” than the PowerPoint developer who categorized the effec ts). A few more 

animation effects are available for text than for other slide objects. 

Here’s a breakdown of the animation effects that are available in PowerPoint 2016  

• Entrance animations: An object with an animated entrance is not visible when the slide first 

appears. (It is visible during the development process, but not when you present the slide 

show.) It then appears on the slide in the manner specified by the entrance effect. Some 

entrance effects are available in the Animation gallery. They’re illustrated in green, and their 

icons provide some idea of the movement associated with the effect. 
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• Emphasis animations: These effects animate an object that is already visible on the slide 

to draw attention to it, without changing its location. The emphasis effects that are available 

in the Animation gallery are illustrated in yellow.  

 

• Motion Path animations: These effects move an object along a path that you specify, 

over a period of time that you specify. A few simple motion paths are available from the 

Animation gallery, but a surprisingly large variety is available from the dialog box that 

opens when you click More Motion Paths at the bottom of the Animation menu. 

 

• Exit Animations: These effects take an existing object through a process that results in the 

object no longer being visible on the slide. The exit effects that are available in the Animation 

gallery are illustrated in red. 
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Animations can be very simple, or very complex. Many animations have options that you can 

configure, such as the direction, speed, size, or color. For example, when you configure an entrance 
effect for a bulleted list, you can specify whether to have the entire list enter the slide at the same 

time, or to have only one bulleted item enter at a time. After you choose an effect, the applicable 

options are available on the Effect Options menu. 

 

11.4 Adding Transition between Slides 

To add a Transition into your presentation select the Transitions Tab (Figure 9). You are then given 

a variety to choose from. i.e., “Fade”.  When you select a Transition it will show a preview on the 

existing slide. You must have text or an image within the slide to see a preview.  
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Figure 9 Transition Tab 

Duration 

Along the right-hand side of the Transitions options you will see Duration (Figure 10.) This allows 

you to modify the Duration of the Transition that is present on the slide. This also features an ability 

to play a sound and to control whether to change to the next slide by “On Mouse Click”.  

 

Figure 10 Duration 

11.5 Slide Show 

To access Slide Show, select the Slide Show Tab (Figure 11). The purpose of the Slide Show Tab is for 

the presenter to have an easy access to the full screen presentation mode as well as Rehearse Timings 

and Record Slide Show. 

 

Figure 11 Slide Show Tab with Rehearse Timings and Record Slide Show 

Rehearse Timing 

Rehearse Timing can be a very useful tool that allows you to set up your presentation to play at a 
certain speed without having to click through the slides yourself. Also, this allows you to practice 

your talking points. This feature allows you to save timings for each slide and transition, and will 

start the PowerPoint automatically. 
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Figure 12 Pause Button 

 

Figure 13 Next Arroe Button 

Once you have Rehearse Timings selected under the Slide Show Ribbon the timing will immediately 
begin. To stop the timing, simply click the pause button located at the top left (Figure 12). To save 

this timing, click the next arrow button located below the slide preview. (Figure 13) Then, a box will 

pop up asking if you would like to save the time. Click yes. 

Record Slide Show 

Record Slide Show (Figure 11)  is very similar to the Rehearse Timing. The only primary difference 

is that you can have the option to start recording at any given slide, rather than the beginning.  

11.6 Adding audio content to slides 

You can enhance presentations by adding sound to slide transitions, to animated content, to an 
individual slide, or to the presentation as a whole. For example, you could run a presentation that 

provides basic information and icebreakers during the time leading up to your actual presentation. 

You can add a pleasant royalty-free soundtrack that loops while the presentation plays, to avoid the 
discomfort of a room full of people who don’t want to break the silence. If you plan to distribute a 

presentation electronically for people to watch on their own, you might want to add audio narration 

to an animation, or provide narration for the entire presentation. 

You can add prerecorded audio content to a presentation, or record your own content directly within 

PowerPoint. PowerPoint supports the most common audio formats— MP3, MP4, Windows audio 
(.wav) and Windows Media audio (.wma), and more specialized formats such as ADTS, AU, FLAC, 

MIDI, and MKA audio. 

  

The Insert Online Audio feature that was present in earlier versions of PowerPoint is not 
available in PowerPoint 2016. However, you can download royalty-free audio music and 

sound effects from many online sources. Some of these require that you credit the website 

as the source, so be sure to read the website fine print. When you locate an audio clip that 
you want to use, you can download it to your computer and follow the instructions in 

this topic to use it in a PowerPoint presentation. 

When you add audio to a slide (rather than to an animation or transition), the audio icon (shaped like 

a speaker) and an accompanying trigger icon appear on the slide, and the trigger event appears in 

the Animation Pane. 
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When the audio icon is selected, the Audio Tools tab group, which includes the Format and Playback 

tool tabs, appears on the ribbon, and audio playback controls appear on the slide. 

 

You can start audio content on a slide automatically or from the playback controls. The playback 

controls are visible only when the audio icon is selected. The icon isn’t obtrusive, but you can disguise 
or hide it if you want to. You can change the size or angle of the audio icon by using the sizing handles 

or rotation handle. 

 

To insert an audio clip onto a slide 

1.  Save the audio clip on your computer or on a network-connected location. 

2.  On the Insert tab, in the Media group, click the Audio button, and then click. Audio on My 

PC to open the Insert Audio dialog box. 

3.  In the Insert Audio dialog box, browse to and select the audio file, and then click the Insert 

button. 

Or 

1. In File Explorer, open the folder that contains the audio file. 

2. Arrange the File Explorer and PowerPoint windows on your screen so that both are visible. 

3. Drag the audio file from File Explorer to the slide. 

To record audio directly onto a slide 

1.  On the Insert tab, in the Media group, click the Audio button, and then click Record Audio 

to open the Record Sound dialog box. 
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2.   In the Name box, enter a name to uniquely identify the recording. Then click the Record 

button (labeled with a red circle). 

 

3. Speak or otherwise provide the audio that you want to record. When you finish, click the 

Stop button (labeled with a blue square). The audio icon and an accompanying trigger icon 

appear in the center of the slide, and the trigger event appears in the Animation Pane. 

To insert Video content onto a slide 

1. On a slide that includes a content placeholder, click the Insert Video button in the 

content placeholder to display the Insert Video window that contains links to all the 

video sources you’ve configured Office to connect to. 

 

2. In the Insert Video window, click the source of the video that you want to insert, and 

then follow the process to insert a video from the selected source. 

                   OR 

1. On any slide, on the Insert tab, in the Media group, click the Insert Video button, and then 

do either of the following:  

● Click Online Video to open the Insert Video window. In the Insert Video window, click 

the source of the video that you want to insert, and then follow the process to insert a video 

from the selected source.  

● Click Video on My PC to open the Insert Video dialog box. In the Insert Video dialog box, 

browse to and select the video file, and then click the Insert button. 

  

Create a presentation of your choice and add animations and audio clip to your slides.  

 

208



Unit 11: MS PowerPoint  

 LOVELY PROFESSIONAL UNIVERSITY  

Notes 

Summary 

• The normal view is the default view of power point which shows a combination of slides, 

outline, and notes page view. 

• Outline view displays the presentation in outline form making it easy to copy, move or 

delete slides. 

• The slide view offers one slide at time for editing. 

Self- Assessment Questions 

1. Which of the following is used to see all slides at once? 

A. Using slide sorter view 

B. Using slide view 

C. Using normal view 

D. None of the above 

2. Which of the following is not a type of view in PowerPoint? 

A. Slide show 

B. Slide sorter 

C. Normal 

D. None of the above 

3. In which of the following menu, the slide sorter view is available in PowerPoint? 

A. Insert 

B. View 

C. Design 

D. Animations 

4. Which of the following view in PowerPoint is used to add comments? 

A. Slide sorter view 

B. Notes page view 

C. Normal view 

D. None of the above 

 

5. Is it allowed to make a PDF of the powerpoint presentation? 

A. Yes 

B. No 

C. May be. 

D. Can't say. 

6. What term will be used when you hold the left key of the mouse on an object and move it 

on the slide? 

A. Dragging 

B. Moving 

C. Highlighting 

D. None of the above 

7. Which term is related with decorative text? 

A. Cross- reference 

B. Hyperlink 

C. Clipart 

D. Wordart 
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8. Special effects used to introduce slides in a presentation are called_____ 

A. Present animations 

B. Transitions 

C. Custom animations 

D. Effects 

9. The auto shapes tool provides you with______ 

A. Fancy text to place on your slide. 

B. Commonly found shapes. 

C. Any shape you want to add on a slide. 

D. Clip art that is related to your presentation. 

 

10. Which of the following tool enables you to add text to a slide without using the standard 

placeholders? 

A. Text tool box 

B. Line tool 

C. Drawing tool 

D. Auto shapes tool 

 

11. how would you create the following diagram in PowerPoint 

A. Use auto shapes and the drawing toolbar to create the diagram and design it 

B. Open the diagram gallery from the drawing toolbar and choose this diagram type 

C. Use the chart command on the insert menu to import the diagram. 

D. All of above. 

 

12. ______________________ are presentations that include various types of media such as: text, 

images, videos, animations, or sound. 

A. Multimedia Presentations 

B. Music Presentations 

C. Image Presentations 

D. Sound Presentations 

 

13. ____ are special visual and sound effects contained in presentation graphics file.  

A. Animations 

B. Attractions 

C. Simulations 

D. Graphics 

14. Which of these multimedia operations can be performed on a presentation? 

A. Adding video 

B. Recording video 

C. Screen recording 

D. All of the above 

15.  What is the slide transition? 

a. Letters 

b. Overheads 

c. It is a special effect used to introduce a slide in a slide show. 
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d. None of the above 

Review Questions 

1. Explain different ways to view slides in PowerPoint. 

2. Explain slide layouts in PowerPoint. 

3. What is the difference between Notes Page and Slide Sorter view? 

Answers for Self-Assessment 

1. A  2. D  3. B  4.B  5.A 

6. A  7. D  8. B  9.B  10. A 

11. B  12. A  13. A  14. D  15. C 

 

Further Reading 

  
A Study of Computer Fundamental, Shu-Jung Yi. 

 
https://www.tutorialspoint.com/powerpoint/index.htm 
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Objectives 

After studying this unit, you will be able to:  

• explain the brief history for internet and Web page 

• discuss about the Web page its features  

• explain browsers and URL  

• discuss various HTML data types and ISP’s 

 

Introduction 

Internet has become a prominent way of communication in today's information technology 
environment. It has infiltrated every aspect of existence. Anyone can access information on the 

internet, with a minimum of financial resources, wherever in the globe. The Internet is a network of 

millions of computers. Phone lines or other means of communication were used to connect them. 
Ethernet ISDN or cable modems, for example, are used to share data. The internet is an enormous 

network. Because of its size and strength, one of the experts likened to the Internet as a "ocean." 

Some people are said to' surf,' 'ride,' or 'navigate' the 'internet.' Most individuals begin to ‘swim' 
across the Internet until they discover their own method, which is probably more realistic. The 

options are unlimited when it comes to the Internet. A few of them are listed below. Schoolchildren 

in Delhi, for example, can ‘talk' to their classmates in Mumbai.  

Teachers and administrators can hold a conference with peers from all around the world. A 

business traveler can use her or his home or office computer to send hundreds of messages with a 

few easy clicks. Students may acquire knowledge on any subject via the Internet at any time.  

 

12.1 Internet history 

The United States Department of Defense launched the Internet as an experiment in 1969. The US 

military need a method for its researchers to interact and exchange programs over the internet. 

Bhanu, Lovely Professional University
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ARPANET (Advanced Research Projects Agency—Network) was the first long-distance computer 
network created by defense computer scientists. Then, via telephone connections, remote military 

outposts were able to communicate with one another. Long-distance networking was recognized as 

a benefit by universities and scientists. They started connecting to ARPANET and to each other. 

Businesses and private individuals began to connect through the computer network. 

Today, no individual, no corporation and no government own the Internet—it is owned, operated 
and maintained by all of those who use it. The Internet was first started as an experiment by the 

United States Department of Defense in 1969. The United States military needed a way for its 

researchers to communicate and share programs with one another over their computers. The 
defense computer researchers developed the first long distance network of computers, which was 

called ARPANET (Advanced Research Projects Agency—Network). Remote military sites were 

then ‘connected’ to one another, via telephone lines. Universities and scientists saw the advantage 
of long distance networking. They began to connect with ARPANET as well as to each other. 

Businesses and private individuals then started connecting through the network of computers. 

Eventually the massive network of networks developed, known as Internet. Today, no individual, 
no corporation and no government owns the Internet—it is owned, operated and maintained by all 

of those who use it. 

 

12.2 Internet 

Internet is defined as an Information super Highway, to access information over the web. However, 

it can be defined in many ways as follows: 

 

• Internet is a world-wide global system of interconnected computer networks. 

• Internet uses the standard Internet Protocol (TCP/IP). 

• Every computer in internet is identified by a unique IP address. 

• IP Address is a unique set of numbers (such as 110.22.33.114) which identifies a computer 

location. 

• A special computer DNS (Domain Name Server) is used to give name to the IP Address so 

that user can locate a computer by a name. 

• For example, a DNS server will resolve a name http://www.abc.com to a particular IP 

address to uniquely identify the computer on which this website is hosted. 

• Internet is accessible to every user all over the world. 

 

 

12.3 Evolution 

The concept of Internet was originated in 1969 and has undergone several technological & 

Infrastructural changes as discussed below: 
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• The origin of Internet devised from the concept of Advanced Research Project Agency 

Network (ARPANET). 

• ARPANET was developed by United States Department of Defense. 

• Basic purpose of ARPANET was to provide communication among the various bodies of 

government. 

• Initially, there were only four nodes, formally called Hosts. 

• In 1972, the ARPANET spread over the globe with 23 nodes located at different countries 
and thus became known as Internet. 

• By the time, with invention of new technologies such as TCP/IP protocols, DNS, WWW, 

browsers, scripting languages etc., Internet provided a medium to publish and access 

information over the web. 

Advantages 

Internet covers almost every aspect of life, one can think of. Here, we will discuss some of the 

advantages of Internet: 

 

• Internet allows us to communicate with the people sitting at remote locations. There are 

various apps available on the wed that uses Internet as a medium for communication. 

One can find various social networking sites such as: 

o Facebook 

o Twitter 

o Yahoo 

o Google+ 

o Flickr 

o Orkut 

• One can surf for any kind of information over the internet. Information regarding various 

topics such as Technology, Health & Science, Social Studies, Geographical Information, 

Information Technology, Products etc can be surfed with help of a search engine. 

• Apart from communication and source of information, internet also serves a medium for 

entertainment. Following are the various modes for entertainment over internet. 

o Online Television 

o Online Games 

o Songs 

o Videos 

o Social Networking Apps 
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• Internet allows us to use many services like: 

o Internet Banking 

o Matrimonial Services 

o Online Shopping 

o Online Ticket Booking 

o Online Bill Payment 

o Data Sharing 

o E-mail 

• Internet provides concept of electronic commerce, that allows the business deals to be 

conducted on electronic systems. 

 

Figure 1What Happens in an Internet Minute? 

Disadvantage 

However, Internet has proved to be a powerful source of information in almost every field, yet 

there exists many disadvantages discussed below: 

 

• There are always chances to loose personal information such as name, address, credit card 
number. Therefore, one should be very careful while sharing such information. One 

should use credit cards only through authenticated sites. 

• Another disadvantage is the Spamming. Spamming corresponds to the unwanted e-mails 

in bulk. These e-mails serve no purpose and lead to obstruction of entire system. 

• Virus can easily be spread to the computers connected to internet. Such virus attacks may 

cause your system to crash or your important data may get deleted. 
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• Also a biggest threat on internet is pornography. There are many pornographic sites that 

can be found, letting your children to use internet which indirectly affects the children 

healthy mental life. 

• There are various websites that do not provide the authenticated information. This leads 

to misconception among many people. 

 

12.4  World Wide Web(WWW) 

The World Wide Web is abbreviated as WWW. The World Wide Web is defined as all resources 

and users on the Internet who employ the Hypertext Transfer Protocol (HTTP) (HTTP).  

The World Wide Web Consortium, which Web creator Tim Berners-Lee helped form, provides a 

larger description (W3C). 

The World Wide Web (WWWW) is a universe of network-accessible information that represents 

human knowledge. 

In its most basic form, the World Wide Web is a method of transmitting information between 

computers connected to the Internet, resulting in a massive collection of interactive multimedia 

resources. 

 

Internet and Web is not the same thing: Web uses internet to pass over the information.  

 

Evolution of WWW 

Timothy Berners Lee invented the World Wide Web in 1989 at CERN in Geneva. He proposed the 
World Wide Web as a way for researchers at CERN to collaborate more effectively and efficiently. It 

was eventually renamed the World Wide Web. 

The evolution of the World Wide Web is depicted in the graphic below: 
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Figure 2 WWW Evolution 

WWW Architecture 

WWW architecture is divided into several layers as shown in the following diagram: 

 

Identifiers and Character Set 

Uniform Resource Identifier (URI) is used to uniquely identify resources on the web 
and UNICODE makes it possible to built web pages that can be read and write in human 

languages. 

Syntax 

XML (Extensible Markup Language) helps to define common syntax in semantic web. 

Data Interchange 

Resource Description Framework (RDF) framework helps in defining core representation of data 

for web. RDF represents data about resource in graph form. 
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Taxonomies 

RDF Schema (RDFS) allows more standardized description of taxonomies and 

other ontological constructs. 

Onto logies 

Web Ontology Language (OWL) offers more constructs over RDFS. It comes in following three 

versions: 

• OWL Lite for taxonomies and simple constraints. 

• OWL DL for full description logic support. 

• OWL for more syntactic freedom of RDF 

Rules 

RIF and SWRL offers rules beyond the constructs that are available from RDFs and OWL. Simple 

Protocol and RDF Query Language (SPARQL) is SQL like language used for querying RDF data 

and OWL onto logies. 

Proof 

All semantic and rules that are executed at layers below Proof and their result will be used to 

prove deductions. 

Cryptography 

Cryptography means such as digital signature for verification of the origin of sources is used. 

User Interface and Applications 

On the top of layer User interface and Applications layer is built for user interaction. 

WWW Operations 

The World Wide Web is based on a client-server model. The steps below will explain how the 

internet works: 

1. In the address bar of the web browser, the user types the URL of the web page (for 
example, http://www.abc.com). 

2. After then, the browser asks the Domain Name Server for the IP address for 
www.abc.com. 

3. After receiving IP address, browser sends the request for web page to the web server 

using HTTP protocol which specifies the way the browser and web server communicates. 
4. Then web server receives request using HTTP protocol and checks its search for the 

requested web page. If found it returns it back to the web browser and close the HTTP 

connection 
5. Now the web browser receives the web page, It interprets it and display the contents of 

web page in web browser’s window. 

Future 

There had been a rapid development in field of web. It has its impact in almost every area such as 
education, research, technology, commerce, marketing etc. So the future of web is almost 

unpredictable. 
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Apart from huge development in field of WWW, there are also some technical issues that W3 

consortium has to come up with. 

User Interface 

Work on higher quality presentation of 3-D information is under development. The W3 Consortium 
is also looking forward to enhancing the web to full fill requirements of global communities which 

would include all regional languages and writing systems. 

Technology 

Work on privacy and security is under way. This would include hiding information, accounting, 

access control, integrity, and risk management. 

Architecture 

There has been huge growth in field of web which may lead to overload the internet and degrade 

its performance. Hence better protocol is required to be developed. 

 

12.5 Website Overview 

Website is a location on web and is hosted on a web server. It is a set of related web pages. It is 

accessed using Internet address known as Uniform Resource Locator 

Static Website 

Websites that are static are sometimes referred to as flat or stationary websites. They are loaded 

precisely as they are on the web server into the client's browser. These websites simply have static 

information on them. The user can only read the information; he or she cannot change it or interact 

with it. 

Only HTML is used to make static webpages. Static websites are only utilized when the 

information does not need to be updated any more. 

 

Figure 3 How Static Websites work? 

Dynamic Website 

Various information is displayed on dynamic webpages at different times. It is possible to modify a 

piece of a web page without having to reload the full page. It was made feasible through the use of 

Ajax technology. 

Server-side dynamic web page 

Server-side scripting is used to generate it. There are server-side scripting settings that control how 

a new web page is built, as well as how further client-side processing is set up. 

Client-side dynamic web page 

Client-side scripting, such as java script, is used to process it. Then it's sent to Document Object 

Model (DOM) 
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Figure 4 How Dynamic Website works? 

 

Web pages 

web page is a document available on world wide web. Web Pages are stored on web server and can 

be viewed using a web browser. 

A web page can contain huge information including text, graphics, audio, video and hyperlinks. 

These hyperlinks are the link to other web pages. 

The website is a document that usually appears in a web browser, generally authored in HTML. By 
entering a URL address in the address bar of a browser, a web page may be visited. You may 

include text, pictures and hyperlinks on a web page to other web pages and files. 

A website is frequently used to give users with information, including images or videos, to 

highlight key issues. The sale of items or services to the viewers is also permitted through an 

internet page. Many online sites, such as our Computer Hope site, make up a web site. 

You reach a web page by clicking on a link supplied by a search engine. There are millions of 

websites in the Internet and more are added earlier. 
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Figure 5 Sample Web pages 

Web Browser 

Web Browser is an application software that allows us to view and explore information on the web. 

User can request for any web page by just entering a URL into address bar. 

Web browser can show text, audio, video, animation and more. It is the responsibility of a web 

browser to interpret text and commands contained in the web page. 

Earlier the web browsers were text-based while now a days graphical-based, or voice-based web 

browsers are also available. Following is the most common web browser available today: 

Browser Vendor 

Internet Explorer Microsoft 

Google Chrome Google 

Mozilla Firefox Mozilla 

Netscape Navigator 
Netscape Communications 

Corp. 

Opera Opera Software 

Safari Apple 

Sea Monkey Mozilla Foundation 

K-meleon K-meleon 

Table 1 Different Web browsers along with the vendor 

Architecture of Web Browser 

There are a lot of web browsers available in the market. All of them interpret and display 

information on the screen however their capabilities and structure vary depending upon 
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implementation. But the most basic component that all web browsers must exhibit are listed 

below: 

• Controller/Dispatcher 

• Interpreter 

• Client Programs 

Controller works as a control unit in CPU. It takes input from the keyboard or mouse, interpret it 

and make other services to work on the basis of input it receives. 

Interpreters receive the information from the controller and execute the instruction line by line. 

Some interpreters are mandatory while some are optional. For example, HTML interpreter 

program is mandatory and java interpreter is optional. 

Client Program describes the specific protocol that will be used to access a particular service. 

Following are the client programs that are commonly used: 

• HTTP 

• SMTP 

• FTP 

• NNTP 

• POP 

 

 

Web Server 

Web server is a computer where the web content is stored. Basically, web server is used to host the 

web sites but there exist other web servers also such as gaming, storage, FTP, email etc. 

 

Web site is collection of web pages while web server is a software that respond 

to the request for web resources. 

Web Server Working 

Web servers respond to the client request in either of the following two ways: 

• Sending the file to the client associated with the requested URL. 

• Generating response by invoking a script and communicating with database. 
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Key Points 

• When client sends request for a web page, the web server search for the requested page if 

requested page is found then it will send it to client with an HTTP response. 

• If the requested web page is not found, web servers will the send an HTTP response: 
Error 404 Not found. 

• If client has requested for some other resources, then the web server will contact to the 

application server and data store to construct the HTTP response. 

Architecture 

Web Server Architecture follows the following two approaches: 

1. Concurrent Approach 

2. Single-Process-Event-Driven Approach. 

Concurrent Approach 

Concurrent approach allows the web server to handle multiple client requests at the same time. It 

can be achieved by following methods: 

• Multi-process 

• Multi-threaded 

• Hybrid method. 

Multi-processing 

In this a single process (parent process) initiates several single-threaded child processes and 

distribute incoming requests to these child processes. Each of the child processes are responsible 

for handling single request. 

It is the responsibility of parent process to monitor the load and decide if processes should be 

killed or forked. 

Multi-threaded 

Unlike Multi-process, it creates multiple single-threaded process. 

Hybrid 

It is combination of above two approaches. In this approach multiple process are created and each 

process initiates multiple threads. Each of the threads handles one connection. Using multiple 

threads in single process results in less load on system resources. 
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12.6 URL(Uniform Resource Locator) 

A URL (Uniform Resource Locator) is a reference to an online resource which defines the location 

of the web resource on the computing network and the methodology used to locate the web 

resource. A Uniform Resource Identification URL(URI) is a specific type but many people 
interchange these two phrases. URls are most often used for web pages of reference (http), but are 

also used for the transfer of files (ftp), e-mail (mailbox), access to databases (JDBC), etc. 

Most web browsers display the URL of a web page above the page in an address bar. A typical URL 
could have the form http://www.example.com/index.html, which indicates a protocol (http), a 

hostname (www.example.com), and a file name (index.html). 

 

The URL sends users to a specific resource online such as video, webpage, or other resources. When 

you search any query on Google, it will display the multiple URLs of the resource that are all 

related to your search query. The displayed URLs are the hyperlink to access the webpages.  

A URL (Uniform Resource Locator) contains the information, which is as follows: 

o The port number on the server, which is optional. 

o It contains a protocol that is used to access the resource. 

o The location of the server 

o A fragment identifier 

o In the directory structure of the server, it contains the location of the resource. 

The additional information about the URL is described below with the help of an example:  

Let's take an example: https://www.abc.com/jtp.htm, it indicates the jtp.htm is a file located on the 

server with the address of javatpoint.com. 

http:// or https:// 

The http is a protocol that stands for Hypertext Transfer Protocol. It tells the browser to which 

protocol will be preferred to use for accessing the information that is specified in the domain.  

The https (Hypertext Transfer Protocol Secure) is an enhanced protocol as compared to http as it 
concerned with security. It provides the surety that the information, which is transmitted 

over HTTP is secure and encrypted. The colon (:) and two forward slashes (//) are used to separate 

the protocol from the rest of the part of the URL. 

www. 

The www is used to distinguish the content, which stands for World Wide Web. This portion of the 

URL can be left out many times, as it is not required. For instance, if you type "http://abc.com," 
you will still get the abc website. For an important subpage, this portion can also be substituted, 

which is known as a sub domain. 

abc.com 
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The abct.com is the domain name for the website, and the .com is called TLD or suffix. It helps to 
identify the location or type of the website. For example, ".org" stands for an organization, ".co.uk" 

stands for the United Kingdom, and ".com" is for commercial. There are various types of domain 

suffixes available; you are required to register the name through a domain registrar to get a 

domain. 

jtp.htm 

The jtp.htm is the name of the web page, and the .htm is the file extension of the web page, which 
describes the file is an HTML file. There are many other file extensions available on the internet 

such as .php, .html, .xml, .jpg, .gif, .asp, .cgi, etc. 

These are some examples of the URLs that you may have come across: 

• http://www.google.com 

• http://www.yahoo.co.uk 

• http://www.amazon.com 

 

If you type these URLs into your browser, you will go to the exact site you wanted  without having 

to use a search engine. 

You can break a URL down into three sections. 

http://www.amazon.co.uk 

 

 

 
 

 

 
 

 

http://www.amazon.co.uk 

 

 

http://www.amazon.co.uk 
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http://www.amazon.co.uk 

 

 

 

Other Endings You Might Come Across 

 

 

12.7 ISP(Internet Service Provider) 

ISP stands for Internet Service Provider. It is a company that provides access to the internet and 

similar services such as Website designing and virtual hosting. For example, when you connect to 
the Internet, the connection between your Internet-enabled device and the internet is executed 
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through a specific transmission technology that involves the transfer of information packets 

through an Internet Protocol route. 

 

Data is transmitted through different technologies, including cable modem, dial-up, DSL, high 

speed interconnects. Accordingly, based on the method of data transmission, the Internet access 

provided by ISPs can be divided into many types, some of which are as follows: 

 

Dial-up Internet access: It is the oldest technology to provide Internet access by modem to modem 

connection using telephone lines. In this method, the user's computer is connected to a modem with 
a telephone line. This method has become outdated today due to slow connection speed. However, 

in remote areas, this method can be used where the broadband network is not available.  

 

DSL: DSL, which stands for 'digital subscriber line' is an advanced version of the dial-up Internet 

access method. It uses high frequency to execute a connection over the telephone network and 
allows the internet and the phone connection to run on the same telephone line. This method offers 

an Asymmetric Digital Subscriber (ADSL), where the upload speed is less than the download 

speed, and a Symmetric Digital Subscriber Line (SDSL), which offers equal upload and download 

speeds. Out of these two, ADSL is more popular among users and is popularly known as DSL. 

 

Wireless Broadband (WiBB): It is a modern broadband technology for Internet access. It allows 
high-speed wireless internet within a large area. To use this technology, you are required to place a 

dish on the top of your house and point it to the transmitter of your Wireless Internet Service 

Provider (WISP). 

 

Wi-Fi Internet: It is the short form for "wireless fidelity," which is a wireless networking technology 

that provides wireless high-speed Internet connections using radio waves. To use the internet, you 
are required to be within the range of wi-fi network. It is commonly used in public places such as 

hotels, airports, restaurants to provide internet access to customers. 

 

ISDN: It is a short form of Integrated Services Digital Network. It is a telephone system network 

which integrates a high-quality digital transmission of voice and data over the same standard 
phone line. It offers a fast upstream and downstream Internet connection speed and allows both 

voice calls and data transfer. 

 

Ethernet: It is a wired LAN (Local Area Network) where computers are connected within a primary 

physical space. It enables devices to communicate with each other via a protocol (a set of rules or 

common network language). It may provide different speeds such as 10 Mbps, 100 Mbps and 10 

Gbps. 
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Figure 6 Examples of some ISP 

Summary 

• In this we discuss about the role of internet and its user in various different fields as 

referred by scientists as an ‘ocean’ to ‘rurf’, ‘side’ or ‘navigate’ the net.  

•  Web page may be retrieved from a local computer or from remote web senses.  

•  Record of web page address is a book marking.  

•  In elements web page, can contain numerous types of information, which is able to be 

sun.  

•  Graphical web browser are user friendly web browsing programs.  

 

Keywords 

Bookmark: In web terminology, a bookmark is a record of Web page address. 

 Browsers: The web browser is a medium that enable to use on’s computer to look at World Wide 

Web (WWW) documents. Graphical. 

Web browser: It is a program which allows one to access World Wide Web with graphic. 

 HTML: It stands for Hyper Text Markup Language, is the predominant markup language for web 

pages. It is the basic building block of webpages.  

ISP: ISP or internet service provider is a company that provides access to the Internet; host data’s or 

does both. 

 

Self Assessment  

1. Which of the following is a correct format of Email address? 
A. name@website@info 

B. www.nameofebsite.com 

C. name@website.info 
D. name.website.com 

 

2. A program that is used to view websites is called a _______ 
A. Browser 

B. Web viewer 
C. Spreadsheet 

D. Word processor 
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3. Internet is _______ 
A. A worldwide interconnected network of computers which use a common protocol to 

communicate with one another. 

B. A worldwide network of computers 
C. An interconnected network of computers 

D. A local computer network. 
 

4. The process of connecting to the internet account is______ 

A. Sing in 
B. Sing out 

C. Login 

D. Logout 
 

5. URL is ___________ 

A. web address 

B. source code 
C. user’s address 

D. an attribute 

 
6. Internet explorer falls under : 

A. Operating System 
B. Compiler 

C. Browser 

D. IP address 
 

7. What is the full form of WWW in web address? 

A. World Wide Web 
B. World Wide Word 

C. World Wide Wood 

D. None of these 
 

8. Full form of HTML is: 
A. Hyper Text Markup Language 

B. Hyper Text Manipulation Language 

C. Hyper Text Managing Links 
D. Hyper Text Manipulating Links 

 

9. To join the internet, the computer has to be connected to a _________ 
A. internet architecture board 

B. internet society 

C. internet service provider 
D. different computer 

 

10.  The third component of URL is: 
A. Protocol 

B. Server name 
C. Domain name 

D. Website name 

 
11. The domain extension .org refers to a type of website__ 

A. Commercial 

B. Government 
C. Non-Profit Organization 

D. Educational 

 
12. What is a search engine? 

A. a program that searches engines 
B. a web site that searches anything 

C. a hardware component 

D. a machinery engine that search data. 
 

13.  It is an application that stores the Web pages requested by users. What is it? 

A. Web page 
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B. Internet 
C. WWW 

D. Web server 

 
14. ISP stands for _____ 

A. Intranet Service Provider 
B. Internet Service Provider 

C. Inter Service Provider 

D. International Special Products 

 

15.  A search engine can be defined as a software program that provides the required 

information in the form of a lists of related websites, based on search criterion defined by 
the user. Some commonly used search engines are: 

A. Google 

B. Bing 
C. Yahoo! 

D. All of these 

 

Answer for Self Assessment 

1. C 2. A 3. A 4. C 5. A 

6. C 7. A 8. A 9. B 10. C 

11. C 12. A 13. D 14. B 15. D 

 

Review Questions 

1. What are the commonly used browsers? 

2. Explain the difference between Lynx and Internet Explorer. 
3. Explain how a banner of IE classified. 

4. What is the function of a location bar in a browser?  

5. Explain the significance of Book Marking. 
6. How can you search for computer books available on the internet in India? 

7. What are the main components of Internet browsers? 

Further Reading 

 
Excellence in Computer Education by Dr. C. K. Seth. 

 
www.webopedia.com/index.php/TERM/I/internet.html 
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Objectives 

• understand the Web Server 

• explain the use and concept of E-mail  

• discuss instant messaging  

• explain internet telephony  

• understand video conference 

 

Introduction 

The machine and the software installed on a web server. The web server uses a web browser to 

interface with the client. They supply web pages via the Web browser and HTTP protocols to the 
customer and application. Also we may set a web server for downloading the required files using 

the File Transfer Protocol and for providing e-mail, web pages creating and published applications 

on an intranet or Internet-connected computer with the help of the File Transfer Protocol. On a 
client server model a web server functions. A server application must be provided to a computer 

connected to the internet or intranet. 

 

13.1 Web Sever 

A web server is software and hardware that uses HTTP (Hypertext Transfer Protocol) and other 

protocols to respond to client requests made over the World Wide Web. The main job of a web 

server is to display website content through storing, processing and delivering webpages to users. 
Besides HTTP, web servers also support SMTP (Simple Mail Transfer Protocol) and FTP (File 

Transfer Protocol), used for email, file transfer and storage. 

Bhanu, Lovely Professional University
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Web server hardware is connected to the internet and allows data to be exchanged with other 
connected devices, while web server software controls how a user accesses hosted files. The web 

server process is an example of the client/server model. All computers that host websites must 

have web server software. 

Web servers are used in web hosting, or the hosting of data for websites and web-based 

applications -- or web applications. 

How it works? 

The Web Server software is accessed via the websites' domain names and provides the content of 
the site to the requested user. There are also various components on the software side, with at least 

one HTTP server. The HTTP server has HTTP and URL comprehensions. A web server is a physical 

machine that holds software for websites and other online-related data, such as HTML texts, photos 

and JavaScript files. 

 

When the browser wants a file that is hosted on a web server, such as Google Chrome or Firefox, 

the browser requires HTTP for the file. The HTTP server will accept the request, retrieve the 

contents and send I if the request is received by the web server. 

Examples of Webserver uses 

Web servers are frequently included as part of a larger package of internet and intranet-related 

tools that are used for things like 

• sending and receiving emails. 

• downloading requests for File Transfer Protocol (FTP) files. 

• creating and publishing sites. 

Server-side scripting, which is used to utilize scripts on a web server that may adapt the response to 
the client, is supported by many basic web servers. Server-side scripting operates on the server 

computer and offers a wide range of capabilities, including database access. Active Server Pages 

(ASP), Hypertext Preprocessor (PHP), and other scripting languages will be used in the server-side 

scripting process. 

 

13.2 WWW( World Wide Web) 

The World Wide Web, sometimes known as a Web, is a collection of websites or web pages 
maintained on web servers and accessible through the internet by local computers. Text pages, 

digital photos, audios, and videos, among other things, can be found on these websites. Users may 

access the content of these sites through the internet utilizing devices such as computers, laptops, 
and cell phones from anywhere in the globe. The WWW, in conjunction with the internet, allows 

you to retrieve and display text and media on your device. 

 

 

 

Web pages, which are formatted in HTML and connected by connections known as "hypertext" or 

hyperlinks and accessible over HTTP, are the building blocks of the Web. These are electronic 

linkages that connect relevant bits of information so that users may easily get what they need. The 
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advantage of hypertext is that it allows you to choose a word or phrase from a text and then go to 
other sites that provide further information on that word or phrase. A Uniform Resource Locator 

(URL) is an Internet address given to a web page (URL). A website is a collection of online pages 

that belong to a given URL, such as www.facebook.com, www.google.com, and so on. As a result, 
the World Wide Web resembles a huge electronic book whose pages are stored on multiple servers 

across the world. 

Small websites keep all of their WebPages on a single server, but large websites or organisations 

store their WebPages on many servers in various countries so that when people from that location 

search their site, the information may be rapidly retrieved from the nearest server.  

As a result, the web serves as a platform for users to retrieve and share data through the internet. 

Unlike in a book, where we go from one page to the next in a sequential order, on the World Wide 

Web, we visit a web page and then travel from that web page to other network sites by following a 
web of hypertext connections. To access the Internet, you'll need a browser installed on your 

computer. 

Different between WWW and Internet 

The phrases 'internet' and 'World Wide Web' are sometimes used interchangeably. They believe 
they are the same, although this is not the case. The Internet is not the same as the World Wide 

Web. It's a global network of computers, laptops, tablets, and other gadgets. It allows users to 

exchange emails and interact with other people online. When you send an email or speak with 

someone online, for example, you are utilizing the internet. 

However, when you access information from a website such as google.com, you are utilising the 

World Wide Web, which is a network of servers connected by the internet. When you use a browser 
to request a site from your computer, the server produces that page for you. Your PC is referred to 

as a client. 

 

How the World Wide Web Works? 

Now, we have understood that WWW is a collection of websites connected to the internet so that 

people can search and share information. Now, let us understand how it works! 
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The internet's core client-server format, as represented in the accompanying graphic, governs how 
the Web functions. When users request web pages or information, the servers store and transport it 

to their computers on the network. A web server is a computer program that provides web pages to  

people who access them using a browser. A client is the computer of a user who requests 
documents from a server. Users can access the papers that have been obtained using a browser that 

has been installed on their machine. 

 

Web servers hold all of the websites. A website, like a person who rents a house, takes up space on 

a server and is kept there. When a user requests a website's WebPages, the server hosts it, and the 

website owner is responsible for paying the hosting fee. 

The WWW starts operating the instant you open your browser and put a URL into the address bar 

or search for anything on Google. In order to send information (web pages) from servers to clients, 

three basic technologies are used (computers of users). Hypertext Markup Language (HTML), 

Hypertext Transfer Protocol (HTTP), and Web browsers are examples of these technologies.  

 

13.3 Hypertext Markup Language (HTML): 

HTML is a markup language that is commonly used to create web pages. It uses HTML elements or 
tags to define the structure of online pages. These tags are used to arrange material like 'header,' 

'paragraph,' 'table,' 'Image,' and others. When you view a site, you won't see HTML tags since 

browsers don't show them and only utilise them to produce the text. HTML is a markup language 

that allows text, graphics, and other resources to be displayed in a Web browser. 
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Hyper Text Markup Language is the abbreviation for Hyper Text Markup Language. It's a markup 
language that's used to create web pages. HTML is a markup language that combines hypertext 

with markup. The term "hypertext" refers to the connection between online pages. The text 

document within the tag that specifies the structure of web pages is defined using a markup 
language. This language is used to annotate (add notes to) text so that a computer can comprehend 

it and alter it appropriately. The majority of markup languages (such as HTML) are understandable 

by humans. Tags are used in the language to specify what type of text processing is required.  

HTML is a markup language that the browser uses to transform text, pictures, and other material so 

that it may be displayed.HTML was created by Tim Berners-Lee in 1991. The first-ever version of 

HTML was HTML 1.0, but the first standard version was HTML 2.0, published in 1999. 

 

Elements and tags 

HTML uses predefined tags and elements which tell the browser how to properly display the 

content. Remember to include closing tags. If omitted, the browser applies the effect of the opening 

tag until the end of the page. 

 

 

 

HTML page structure: 

The basic structure of an HTML page is laid out below. It contains the essential building-block 

elements (i.e. doctype declaration, HTML, head, title, and body elements) upon which all web 
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pages are created.

 

<DOCTYPE! html>: This is the document type declaration (not technically a tag). It declares a 
document as being an HTML document. The doctype declaration is not case-sensitive. 

 
<html>: This is called the HTML root element. All other elements are contained within it.  

 

<head>: The head tag contains the “behind the scenes” elements for a webpage. Elements within 
the head aren’t visible on the front-end of a webpage. HTML elements used inside the <head> 

element include:  

• <style> 

• <title> 

• <base> 

• <noscript> 

• <script> 

• <meta> 

• <link> 

<body>: the body tag is used to enclose all the visible content of a webpage. In other words, the 
body content is what the browser will show on the front-end. 

 
An HTML document can be created using any text editor. Save the text file using .html or .htm. 

Once saved as an HTML document, the file can be opened as a webpage in the browser.  

NOTE: Basic/built-in text editors are Notepad (Windows) and Text Edit (Macs). Basic text 
editors are entirely sufficient for when you’re just getting started. As you progress, there are 
many feature-rich text editors available which allow for greater function and flexibility.  

Features of HTML: 

• It is easy to learn and easy to use. 

• It is platform independent. 

• Images, videos, and audio can be added to a web page. 

• Hypertext can be added to text. 

• It is a markup language.  

Advantages:  

• HTML is used to build websites. 

• It is supported by all browsers. 

• It can be integrated with other languages like CSS, JavaScript, etc. 

Disadvantages:  

• HTML can only create static web pages. For dynamic web pages, other languages have to 

be used. 

• A large amount of code has to be written to create a simple web page. 

• The security feature is not good. 
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13.4 Email 

Do you ever feel like the only person who doesn't use email? You don't have to feel left out. If 
you're just getting started, you'll see that with a little bit of practice, email is easy to understand and 

use. 

In this lesson, you will learn what email is, how it compares to traditional mail, and how email 
addresses are written. We'll also discuss various types of email providers and the features and tools 

they include with an email account. 

Getting to know email: 

Email (electronic mail) is a method of communicating through the Internet. It's comparable to 
regular mail, but there are a few important distinctions. Take a look at the info graphic below to 

have a better sense of what email is all about and how you may profit from it.  
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Email Advantages 

• Productivity tools: Email is usually packaged with a calendar, address book, instant 

messaging, and more for convenience and productivity. 

• Access to web services: If you want to sign up for an account like Facebook or order 

products from services like Amazon, you will need an email address so you can be safely 

identified and contacted. 

• Easy mail management: Email service providers have tools that allow you to file, label, 

prioritize, find, group, and filter your emails for easy management. You can even easily 
control spam, or junk email. 

• Privacy: Your email is delivered to your own personal and private account with a 

password required to access and view emails. 

• Communication with multiple people: You can send an email to multiple people at once, 

giving you the option to include as few as or as many people as you want in a 

conversation. 

• Accessible anywhere at any time: You do not have to be at home to get your mail. You 

can access it from any computer or mobile device that has an Internet connection.  

 

13.5 Understanding Email Address 

To receive emails, you will need an email account and an email address. Also, if you want to send 

emails to other people, you will need to obtain their email addresses. It's important to learn how to 
write email addresses correctly because if you do not enter them exactly right, your emails will not 

be delivered or might be delivered to the wrong person. 

Email addresses are always written in a standard format that includes a user name, the @ (at) 

symbol, and the email provider's domain. 

The user name is the name you choose to identify yourself. 

 

 

The email provider is the website that hosts your email account. 

 

 

Some businesses and organizations use email addresses with their own website domain. 
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About Email Providers 

People used to get their email accounts from the same firms that supplied their Internet connection 

in the past. If AOL offered your Internet service, for example, you'd have an AOL email address. 
While this is still true for some people, using a free web-based email service, commonly known as 

webmail, is becoming more widespread. These services are available to anybody, regardless of who 

supplies their Internet access. 

Webmail Providers 

Today, the top three webmail providers are Yahoo!, Microsoft's Outlook.com (previously Hotmail), 

and Google's Gmail. These providers are popular because they allow you to access your email 

account from anywhere with an Internet connection. You can also access webmail on your mobile 

device. 

 

Other email providers 

Many people also have an email address hosted by their company, school, or organization. These 

email addresses are usually for professional purposes. For example, the people who work for this 

website have email addresses that end with @gcflearnfree.org. If you are part of an organization 

that hosts your email, they'll show you how to access it. 

Many hosted web domains end with a suffix other than .com. Depending on the organization, your 

provider's domain might end with a suffix like .gov (for government websites), .edu (for schools), 

.mil (for military branches), or .org (for nonprofit organizations). 

13.6 Email Productivity Features 

In addition to email access, webmail providers offer various tools and features. These features are 

part of a productivity suite—a set of applications that help you work, communicate, and stay 

organized. The tools offered will vary by provider, but all major webmail services offer the 

following features: 
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• Instant messaging, or chat, which lets you have text-based 

conversations with other users (check out our Beyond Email lesson to 
learn more about the basics of instant messaging) 

 
• An online address book, where you can store contact information for 

the people you contact frequently 

 

• An online calendar to help organize your schedule and share it with 

others. 
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• A public profile that you can use for basic social networking purposes, like 

sharing photos, previous work or school history, and status updates, among 

other things 

 

 

 

In addition, each provider offers some unique features. For instance, when you sign up 
for Gmail you gain access to a full range of Google services, including Google Drive, 

Google Docs, and more. Outlook, on the other hand, offers connectivity with One Drive 

and Microsoft Office Web Apps. You can visit our tutorials on Google Drive, Google Docs 

and One Drive and Office Online to learn more. 

13.7 Instant Messaging (IM) 

Instant messaging (IM) is a sort of online chat that allows users to send and receive text messages in 

real time via the Internet. Over a local area network, a LAN messenger works similarly. When each 
user completes an idea and selects "send," short messages are often sent between two individuals. 

Push technology may be used by some IM systems to give real-time text, which sends messages 

character by character as they are produced. File transmission, clickable hyperlinks, Voice over IP, 

and video chat are all options in more complex instant messaging. 

Instant messaging (IM) is a type of Internet communication that allows senders and receivers to 

send and receive text-based communications quickly. Instant messaging is a type of internet chat 
that allows users to communicate in real time using written language. The text of the user is sent 

through a network, such as the Internet. 

Examples 

• Face book 

• Twitter 

• instant messaging 

• E-mail 
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• chat rooms 

• Whatsapp 

 

 

 

 

 

 

 

 

 

 

Chat rooms 

• The primary use of a chat room is to share information via text with a group of other 

users. Generally speaking, the ability to converse with multiple people in the same 

conversation differentiates chat rooms from instant messaging programs, which are more 

typically designed for one-to-one communication. 

 

 

 

 

 

 

 

SMS 

• Short Message Service (SMS) is a text messaging service component of phone, web, or 

mobile communication. 

• SMS is the most widely used data application in the world, with 3.6 billion active users, or 
78% of all mobile phone subscribers. SMS is the user activity itself in many parts of the 

world. SMS is also being used as a form of direct marketing known as SMS marketing. 

Uses of IM 

1. Communicate Instantly 

2. Improve Efficiency and Productivity 

3. People Like Using It 

4. Save Money 

5. Communicate with Remote Workers 

6. It’s Full of Features 

7. Easy to Implement and Administer 

 

Search some others IM software's which are being used on Internet / Which 

are you using at your home. 
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13.8 Internet Telephony 

• IP telephony uses the Internet to send audio, video, fax etc between two or more users in 
real time, so the users can converse. Digital Voice encapsulated into packets transmitted 

over packet switched IP network. 

⮚ Main motivation: 

▪  Integration of new services, 

▪  cost effectiveness 

 

Difference between Internet Telephony and Voice over IP 

• Internet Telephony and Voice over IP (VoIP) are often used synonymously, but in reality, 

VoIP is a subset of Internet Telephony that refers to voice traffic only. 

• While Internet Telephony is a general term for the IP packet-switching technology used by 

Internet phone systems to exchange any type of information,  

• Voice over IP is the specific method for carrying voice calls over an IP network. 

 

The simplest IP telephone system uses two basic components: 

- IP telephone: end device allowing humans to place and receive calls. 

- Media Gateway Controller: providing overall control  and coordination between IP 

phones; allowing a caller to  locate a called (e.g., call forwarding) 

 

13.9 Video Conferencing 

• Video conference tools have become incredibly popular in the last months. They allow you 

to keep in touch with your team, contact potential customers and investors, and do pretty 

much everything you could do in person. You can record and save conversations you have 
through video conferencing. You don’t have to rely on someone taking notes, or your 

memory to know exactly what you said. Video conferences offer the possibility of 

directly sharing audiovisual complements that will illustrate your points. 

Advantages 

• It's More Engaging than Audio Conferencing.  

• It's Efficient 

• It Saves on Travel Money 

• It Improves Communication 

• It Connects Teams 
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• It Improves Productivity 

• It Improves Attendance 

Disadvantages 

• Lack of Personal Connection. Some customers may feel that video conferencing takes 

away from the personal touch provided by in-person meetings. ... 

• Time Zone Differences. ... 

• Unreliable Technology. ... 

• Too Much Required Training. 

 

Figure 1Popular Video Conference Tools for Businesses 

 

Figure 2 Other Apps 

 

Summary 

• The Web server have such feature like Web sorting, Web working.  

•  A Web server can be referred to as other the hardware (the computer) or the software that 

helps to deliver content.  

•  Internet telephony use in web server.  

• E-mail application is used Web Server.  

•  Videoconferencing differs from video phone calls in that it is designed to save a 

conference ratter than individuals. 

 

Keywords 

E-mail: Electronic mail, commonly called email, is a method of exchanging digital messages from 

an author to one or more recipients.  
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Instant Messaging (IM): Instant messaging is a form of real time direct text-based communication 

between two or more people using personal computers or other devices, along with shared clients.  

Internet Telephony: It is a category of hardware and software that enables people to use the 

Internet as the transmission medium for telephone calls. 

Video Conference: A video conference is a set of interactive telecommunication technologies which 

allow two or more locations to interact via two way video and audio transmissions simultaneously.  

Web server: A web server can be referred to as either the hardware (the computer) or the software 

(the computer application) that helps to deliver content that can be accessed through the Internet.  

 

Self Assessment 

1. A piece of icon or image on a web page associated with another webpage is called ______ 
A. url 

B. hyperlink 
C. plugin 

D. extension 

 
2. Dynamic web page ______ 

A. is same every time whenever it displays. 

B. generates on demand by a program or a request from browser. 
C. both is same every time whenever it displays and generates on demand by a 

program or a request from browser. 

D. is different always in a predefined order. 
 

3. Collection of documents stored on a computer which is permanently connected with 
internet around the world is called ____ 

A. telnet 

B. WWW 
C. LAN 

D. FTP 

 
4. The internet also known simply as _______ 

A. NAT 

B. NOT 
C. NET 

D. NFT 

 
5. Which of the following is an example of connectivity? 

A. Floppy Disk 
B. Data 

C. Internet 

D. Power card 
 

6. The process of transferring files from a computer on the Internet to your computer is 

called _________ 
A. Uploading 

B. Forwarding 

C. FTP 
D. Downloading 

 
7. A Web site's front page /main page is called ______ 

A. Browser Page 

B. Search Page 
C. Home Page 

D. Bookmark 

 
8. Which of these is not a medium for e-mail? 

A. Intranet 

B. Internet 
C. Extranet 

D. Paper 
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9. Which of these is the easiest way of communication? 

A. E-mail 

B. Telephone 
C. Fax 

D. Letter 
 

10. Which of these do not provide free E-mail? 

A. Hotmail 
B. Rediff 

C. WhatsApp 

D. Yahoo 
 

11. Which of the following feature is supported by Skype application? 

A. Message logging 
B. Instant messaging 

C. File transfers 

D. All of the mentioned 
 

12. Viber is an instant messaging and VoIP app for smartphones. What is the acronym of 
VoIP? 

A. Video over Internet Protocol 

B. Visual over Internet Protocol 
C. Voice over Internet Protocol 

D. Volume over Internet Protocol 

 
13. The collection of links throughout the Internet creates an interconnected network called 

the  ___________ 

A. Pie chart 
B. Slide Presentation 

C. Bookmark 
D. Plotter 

 

14. There are how many types of Internet telephony___? 
A. 2 

B. 3 

C. 4 
D. 5 

 

15. Which of these is true in the context of Video Conference? 
A. You can record and save conversations you have through video conferencing. 

B. You don’t have to rely on someone taking notes, or your memory to know exactly 

what you said. 
C. Video conferences offer the possibility of directly sharing audiovisual 

complements that will illustrate your points. 
D. All of these 

 

 

Answers for Self Assessment 

1. B 2. B 3. B 4. C 5. C 

6. D 7. C 8. D 9. A 10. C 

11. D 12. C 13. C 14. B 15. D 

 

Review Questions 

1. How can you download a particular information from the web? 

2. What are the common features of a Web server?  
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3. Explain significance of video conference and how it is used. 

4. Explain some different Applications used for IM. 

Further Reading 

 
Excellence in Computer Education by Dr. C. K. Seth. 

 
www.webopedia.com/index.php/TERM/I/internet.html 
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Unit 14: Cloud Computing and IoT 

CONTENTS 
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14.5 Cloud Deployment Models 
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14.7 Cloud Computing Virtualization 

14.8 Cloud Computing Data Storage 
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Summary 

Keywords 

Self Assessment 

Answers for Self Assessment 

Review Questions 

Further Reading 

Objective  

 learn about the concept of cloud computing along with its services. 

 learn about different deployment models. 

 understand the concept of virtualization in cloud computing. 

 understand how cloud storage works. 

 understand the basic concept of IoT and sensors. 

 

Introduction  

A network or the internet is referred to as the cloud. It is a system that stores, manages, and 
accesses data online rather than on local discs using distant servers on the internet. Files, pictures, 
documents, audio, video, and other types of data are all examples of data. 

The following operations may be performed utilizing cloud computing: 

 New apps and services are being developed. 

 Data storage, backup, and recovery 

 Blog and website hosting 

 Software delivery on demand 

 Data examination 

 Video and audio streaming 

 

Bhanu, Lovely Professional University
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14.1 What is Cloud Computing? 

Anything that includes offering hosted services via the internet is referred to as cloud computing. 
Infrastructure as a service (IaaS), platform as a service (PaaS), and software as a service are the three 
primary kinds of these services (SaaS). Cloud Computing refers to manipulating, configuring, and 
accessing the hardware and software resources remotely. It offers online data storage, 
infrastructure, and application.Cloud computing offers platform independency, as the software is 
not required to be installed locally on the PC. Hence, the Cloud Computing is making our business 
applications mobile and collaborative. 

It is possible to have a private or public cloud. Anyone on the internet may buy services from a 
public cloud. A private cloud is a closed network or data centre that provides hosted services to a 
small group of individuals with specific access and permissions. The objective of cloud computing, 
whether private or public, is to give simple, scalable access. to computer resources and IT services. 
The hardware and software components needed to establish a cloud computing architecture are 
referred to as cloud infrastructure. On-demand computing or utility computing are other terms for 
cloud computing. 

 

What is a Cloud? 

A network or the internet is referred to as a cloud. To put it another way, a cloud is anything that 
exists at a faraway location. Cloud services can be delivered through public and private networks, 
such as WANs, LANs, and VPNs. 

Cloud-based applications include e-mail, online conferencing, and customer relationship 
management (CRM). 

Characteristics of Cloud Computing 

The characteristics of cloud computing are given below: 

1) Agility 

The cloud works in a distributed computing environment. It shares resources among users and 
works very fast. 

2) High availability and reliability 

The availability of servers is high and more reliable because the chances of infrastructure failure are 
minimum. 

3) High Scalability 

Cloud offers "on-demand" provisioning of resources on a large scale, without having engineers for 
peak loads. 

4) Multi-Sharing 

With the help of cloud computing, multiple users and applications can work more efficiently with 
cost reductions by sharing common infrastructure. 

5) Device and Location Independence 

Cloud computing enables the users to access systems using a web browser regardless of their 
location or what device they use e.g. PC, mobile phone, etc. As infrastructure is off-site (typically 
provided by a third-party) and accessed via the Internet, users can connect from anywhere. 

6) Maintenance 
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Maintenance of cloud computing applications is easier, since they do not need to be installed on 
each user's computer and can be accessed from different places. So, it reduces the cost also. 

7) Low Cost 

By using cloud computing, the cost will be reduced because to take the services of cloud 
computing, IT company need not to set its own infrastructure and pay-as-per usage of resources. 

8) Services in the pay-per-use mode 

Application Programming Interfaces (APIs) are provided to the users so that they can access 
services on the cloud by using these APIs and pay the charges as per the usage of services. 

 

14.2 Cloud Computing Architecture 

The cloud computing architecture is made up of a number of loosely connected cloud components. 
The cloud architecture may be divided into two parts: 

 Front-end development 

 In the backend 

Each end is connected to the other through a network, most often the Internet. The figure below 
depicts a graphical representation of cloud computing architecture: 

 

Figure 1 Cloud Computing Architecture 

Front End 

The front end refers to the client part of cloud computing system. It consists of interfaces and 
applications that are required to access the cloud computing platforms, Example - Web Browser. 

Back End 

The back End refers to the cloud itself. It consists of all the resources required to provide cloud 
computing services. It comprises of huge data storage, virtual machines, security mechanism, 
services, deployment models, servers, etc. 

 

14.3 Cloud Computing Infrastructure 

Cloud infrastructure consists of servers, storage devices, network, cloud management software, 
deployment software, and platform virtualization. 
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Hypervisor 

Hypervisor is a Virtual Machine Manager that is implemented as firmware or a low-level software. 
It allows several tenants to share a single physical instance of cloud resources. 

Management Software 

It helps to maintain and configure the infrastructure. 

Deployment Software 

It helps to deploy and integrate the application on the cloud. 

Network 

It is the key component of cloud infrastructure. It allows to connect cloud services over the Internet. 
It is also possible to deliver network as a utility over the Internet, which means, the customer can 
customize the network route and protocol. 

Server 

The server helps to compute the resource sharing and offers other services such as resource 
allocation and de-allocation, monitoring the resources, providing security etc. 

Storage 

Cloud keeps multiple replicas of storage. If one of the storage resources fails, then it can be 
extracted from another one, which makes cloud computing more reliable. 

 

How does cloud computing work? 

Assume you are a senior executive at a major business. Your specific responsibilities include 
ensuring that all your workers have the necessary hardware and software to do their duties. 
Purchasing computers for everyone is insufficient. You must also acquire software and software 
licenses, which you must subsequently distribute to your staff as needed. When you recruit a new 
employee, you'll either need to purchase more software or double-check that your current software 
licensing permits for another user. You must spend a lot of money because it is so stressful. 

However, for CEOs like you, there may be another option. As a result, rather of installing a suite of 
applications on each machine, you just need to run one program. Employees will be able to log in to 
a Web-based service that will have all of the programs that the user will need to do his or her work. 
Remote servers, which would handle everything from e-mail to word processing to complicated 
data analysis applications, will be controlled by another business. It's known as cloud computing, 
and it has the potential to revolutionize the computer industry. 
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There is a considerable workload change in a cloud computing system. When it comes to running 
apps, local PCs no longer have to perform all of the hard lifting. Cloud computing, on the other 
hand, can simply and automatically handle such a large load. The user's hardware and software 
requirements reduce. The user's computer just has to be able to run the system's cloud computing 
interface software, which can be as basic as a Web browser, and the cloud's network will take care 
of the rest. 

 

14.4 Cloud Service Models 

There are the following three types of cloud service models - 

1. Infrastructure as a Service (IaaS) 

2. Platform as a Service (PaaS) 

3. Software as a Service (SaaS) 

 

Infrastructure as a Service (IaaS) 

Hardware as a Service is another name for IaaS. (HaaS). It's a computer network that's administered 
through the internet. The major benefit of utilising IaaS is that it saves consumers money and time 
by allowing them to avoid the cost and complexity of acquiring and operating physical servers. 

IaaS Characteristics 

The following are the features of IaaS: 

 As a service, resources are provided. 

 The services are extremely scalable. 

 Adaptable and dynamic 
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 Access via a graphical user interface (GUI) or an API 

 Administrative duties that are automated 

Example: Digital Ocean, Linode, Amazon Web Services (AWS), Microsoft Azure, Google Compute 
Engine (GCE), Rack space, and Cisco Meta cloud. 

 

Platform as a Service (PaaS) 

Platform-as-a-Service provides the application runtime environment. It also includes the 
development and deployment tools needed to create apps. Non-developers may construct web 
apps with the help of point-and-click technologies in PaaS. 

Google's App Engine and Force.com are two examples of PaaS providers. Developers may access 
these websites and develop web-based apps using the built-in API. 

However, adopting PaaS has the disadvantage of tying the developer to a single provider. For 
example, a Python programme that uses Google's API and runs on Google's App Engine is likely to 
operate solely in that environment. 

The figure below depicts how PaaS 

 

Characteristics of PaaS 

There are the following characteristics of PaaS - 

o Accessible to various users via the same development application. 

o Integrates with web services and databases. 

o Builds on virtualization technology, so resources can easily be scaled up or down as per 

the organization's need. 

o Support multiple languages and frameworks. 

o Provides an ability to "Auto-scale". 

Example: AWS Elastic Beanstalk, Windows Azure, Heroku, Force.com, Google App Engine, 
Apache Stratos, Magento Commerce Cloud, and OpenShift. 

Cloud Computing Software as a Service (SaaS) 
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The Software-as-a-Service (SaaS) paradigm enables end users to access software applications as a 
service. It's a piece of software that's installed on a server and accessible through the Internet. The 
following are some SaaS apps to consider: 

 System for billing and invoicing 

 

 CRM (Customer Relationship Management) software 

 

 Applications for help desks 

 

 Solutions for Human Resources (HR) 

Some SaaS products, such as Microsoft Office Suite, are not configurable. However, SaaS supplies 
us with an Application Programming Interface (API) that allows us to create a customized 
application. 

Characteristics of SaaS 

There are the following characteristics of SaaS - 

o Managed from a central location. 

o Hosted on a remote server. 

o Accessible over the internet 

o Users are not responsible for hardware and software updates. Updates are applied 

automatically. 

o The services are purchased on the pay-as-per-use basis. 

Example: BigCommerce, Google Apps, Salesforce, Dropbox, ZenDesk, Cisco WebEx, ZenDesk, 
Slack, and GoToMeeting. 

14.5 Cloud Deployment Models 

There are the following 4 types of cloud that you can deploy according to the organization's needs- 

 

Public Cloud 
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The public cloud is a pay-per-use service that allows anybody to store and retrieve information 
through the Internet. 

The Cloud Service Provider manages and operates computer resources in the public cloud (CSP). 

Example: Amazon Elastic Compute Cloud (EC2), IBM SmartCloud Enterprise, Microsoft, Google 
App Engine, and Windows Azure Services Platform are all examples of cloud computing 
platforms. 

Advantages of Public Cloud 

There are the following advantages of Public Cloud - 

 Public cloud is owned at a lower cost than the private and hybrid cloud. 

 Public cloud is maintained by the cloud service provider, so do not need to worry about 

the maintenance. 

 Public cloud is easier to integrate. Hence it offers a better flexibility approach to 

consumers. 

 Public cloud is location independent because its services are delivered through the 

internet. 

 Public cloud is highly scalable as per the requirement of computing resources. 

 It is accessible by the general public, so there is no limit to the number of users. 

 

 

Figure 2 Public Cloud 

Private Cloud 

Within a company, a private cloud allows systems and services to be accessed. The Private Cloud is 
only used within a single company. It can, however, be handled either internally by the company or 
externally by a third-party. The graphic below depicts the private cloud model. 
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Advantages of Private Cloud 

There are the following advantages of the Private Cloud - 

 Private cloud provides a high level of security and privacy to the users. 

 Private cloud offers better performance with improved speed and space capacity. 

 It allows the IT team to quickly allocate and deliver on-demand IT resources. 

 The organization has full control over the cloud because it is managed by the organization 

itself. So, there is no need for the organization to depends on anybody. 

 It is suitable for organizations that require a separate cloud for their personal use and data 

security is the priority. 

 

Hybrid Cloud 

A hybrid cloud combines public and private cloud services. The public cloud is used for non-
critical operations, whereas the private cloud is used for crucial activities. In the figure below, the 
Hybrid Cloud Model is depicted. 

 

Advantages of Hybrid Cloud 

There are the following advantages of Hybrid Cloud - 

 Hybrid cloud is suitable for organizations that require more security than the public cloud. 

 Hybrid cloud helps you to deliver new products and services more quickly. 

 Hybrid cloud provides an excellent way to reduce the risk. 
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 Hybrid cloud offers flexible resources because of the public cloud and secure resources 

because of the private cloud. 

14.6 Community Cloud Model 

The Community Cloud allows a collection of organizations to access the same infrastructure and 
services. It distributes infrastructure among a group of organizations in a particular community. It 
can be maintained by organizations internally or by a third-party. In the figure below, the 
Community Cloud Model is depicted. 

 

Example: Health Care community cloud. 

Advantages of Community Cloud 

There are the following advantages of Community Cloud - 

 

 Community cloud is cost-effective because the whole cloud is being shared by several 

organizations or communities. 

 Community cloud is suitable for organizations that want to have a collaborative cloud 

with more security features than the public cloud. 

 It provides better security than the public cloud. 

 It provides collaborative and distributive environment. 

 Community cloud allows us to share cloud resources, infrastructure, and other capabilities 

among various organizations. 

 

14.7 Cloud Computing Virtualization 

Virtualization is a technique, which allows to share single physical instance of an application or 
resource among multiple organizations or tenants (customers). It does so by assigning a logical 
name to a physical resource and providing a pointer to that physical resource on demand. 

Virtualization Concept 

Creating a virtual machine over existing operating system and hardware is referred as Hardware 
Virtualization. Virtual Machines provide an environment that is logically separated from the 
underlying hardware. 
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The machine on which the virtual machine is created is known as host machine and virtual 
machine is referred as a guest machine. This virtual machine is managed by a software or firmware, 
which is known as hypervisor. 

Hypervisor 

The hypervisor is a firmware or low-level program that acts as a Virtual Machine Manager. There 
are two types of hypervisor: 

Type 1 hypervisor executes on bare system. LynxSecure, RTS Hypervisor, Oracle VM, Sun xVM 
Server, VirtualLogic VLX are examples of Type 1 hypervisor. The following diagram shows the 
Type 1 hypervisor. 

 

 

Because they are placed on a bare machine, type 1 hypervisors do not have a host operating system. 

A Type 2 hypervisor is a software interface that simulates the devices with which a system interacts 
on a regular basis. Type 2 hypervisors include Containers, KVM, Microsoft Hyper V, VMWare 
Fusion, Virtual Server 2005 R2, Windows Virtual PC, and VMWare Workstation 6.0. The Type 2 
hypervisor is depicted in the diagram below. 
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Types of Hardware Virtualization 

Here are the three types of hardware virtualization: 

 Full Virtualization 

 Emulation Virtualization 

 Paravirtualization 

Full Virtualization 

In full virtualization, the underlying hardware is completely simulated. Guest software does not 
require any modification to run. 

 

Emulation Virtualization 

The virtual computer replicates the hardware via emulation and therefore becomes independent of 
it. The guest operating system does not need to be changed in this case. 
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Paravirtualization 

In Paravirtualization, the hardware is not simulated. The guest software run their own isolated 
domains. 

 

VMware vSphere is highly developed infrastructure that offers a management infrastructure 
framework for virtualization. It virtualizes the system, storage and networking hardware. 

14.8 Cloud Computing Data Storage 

Cloud Storage is a service that allows to save data on offsite storage system managed by third-party 
and is made accessible by a web services API. 

Storage Devices 

Storage devices can be broadly classified into two categories: 

 Block Storage Devices 

 File Storage Devices 

Block Storage Devices 

The block storage devices offer raw storage to the clients. These raw storage are partitioned to 
create volumes. 

File Storage Devices 

The file Storage Devices offer storage to clients in the form of files, maintaining its own file system. 
This storage is in the form of Network Attached Storage (NAS). 

Cloud Storage Classes 

Cloud storage can be broadly classified into two categories: 

 Unmanaged Cloud Storage 

 Managed Cloud Storage 

Unmanaged Cloud Storage 

Unmanaged cloud storage means the storage is preconfigured for the customer. The customer can 
neither format, nor install his own file system or change drive properties. 

Managed Cloud Storage 

Managed cloud storage offers online storage space on-demand. The managed cloud storage system 
appears to the user to be a raw disk that the user can partition and format. 
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Creating Cloud Storage System 

Various copies of data are stored on numerous servers in multiple locations by the cloud storage 
system. If one of the systems fails, all that is necessary is to update the reference to the object's 
storage location. 

Storage virtualization technologies such as Storage GRID can be used by the cloud provider to 
combine storage assets into cloud storage systems. It builds a virtualization layer that collects data 
from many storage devices and consolidates it into a single management system. It can also use the 
Internet to handle data from CIFS and NFS file systems. The figure below illustrates how Storage 
GRID  virtualizes storage into storage clouds: 

 

14.9 Basics of IoT and sensors 

 

What is IoT? 

The Internet of Things (IoT) is a network of physical items or people referred to as "things" that are 
equipped with software, electronics, networks, and sensors to gather and share data. The objective 
of the Internet of Things is to expand internet connectivity beyond typical devices such as 
computers, smartphones, and tablets to relatively simple items such as toasters. 

 

Virtually everything becomes "smart" as a result of the Internet of Things, which uses the power of 
data collecting, AI algorithms, and networks to improve parts of our lives. A human with a diabetes 
monitor implant, an animal with tracking devices, and so on are examples of things in the Internet 
of Things. This IoT lesson for beginners covers all of the fundamentals of the Internet of Things. 
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How IoT works? 

The IoT process begins with the devices themselves, such as smartphones, smartwatches, and 
electronic appliances such as televisions and washing machines, which allow you to connect with 
the platform. 

 

In this IoT lesson, we'll go through the four basic components of an IoT system: 

1) Sensors/Devices: Sensors and devices are essential components for collecting real-time data from 
the environment. All of this information might be complicated in some way. It might be as basic as 
a temperature monitoring sensor or as complex as a video stream. 

A gadget may have a variety of sensors that perform activities other than sensing. A mobile phone, 
for example, is a gadget with many sensors such as GPS and a camera, but your smartphone is 
unable to detect these things. 

2) Data transmission: All gathered data is transferred to a cloud infrastructure. The sensors should 
be linked to the cloud via a variety of communication channels. These modes of communication in  
mobileor satellite networks, Bluetooth, WI-FI, WAN, etc. 

3) Data Processing: Once that data is collected, and it gets to the cloud, the software performs 
processing on the gathered data. This process can be just checking the temperature, reading on 
devices like AC or heaters. However, it can sometimes also be very complex like identifying objects, 
using computer vision on video. 

4)User Interface: The information needs to be available to the end-user in some way which can be 
achieved by triggering alarms on their phones or sending them notification through email or text 
message. The user sometimes might need an interface which actively checks their IoT system. For 
example, the user has a camera installed in his home. He wants to access video recording and all 
the feeds with the help of a web server. 

However, it's not always one-way communication. Depending on the IoT application and 
complexity of the system, the user may also be able to perform an action which may create 
cascading effects. 

 

For example, if a user detects any changes in the temperature of the refrigerator, with the help of 
IoT technology the user should able to adjust the temperature with the help of their mobile phone. 

IoT Applications 

Now in this IoT tutorial, we will see various IoT applications: 
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IoT solutions are widely used in numerous companies across industries. Some most common IoT 
applications are given below: 

 

Application type Description 

Smart Thermostats Helps you to save resource on heating 

bills by knowing your usage patterns. 

Connected Cars IoT helps automobile companies handle 

billing, parking, insurance, and other 

related stuff automatically. 

Activity Trackers Helps you to capture heart rate pattern, 

calorie expenditure, activity levels, and 

skin temperature on your wrist. 

Smart Outlets Remotely turn any device on or off. It 

also allows you to track a device's 

energy level and get custom 

notifications directly into your 

smartphone. 

Parking Sensors IoT technology helps users to identify 

the real-time availability of parking 

spaces on their phone. 

Connect Health The concept of a connected health care 

system facilitates real-time health 

monitoring and patient care. It helps in 

improved medical decision-making 

based on patient data. 

Smart City Smart city offers all types of use cases 

which include traffic management to 

water distribution, waste management, 

etc. 

Smart home Smart home encapsulates the 

connectivity inside your homes. It 

includes smoke detectors, home 

appliances, light bulbs, windows, door 

locks, etc. 
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Smart supply chain Helps you in real time tracking of 

goods while they are on the road, or 

getting suppliers to exchange inventory 

information. 

Challenges of Internet of Things (IoT) 

IoT is now confronted with a slew of issues, including: 

 Testing and upgrading are insufficient. 

 Data security and privacy are both a source of concern. 

 Complexity of software 

 Volumes of data and their interpretation 

 Automation and AI integration 

 Devices require a continuous power source, which is difficult to achieve. 

 Short-range communication and interaction. 

Advantages of IoT 

Technical Optimization: IoT technology aids in the advancement and improvement of 
technologies. A manufacturer, for example, can collect data from numerous automobile sensors 
using IoT. They are analysed by the manufacturer in order to enhance the design and make them 
more efficient. 

Improved Data Gathering: Traditional data collection has flaws and is designed to be used 
passively. IoT allows for quick data action. 

Reduced Waste: The Internet of Things (IoT) provides real-time data that allows for better resource 
management and decision-making. For example, if a manufacturer discovers a problem with 
numerous vehicle engines, he may follow their manufacturing plans and resolve the problem with 
the manufacturing team. 

Improved Customer Engagement: IoT allows you to improve customer experience by detecting 
problems and improving the process. 

 

Disadvantages of Iot 

Now, let us see some of the disadvantages of IoT in this Internet of Things tutorial: 

Security: IoT technology creates an ecosystem of connected devices. However, during this process, 
the system may offer little authentication control despite sufficient security measures. 

Privacy: The use of IoT, exposes a substantial amount of personal data, in extreme detail, without 
the user's active participation. This creates lots of privacy issues. 

Flexibility: There is a huge concern regarding the flexibility of an IoT system. It is mainly regarding 
integrating with another system as there are many diverse systems involved in the process. 

Complexity: The design of the IoT system is also quite complicated. Moreover, it's deployment and 
maintenance also not very easy. 

Compliance: IoT has its own set of rules and regulations. However, because of its complexity, the 
task of compliance is quite challenging. 

 

Summary 

 Introduction to Internet of Things (IoT): The Internet of Things (IoT) is a network of 

physical objects or people called "things" that are embedded with software, electronics, 

network, and sensors which allows these objects to collect and exchange data. 

 The actual idea of connected devices was proposed in 1970 
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 Four Key components of IoT framework are 1) Sensors/Devices, 2) Connectivity, 3) Data 

Processing, 4) User Interface 

 Various applications of IoT are Smart Thermostats, Connected Cars, Activity Trackers, 

Smart Outlets, Connect Health, etc 

 Technical Optimization, Improve Data Collection, Reduced Waste, Improved Customer 

Engagement are key benefits of IoT 

 Security, Privacy, Complexity, Compliance, are key challenges of IoT. 

 

Keywords 

IoT: The Internet of Things (IoT) is a network of physical objects or people called "things" 

that are embedded with software, electronics, network, and sensors which allows these 

objects to collect and exchange data. 

Data Processing: Once that data is collected, and it gets to the cloud, the software 

performs processing on the gathered data. This process can be just checking the 

temperature, reading on devices like AC or heaters. However, it can sometimes also be 

very complex like identifying objects, using computer vision on video. 

Virtualization: Virtualization is a technique, which allows to share single physical 
instance of an application or resource among multiple organizations or tenants 
(customers). It does so by assigning a logical name to a physical resource and providing a 
pointer to that physical resource on demand. 

 

Self Assessment 

1. Cloud computing is a kind of abstraction which is based on the notion of combining 

physical resources and represents them as _______resources to users. 

A. Real 

B. Cloud 

C. Virtual 

D. none of the mentioned 

 

2. Which one of the following cloud concepts is related to sharing and pooling the resources? 

A. Polymorphism 

B. Virtualization 

C. Abstraction 

D. None of the mentioned 

 

3. Which of the following is a type of Service Models? 

A. Public-as-a-Service 

B. Platform-as-a-Service 

C. Community-as-a-Service 

D. Public-as-a-Service 

 

4. Which of the following is the working models for cloud computing? 

A. Deployment Models 

B. Configuring Model 

C. Collaborative Model 

D. All of the above 
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5. How many types of Cloud are there in Deployment Models? 

A. 2 

B. 3 

C. 4 

D. 5 

 

6. The ____________ allows systems and services to be accessible by a group of organizations. 

A. Private cloud 

B. Public cloud 

C. Community cloud 

D. Hybrid cloud 

 

7. Which one of the following can be considered as a utility is a dream that dates from the 

beginning of the computing industry itself? 

A. Computing 

B. Model 

C. Software 

D. All of the mentioned 

 

8. Which of the model involves the special types of services that users can access on a Cloud 

Computing platform? 

A. Service 

B. Planning 

C. Deployment 

D. Application 

 

9. Which one of the following options can be considered as the Cloud? 

A. Hadoop 

B. Intranet 

C. Web Applications 

D. All of the mentioned 

 

10. Which of the following type of virtualization is also characteristic of cloud computing? 

A. Storage 

B. Application 

C. CPU 

D. All of the above 

 

11. Point out the correct statement: 

A. A client can request access to a cloud service from any location. 

B. A cloud has multiple application instances and directs requests to an instance based on 

conditions. 

C. Computers can be partitioned into a set of virtual machines with each machine being 

assigned a workload. 

D. All of the mentioned. 
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12. _______ provides the runtime environment for applications, development and deployment 

tools, etc 

A. IaaS 

B. PaaS 

C. SaaS 

D. XaaS 

 

13. IoT stands for? 

A. Introduction of Things 

B. Internet of Things 

C. Internet of Tracking 

D. Interaction of Things 

 

14. Which of the following is true about IoT? 

A. The term Things of the Internet of Things refers to anything and everything in day to day 

life 

B. IoT has greater transparency, control, and performance. 

C. Both are true. 

D. None of the above 

 

15. Which one of the following is not an IoT device? 

A. Amazon echo voice controller 

B. Google Home 

C. Nest Smoke Alarm 

D. None of these 

 

Answers for Self Assessment 

1. C 2. B 3. B 4. A 5. C 

6. C 7. A 8. A 9. A 10. D 

11. D 12. B 13. B 14. C 15. D 

 

Review Questions 

1. What is Cloud? 

2. What is Cloud Computing? 

3. Explain the Architecture of Cloud. 

4. Explain the concept of Virtualization. 

5. What do you understand by the term IoT? 

6. Give examples of some IoT devices that you use in real life. 
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Further Reading 

http://www.freebookcentre.net/Networking/Cloud-Computing-Books.html 

 

 

Web Links 

https://azure.microsoft.com/en-in/overview/what-is-cloud-computing/ 
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